
ANTIDOTE 10 USER GUIDE

Updated: October 18, 2021



TABLE OF CONTENTS

FOREWORD............................................................................................................................................................................................................................................................................................................5

INTRODUCTION............................................................................................................................................................................................................................................................................................................6
THE CORRECTOR............................................................................................................................................................................................................................................................................................................7
THE DICTIONARIES............................................................................................................................................................................................................................................................................................................8
THE LANGUAGE GUIDES............................................................................................................................................................................................................................................................................................................13

THE CORRECTOR............................................................................................................................................................................................................................................................................................................14
ACCESSING THE CORRECTOR............................................................................................................................................................................................................................................................................................................15
THE CORRECTION PRISM............................................................................................................................................................................................................................................................................................................15
THE CORRECTION PROCESS............................................................................................................................................................................................................................................................................................................16
TYPES OF DETECTIONS AND UNDERLINING............................................................................................................................................................................................................................................................................................................17
HANDLING A DETECTION............................................................................................................................................................................................................................................................................................................20
LIST OF DETECTIONS............................................................................................................................................................................................................................................................................................................26
THE STYLE VIEW............................................................................................................................................................................................................................................................................................................28
THE REVISION PRISM............................................................................................................................................................................................................................................................................................................36
THE STATISTICS PRISM............................................................................................................................................................................................................................................................................................................40
THE INSPECTION PRISM............................................................................................................................................................................................................................................................................................................43
NAVIGATING IN THE FILTERS............................................................................................................................................................................................................................................................................................................45
MODIFYING THE TEXT............................................................................................................................................................................................................................................................................................................45
PRINTING THE RESULTS............................................................................................................................................................................................................................................................................................................45
DETAILED ANALYSIS............................................................................................................................................................................................................................................................................................................45
TEXT DISPLAYED IN GREY............................................................................................................................................................................................................................................................................................................46
UNDERSTANDING HOW THE CORRECTOR WORKS............................................................................................................................................................................................................................................................................................................46
THE IMPACT OF THE CORRECTOR ON THE STYLE VIEW............................................................................................................................................................................................................................................................................................................47

THE DICTIONARIES............................................................................................................................................................................................................................................................................................................47
ACCESSING THE DICTIONARIES............................................................................................................................................................................................................................................................................................................48
INSTANT SEARCH MENU............................................................................................................................................................................................................................................................................................................49
HOMOGRAPHS BAR............................................................................................................................................................................................................................................................................................................50
DEFINITIONS DICTIONARY............................................................................................................................................................................................................................................................................................................50
DICTIONARY OF SYNONYMS............................................................................................................................................................................................................................................................................................................54
DICTIONARY OF ANTONYMS............................................................................................................................................................................................................................................................................................................56
DICTIONARY OF COMBINATIONS............................................................................................................................................................................................................................................................................................................57

59

2



DICTIONARY OF SEMANTIC FIELDS............................................................................................................................................................................................................................................................................................................59
CONJUGATION DICTIONARY............................................................................................................................................................................................................................................................................................................61
DICTIONARY OF FAMILIES............................................................................................................................................................................................................................................................................................................63
DICTIONARY OF QUOTATIONS............................................................................................................................................................................................................................................................................................................63
HISTORICAL DICTIONARY............................................................................................................................................................................................................................................................................................................64
ACCESSING WIKIPEDIA............................................................................................................................................................................................................................................................................................................65
MULTI-WORD SEARCH............................................................................................................................................................................................................................................................................................................67
SEARCHING WITH VARIABLES............................................................................................................................................................................................................................................................................................................68
SEARCHING BY CRITERIA............................................................................................................................................................................................................................................................................................................70
NAVIGATING THROUGH THE DICTIONARIES............................................................................................................................................................................................................................................................................................................78
FAVOURITES............................................................................................................................................................................................................................................................................................................79
PERSONALIZED WORD LISTS............................................................................................................................................................................................................................................................................................................80
DISCOVERING NEW WORDS............................................................................................................................................................................................................................................................................................................81
TEXT SEARCH............................................................................................................................................................................................................................................................................................................81
REPLACING A WORD IN THE TEXT............................................................................................................................................................................................................................................................................................................81
EXTRACTING THE DICTIONARY CONTENTS............................................................................................................................................................................................................................................................................................................81
PRINTING THE DICTIONARY CONTENTS............................................................................................................................................................................................................................................................................................................81

THE LANGUAGE GUIDES............................................................................................................................................................................................................................................................................................................82
ACCESSING THE GUIDES............................................................................................................................................................................................................................................................................................................83
NAVIGATING THE GUIDES............................................................................................................................................................................................................................................................................................................85
FAVOURITES............................................................................................................................................................................................................................................................................................................87
PERSONALIZED ARTICLE LISTS............................................................................................................................................................................................................................................................................................................87
PRINTING ARTICLES............................................................................................................................................................................................................................................................................................................88

ANTI-OOPS!............................................................................................................................................................................................................................................................................................................88
THE CORRECTOR IS READY............................................................................................................................................................................................................................................................................................................89
CHECKING ATTACHMENTS............................................................................................................................................................................................................................................................................................................89

SETTINGS............................................................................................................................................................................................................................................................................................................90
WHY ADJUST THE SETTINGS?............................................................................................................................................................................................................................................................................................................91
ACCESSING THE SETTINGS............................................................................................................................................................................................................................................................................................................91
ADJUSTING THE SETTINGS............................................................................................................................................................................................................................................................................................................91
PRESETS............................................................................................................................................................................................................................................................................................................92
INTERFACE SETTINGS............................................................................................................................................................................................................................................................................................................93
CORRECTOR SETTINGS............................................................................................................................................................................................................................................................................................................97
LANGUAGE SETTINGS............................................................................................................................................................................................................................................................................................................102
TYPOGRAPHY SETTINGS............................................................................................................................................................................................................................................................................................................109

PERSONAL DICTIONARIES............................................................................................................................................................................................................................................................................................................113
WHY PERSONALIZE YOUR DICTIONARY? ............................................................................................................................................................................................................................................................................................................114
ACCESSING THE PERSONAL DICTIONARIES............................................................................................................................................................................................................................................................................................................114
ADDING AN ENTRY TO A PERSONAL DICTIONARY............................................................................................................................................................................................................................................................................................................115
SAVING THE NEW WORD............................................................................................................................................................................................................................................................................................................118

118

3



MANAGING ENTRIES IN THE PERSONAL DICTIONARIES............................................................................................................................................................................................................................................................................................................118
IMPORTING INTO A PERSONAL DICTIONARY............................................................................................................................................................................................................................................................................................................118
SYNCING PERSONAL DICTIONARIES............................................................................................................................................................................................................................................................................................................128
EXPORTING A PERSONAL DICTIONARY............................................................................................................................................................................................................................................................................................................128
COPYING A PERSONAL DICTIONARY............................................................................................................................................................................................................................................................................................................129
MANAGING PERSONAL DICTIONARIES............................................................................................................................................................................................................................................................................................................129

THE FRENCH MODULE............................................................................................................................................................................................................................................................................................................130
CORRECTOR............................................................................................................................................................................................................................................................................................................131
DICTIONARIES............................................................................................................................................................................................................................................................................................................135
GUIDES............................................................................................................................................................................................................................................................................................................149
ANTI-OOPS!............................................................................................................................................................................................................................................................................................................151
SETTINGS............................................................................................................................................................................................................................................................................................................151
PERSONAL DICTIONARIES............................................................................................................................................................................................................................................................................................................161

USING WITH YOUR OTHER SOFTWARE............................................................................................................................................................................................................................................................................................................164
WINDOWS............................................................................................................................................................................................................................................................................................................165
MAC............................................................................................................................................................................................................................................................................................................178
LINUX............................................................................................................................................................................................................................................................................................................205

SYNCHRONIZATION............................................................................................................................................................................................................................................................................................................215

THANKS............................................................................................................................................................................................................................................................................................................216

BIBLIOGRAPHIE............................................................................................................................................................................................................................................................................................................217

4



Antidote 10 is the result of over 25 years of progress in language engineering, underpinned by the four key values that
first forged its reputation: consistency, scope, simplicity and accessibility.

Consistency. Antidote is a one-stop, multi-resource platform for anyone who writes in English, including an advanced
corrector, a set of rich dictionaries and detailed language guides. All these resources aren’t just pasted together; they
are carefully designed to complement one another and interact intelligently to help you explore every aspect of a
language question. Individually, each of these resources rivals the best in its category. Together, they are simply
unmatched.

Scope. The resources in Antidote have some impressive figures to offer: 110,000 words, 700,000 combinations, 1,500,000
synonyms, 8,500 verbs, 16,000 targeted errors and much more. It all adds up to a real treasure trove of information.
Each resource comes with a host of useful functions, such as the 200 filters in the corrector and the many search modes
in the dictionaries.

Simplicity. All the resources appear in just three windows. Each window clearly lays out the functions with minimal
buttons, complemented by all sorts of clever, handy options just when you need them. The result is a simple, quick and
effective correction process. Antidote is powerful but clean and easy to master.

Accessibility. Antidote is accessible directly from your document with a simple mouse click or from a menu. No files to
send or convert, no time wasted. You’re busy writing, something nags you: you just click and Antidote comes to your
help. It’s like having an English expert living inside your computer.

Antidote 10 comes with a number of key improvements to all of its resources.

The synonym lists are now sorted by proximity with the headword, giving you quick access to the most relevant
alternatives. They can also be ordered alphabetically, by frequency or by length. New filters allow you to choose which
types of synonym to show, making it simpler to spot what you’re looking for.

Proverbs can be searched by theme, for example love, money or power. Expressions are shown as soon as you type
them in, with no need to perform a multiword search.

It is now even easier to share Antidote’s rich resources by creating word lists (mammals, monkeys, etc.) or article lists
(negation, capitalization, etc.) that can be sent to other users. These users can then import the lists into their own copies
of Antidote to view or edit them.

Binge-watch, facticide and hoverboard are among more than 6,000 new words added to the English nomenclature;
meanwhile 120,000 new synonyms and 125,000 antonyms complete the panoply of English dictionaries. The guides now
comprise more than 480 articles, with a cleaner, more attractive display.

Style correction in Antidote boasts a number of enhancements. You no longer have to leave the Style view to correct
language errors. More than 3,500 detections have been added, such as split infinitives and wordiness. When flagging
repeated words, the corrector provides a menu of the most relevant synonyms, making it easy to vary the text’s
vocabulary. A new readability filter displays a selection of the most common indexes as well as the new Antidote score.
To help improve readability, the filter underlines all the elements that can make a text overly complex: long words and
sentences, rare or foreign words, abbreviations and nested phrases. A little work on the highlighted elements can
greatly improve your text’s readability.
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In response to growing demand, a new filter for gender neutrality has been added. It helps writers remove bias in their
texts by using neutral terms whenever gender-specific terms are not necessary. It flags nouns, pronouns and
determiners specific to a particular gender, such as job titles or terms of address, and suggests more inclusive
alternatives.

Thousands of improvements to the lexical and syntactic analysis now enable even smarter language corrections. Bold
and italic type are recognized and displayed; especially useful when italics are used to designate foreign words, for
example. Emojis are also displayed thanks to the analyzer’s full conversion to Unicode. The tooltips display clearer error
diagnostics and more specific possible actions.

With the new optional synchronization service, you can now sync favourites, word lists and personal dictionaries across
all your devices that use Antidote.

In total, Antidote 10 sees more than 75 new features added to its content, functions and interface, making this edition a
more solid and complete language tool than ever before.

But that’s not all! Antidote 9 was the first edition to open up the dimension of English to its users, who had already been
enjoying Antidote in French for many years. Now, those who purchase both language modules will see them interact.
The definitions dictionary displays more than 800,000 translations for all of its words, expressions and proverbs. Even
more impressive is the tour de force achieved by our linguists, who have translated 1,700,000 combinations in both
directions, with examples. Never before has a new edition of Antidote been so rich in new content.

The French module itself benefits from 60 improvements, including French versions of the new features described
above. Cuichette, inclusivité and sociofinancement are among the 1,000 words and expressions added to the
dictionaries, while the guides now comprise 850 articles.

We therefore invite you to discover Antidote, now in its 25th year and our greatest vintage yet – whether in French,
English, or the winning combination of both languages.
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Language is an organic whole. From glyph to sentence, from page to novel, a remarkable amount of knowledge,
reasoning, and emotion come into play. Typography, lexicon, syntax, grammar, semantics, style and rhythm — all these
and more are called on to contribute. And each comes with its own set of rules, conventions and pitfalls.

Harnessing the power of the computer, we sought to bring together the great reference works on the English language:
dictionaries covering definitions, conjugations, synonyms and more, as well as guides that cover grammar, style,
typography and punctuation. Moreover, we wanted to create a tool that would put this wealth of information into
practice: a corrector.

This ambition gave rise to Antidote, now in its tenth edition.

Antidote is intended for English speakers the world over. People in the United States, the United Kingdom, Canada and
Australia will find in Antidote not just the words that are common to standard English, but also the lexical and syntactic
particularities of their country — in all of Antidote’s resources.

Antidote’s corrector is also designed for second-language speakers of English, who bravely set out to master its
intricacies. It recognizes, corrects and explains errors and expressions typical of non-native speakers and of varying
degrees of linguistic proficiency.

In creating Antidote, we wanted to render the treasures of the English language available to as diverse an audience as
possible. Naturally, this involves shedding light on its difficulties, but above all laying out all the richness of English. It is
our hope that Antidote will help you enjoy the language more.

This introduction offers a brief overview of the principles that govern the operation of Antidote and the content of its
many resources. The chapters that follow provide a more detailed description of how each of these functions.

THE CORRECTOR
Antidote’s advanced corrector carries out a complete grammatical analysis of each sentence in your text, from which it
delivers a set of multifaceted diagnostics.

The scope of Antidote’s corrector is quite broad: it corrects agreement errors (subject–verb, noun–determiner, etc.),
errors with the possessive ’s, commonly confused words (its/it’s, your/you’re, who’s/whose, their/there/they’re, etc.),
contextual errors involving homophones or near-homophones (cup of *tee, summer *brake, world *piece). It corrects
the use of hyphens, commas and capitalization, as well as the written form of numbers, times and addresses. It flags
redundancies, inconsistencies, false friends, regional words, and words of inappropriate language registers. It presents
its diagnostics in three distinct views: language, typography and style, for a more streamlined correction process. You
can also adjust the nature and number of Antidote’s alerts by means of detailed settings.

Antidote’s corrector seamlessly integrates with most writing software. You can use it to analyze a sentence, a
paragraph or two, or an entire text, depending on your needs, without changing your writing environment.

The corrector interacts closely with Antidote’s other resources. When it detects an error, it can open the appropriate
guide article describing the rule that’s been broken. You can also consult the dictionary entry of a word flagged by the
corrector.

 INTRODUCTION2
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Language correction requires a set of rules to follow. In establishing its rules, Antidote’s corrector aims to apply the
standard conventions of English usage, as described in authoritative works such as The Cambridge Grammar of the
English Language, the Oxford English Grammar, The Canadian Style, New Hart’s Rules and The Chicago Manual of
Style. When these sources disagree, Antidote usually offers settings to adapt the corrections to the user’s preference.

But Antidote’s work goes well beyond grammar. It implements detailed verifications of typographic rules, from date
formats to quote styles. And it goes as far as helping you improve the style of a text by highlighting repetition,
problematic constructions, and vocabulary weaknesses. Moreover, using the results of the system’s language analysis,
revision filters visually illustrate certain pragmatic aspects (Who, When, Where, How Many/Much), logical relations
(transitions, reporting clauses), in addition to certain semantic aspects of the text (whether its connotation is positive or
negative, strong or weak). Inspection filters expose each sentence’s constituent elements: adjectives, adverbs,
complements, conditionals, etc. Statistics filters aggregate various aspects of language and represent them graphically:
the number of errors, the most frequent words, word distribution according to etymology, etc. By submitting a text to
the corrector and then to its various filters, one can examine, correct, revise and refine the text to a degree hitherto
unattainable.

Despite its cutting-edge technology, however, Antidote’s corrector is not omniscient. Although each new edition brings
significant progress, the expressive complexity of human language remains an enormous technical challenge. Although
it can analyze a text syntactically, detecting many grammar and spelling errors, and even certain constructions that
make no sense, Antidote does not understand the actual meaning of the text. It cannot rephrase a poorly written
sentence, and will inevitably flag false detections and fail to catch a few mistakes.

Antidote’s corrector is a rich and valuable tool for writers, but it does not replace a human editor, and vice versa. The
best way to check a text is to begin with Antidote, which flags the most embarrassing errors, including those that can
easily escape our attention, and then call in a human editor who will highlight the more difficult problems. Sometimes,
however, a human editor may not be available, whereas Antidote is always at the ready.

THE DICTIONARIES
Lexicography is not what it used to be. In place of the valiant scribe of former times who spent twenty years over a
thousand works patiently documenting the riches of the language, word by word, sense by sense, usage by usage, we
now have computer-assisted lexicographers, equipped with their infallible software tools, their indefatigable
computers and their infinite memories. With the power of computers and the boundless reach of their networks,
lexicographers today have no trouble searching through billions of words. They can massage them at will, calculate
frequencies, establish distributions and co-occurrences. They no longer have to hunt for a few attested occurrences;
they now sort through masses of them!

At Druide, our interdisciplinary team of lexicographers and computer scientists has benefited enormously from these
modern resources, allowing us to scour the Internet and countless digital documents, without neglecting traditional
sources, in order to create Antidote’s dictionaries. The result is a wealth of 110,000 entries, which paints a broad portrait
of the English language today and which form the basis of the dictionaries in Antidote.

In fact, Antidote comprises multiple dictionaries, all of whose entries are displayed within a unified interface. Whether it
be for definitions or synonyms, combinations or semantic fields, Antidote’s dictionaries offer a lexical reference work of
unparalleled richness, variety and consistency.
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Because they are so easy to consult, these dictionaries will entice you to discover the boundless treasures of English.
Click on any word in any field of any dictionary, and you will be logically led to additional information. You will find
yourself flitting from one word to another and from one dictionary to the next, simply by clicking on whatever piques
your curiosity. With Antidote, you can effortlessly meander through the fascinating skein of links between words, going
from senator to senile, from shirt to skirt, and from skates to stilts.

The computer’s agility makes it so much easier to explore the language. Enter two words and Antidote’s multi-word
search will list all the associations between them, including the expressions in which they appear, their combinations
and their synonyms. Use the wildcard characters to find the words that will help you complete your crossword puzzle.
Combine up to fourteen criteria in any way you like to generate the most diverse lists, including rhymes, subject fields
and source languages, producing results that are often surprising.

Finally, because the computer has become the crucible for our texts, the integration of Antidote’s dictionaries within the
programs we use to write is of critical importance. Thanks to this integration, the dictionaries can be invoked
effortlessly wherever and whenever the need arises. All these important features of Antidote’s dictionaries—their
richness and consistency, powerful search and ease of consultation—open up vast new possibilities for everyone who
writes.

THE DICTIONARY OF DEFINITIONS AND EXPRESSIONS

In appearance, the dictionary of definitions looks like an ordinary dictionary, providing a description in everyday
language for each of its entries. There are definitions for more than 110,000 words, including 28,000 proper nouns, the
names of countries, major world cities, famous people and UNESCO World Heritage sites.

The definitions are clear and precise, and describe the various meanings of each word. The main senses and sub-
senses are organized and presented in a tree structure, which makes it easier to pick them out. Examples are provided
for each sense of a word, illustrating and clarifying how it is used. Domain labels situate the word’s meaning within the
specialized vocabulary of the corresponding field (medicine, architecture, finance, etc.). Usage labels indicate the
register of language to which the word belongs (formal, informal, slang, etc.), or the region in the English-speaking
world where it is used (Canada, the United States, the United Kingdom, etc.). Indeed, particular attention has been paid
to the description of regional variants, as for example toque in Canadian English, thongs in Australian English, and
hoagie in American English.

The entry for each word displays all its inflected forms (singular/plural, comparative/superlative), its phonetic
transcription, its etymology, and any alternative spellings along with their respective frequency. A frequency index is
provided for each word; it indicates the relative frequency of the word in our corpus, which is described below. The
population figures for cities and countries come from recent censuses, particularly those found on the sites
GeoNames.org and PopulationData.net.

Finally, the definition of each common noun, each proper noun and most fixed noun-phrase expressions includes a link
to the corresponding article in the Wikipedia online encyclopedia (for which an Internet connection is required). The
content of the Wikipedia article is displayed within the Antidote dictionary window, for easy reading. Antidote 10 also
provides smart links to other high-quality external resources, such as Google Maps and TERMIUM Plus®. You can even
add your own links as you see fit.

EXPRESSIONS, IDIOMS, PHRASAL VERBS AND PROVERBS

Because they are part of a word’s immediate environment, expressions appear right below the definitions and are
classified into four groups: expressions, idioms, phrasal verbs and proverbs. Links allow direct access to each.
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In addition to single words, idioms are an important part of the lexicon. An idiom is a fixed group of words forming a
lexical unit that has a precise meaning. Some are figurative expressions, while others constitute specialized
terminology.

Everyday language is full of figurative expressions, which may seem nonsensical when interpreted literally (a red
herring, bury the hatchet). To understand the expression’s conventional meaning, one must consult a dictionary.

Specialized expressions, such as the term heavy water in chemistry, denote entities that are specific to various fields of
knowledge. These are also numerous and are often opaque to non-specialists.

Antidote includes 50,000 common idioms, specialized expressions, phrasal verbs and proverbs, each provided with its
own definition and illustrative examples. Domain labels indicate the area in which the specialized expressions are used.
Senses are organized in distinct groups, making it easier to locate words and expressions of polysemous words. To find
the definition of a given expression, simply look up one of its key words. For example, you can find the meaning of the
idiom bury the hatchet by looking up either bury or hatchet. Or you can enter the complete expression directly and
Antidote’s multi-word search will produce it readily.

Antidote’s listed expressions include 500 proverbs, which are included in their own section following the idioms. These
are easy to locate thanks to the search-by-criteria function.

THE DICTIONARY OF SYNONYMS

Synonyms are another area in which Druide’s lexicographers have been able to take advantage of the power of
computers. Antidote includes close to 1.5 million synonyms for 60,000 entries.

Our main goal here was to allow you to quickly find the synonym you are looking for. For this, three things are required:
the lists of synonyms have to be rich, well structured, and immediately accessible.

Seeking the right balance between feast and famine, we built up rich lists of synonyms while ensuring that all remain
relevant. We then classified the synonyms by meanings and sub-meanings, all of which are clearly labelled. Continuous
text display allows you to see more synonyms at once. Thanks to a clever use of colour, the appropriate meaning can be
quickly spotted, allowing you to rapidly zoom in on the desired synonym.

Nor have we limited ourselves to words. Antidote systematically includes multiword expressions, since they do constitute
bona fide synonyms and are often perfectly appropriate, such as grab a bite for eat, or title holder for champion.

We have also included the hyponyms and hyperonyms of thousands of nouns. Hyponyms are synonyms that have a
more specific meaning, like greyhound for dog, whereas hyperonyms are synonyms that have a more general meaning,
like mammal for dog. Together, hyponyms and hyperonyms form a true taxonomy of the language, a family tree of
words that you can browse as you please.

Furthermore, Antidote’s synonyms are not confined to formal language, but draw on all registers and regional dialects.
You will find as many informal synonyms as literary ones, and synonyms that are used in all areas of the English-
speaking word, e.g. sheila, we learn, is an informal synonym for young girl in Australia, whereas bird might be used for
the same notion in the UK, and chick might be used in the US (although the latter two are somewhat impolite). Of
course, each of these “deviations from the standard or neutral form” is appropriately marked (UK, informal, etc.).

Another new and useful feature is that Antidote allows you to carefully select the right word by examining the full
definition of each suggested synonym: just click on the word and its definition appears right beside it. No pages to turn,
no windows to manipulate.
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THE DICTIONARY OF ANTONYMS

One of the elementary operations of thought and reasoning is the comparison of contrasting concepts. The simple
mention of a given word often means that one with an opposing meaning is not far away.

This is the value of having an antonyms dictionary at your fingertips. Antidote offers a rich inventory of the contrasts
and opposites that a word can evoke. The exact nature of these contrasts, of course, varies greatly, which is why
Antidote’s antonyms are grouped according to sense and context. Whether you are comparing the romantic to the
platonic or to the unsentimental or cynical, your antonyms are presented accordingly. Boasting over 100,000 antonyms,
this dictionary is the ideal tool for your inner contrarian!

THE DICTIONARY OF COMBINATIONS

Words, like people, do not exist in a vacuum; it is only through their association with others that they take on their full
meaning. Antidote’s dictionary of combinations provides a comprehensive inventory of word associations. Refresh one’s
memory, a dazzling display, tender care—in all, there are 700,000 such word combinations that exemplify the lexical
associations which help give the language its particular colour.

To create this enormous compilation, we put our computers to work in two ways. First, we scoured the Web to build a
corpus of close to five billion words, or 235 million sentences, drawn from many different sources. Among these are
news sites such as The Washington Post, The Guardian and The Globe and Mail, as well as digital libraries such as
Booksie and Project Gutenberg.

We then extracted the most interesting associations from this huge corpus. We isolated the nouns and their modifiers,
verbs and their complements, adjectives and their adverbs, and other such grammatical relations. A statistical filter
allowed us to retain the most salient combinations, i.e. those that are significantly frequent and distinct.

The resulting combinations were first classified by meaning whenever one of the words was polysemous, and then by
syntactic role: modifiers, subjects, complements, etc. In addition, we chose to display each combination in full, with its
most frequent determiner and inflected form, as for example love at first sight, a mother’s love, and love of one’s
country. The result is an ordered list that is complete and easy to read.

In order to illustrate each combination, we developed a heuristic to select example sentences in accordance with
various criteria. Nearly 700,000 sentences from our corpus were extracted, providing on average more than two
examples for each combination. The examples are displayed in a column on the right when a combination is selected,
and they help to understand its meaning and use. Alternatively, you can also examine the definitions of the combining
term.

Throughout the entire process, our linguists diligently reviewed the data to ensure that what was retained was both
relevant and accurate. They also filtered out many instances of inappropriate or improperly formulated examples,
problems that our automatic extraction heuristic could obviously not evaluate.

To help you find the perfect adjective for a given noun, the most suitable verb or the most evocative adverb, the
dictionary of combinations, with its unique perspective on the language from the associative angle, will quickly become
an indispensable aid.

THE DICTIONARY OF SEMANTIC FIELDS

A semantic field is a set of words whose members are linked together semantically. Antidote’s dictionaries already
include several links of this type, e.g. combinations and synonyms. The dictionary of semantic fields goes further by
bringing together the existing links and completing them with others.
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To create this dictionary, we took our cue from the method previously employed for our combinations dictionary. Using
our five billion-word corpus, we identified the words that appear most frequently in the vicinity of another. We
restricted the analysis to nouns, adjectives and verbs, which convey most of the meaning in a sentence.

The resulting dictionary of semantic fields offers an overview of each word’s lexical landscape. Or rather, two
overviews, because the results are displayed in two ways: on the one hand, in a standard vertical list, and on the other,
in an interactive word cloud. In the list, the results are grouped into three levels: first, by the meaning of the headword,
if it is polysemous; then by category, so that the members listed are more cohesive; and finally, by statistical strength
within each category. In the word cloud, the size of each word is proportional to the strength of its link to the headword.
In both cases, a click on a word displays its semantic field in turn, allowing for easy navigation among related concepts.

Unlike combinations, two words do not have to be in a syntactic relationship in order to be considered neighbours.
Consequently, certain words that appear in a semantic field may occasionally raise questions. Nonetheless, each
included element does indeed occur frequently in the headword’s environment.

Semantic fields are often used in teaching to help students discover related vocabulary or to expand the range of their
ideas. The two views of semantic fields provided by our dictionary are designed with these goals in mind.

THE CONJUGATION DICTIONARY

Conjugation in English is simpler than in many other Indo-European languages. English verbs don’t have nearly as
many inflected forms as they do in French, for example. However, this does not mean that English grammar is any
simpler than that of other languages: grammatical categories such as tense, person or mood are equally important in
English, even if they do not systematically cause the form of a verb to change. Without context, the verb form eat, for
example, could be in the infinitive, the first-person present indicative, or a number of other categories. Yet in certain
categories, its form does change (ate, eaten, etc.).

In order to avoid potential mistakes, understanding why you are using the right form of a verb is just as important as
using it. For example, in the sentence “It is necessary that he go”, the form go — and not goes, went, etc. — is used
because the verb is in the third-person present subjunctive.

Perhaps because of the relatively limited variations in verb form, traditional English grammar resources have not
typically included complete conjugation information by grammatical category. Antidote, unconstrained by the limits of
paper reference material, provides a comprehensive set of tenses, moods and persons along with their corresponding
forms. Auxiliaries for compound forms are also listed (e.g. have in the past perfect have eaten), as is the progressive
aspect. This information is displayed clearly and intuitively in the form of a table, which can be expanded to show all
conjugations, or condensed to display only the main ones.

Naturally, you can still rely on the corrector to spot any conjugation mistakes, but checking the conjugation dictionary
can help you to learn, verify and compare in far greater depth. In all, over a million conjugations for over seven
thousand verbs are just a mouse click away!

THE DICTIONARY OF WORD FAMILIES

Some groups of words which may be far apart in terms of alphabetical order are nevertheless closely related from a
morphological and semantic point of view, like write, rewrite, unwritten. Learning new vocabulary would be much easier
if these “broken families” could somehow be reunited.
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That is what Antidote’s dictionary of word families sets out to do: group together words that have a common
morphological root and which all revolve around a common meaning. Some members are formed by derivation, in the
way that the adjective unwritten is derived from the verb write; others, by composition: the noun watch-glass combines
the words watch and glass. Of the 13,000 morpho-semantic families we have been able to assemble, some of the
particularly larger ones attest to the rich derivation system of the English language.

THE DICTIONARY OF QUOTATIONS

There is no better way to grasp the subtleties of how a word is used than being able to observe examples of the word as
it is employed in context. That is the purpose of the dictionary of quotations, which provides 300,000 example
sentences, none of which are drafted by lexicographers but rather are all drawn from literary and journalistic texts. This
dictionary offers up to fifteen quotations per word. The literary quotations appear first, presented in chronological
order, followed by newspaper quotations. Each is accompanied by a hyperlink reference, which allows you to access
the original website from which the quotation was taken.

The quotations are more linguistic in nature than literary. They have not been selected for their moral or poetic value,
but because they clearly illustrate the way a word is actually used. The corpus that was assembled to develop the
dictionary of combinations was put to use here again, which ensures that the quotations exhibit a large measure of
temporal, geographic and stylistic diversity.

THE HISTORICAL DICTIONARY

The birth of the English language is generally situated around the mid-seventh century. The oldest literary documents
written in Old English, the language of the Anglo-Saxons, are dated from this period. Descended from Proto-Germanic
and greatly influenced by Old Norse, Norman French and Latin, English slowly but surely came into its own, frequently
borrowing from its neighbours and invaders, such as for the words government (from Anglo-French and Classical
Latin), want (from Old Norse), tobacco (from Spanish and Arabic) and camera (from Late Latin and Ancient Greek), in
addition to creating its own words (work, night, hand…). The spelling and the current meaning of English words are the
product of this long evolution. Antidote’s historical dictionary tries to summarize this process in an original way,
shedding light in so doing on the richness of contemporary English.

The historical dictionary describes the etymology of almost 75,000 words; over a hundred of the more remarkable
entries also include detailed notes. It also showcases all the etymological relationships of each word. By cross-
referencing our etymological data, we were able to display all the words derived from the same etymon in a simplified
tree structure, which sometimes yields surprising connections, like discovering that the words shirt and skirt both derive
from the same Proto-Germanic root. Antidote contains over 1.8 million etymological links, and they paint a detailed
historical portrait of the English language.

The historical dictionary is supported by a special guide, tracing the evolution of English and describing the processes
by which new words are created. Moreover, in the corrector, the etymology filter allows you to trace first-hand the
genealogy of your texts, language by language, word by word.

THE LANGUAGE GUIDES

Antidote comes with a number of language guides covering a broad range of topics relevant for writing in English. They
contain close to 500 articles which explain in detail the rules and conventions that govern English. Written in an

INTRODUCTION  13



accessible style, the articles describe these rules and conventions and illustrate them with well-chosen examples. The
basic notions of English grammar are presented, and certain “tricks” are provided to help retain some of these. In each
guide, the articles are structured according to themes and sub-themes, enabling you to quickly cover all the aspects of
a given problem. An intelligent search function allows you to rapidly locate all the articles pertaining to a particular
subject.

For questions of grammar, style, punctuation and typography, our guides draw inspiration from a number of
authoritative references including The Cambridge Grammar of the English Language, the Oxford English Grammar,
New Hart’s Rules, The Canadian Style and The Chicago Manual of Style. Letter writing information in the business
writing section incorporates recommendations from the aforementioned style guides as well as the postal services of
the corresponding countries.

The lexical and spelling guides cover many difficult problems, some well-known and others less so. In conjunction with
the corrector’s style view, the style guide can help to improve the colour and tone of your texts.

The phonetics guide recalls the phonetic transcriptions found in the dictionary of definitions and conjugation. In some
19 articles, it describes the principles of the English sound system, and in particular two of its regional variants: General
American and General Southern British.

The historical guide is of a different nature; it is meant to support the historical dictionary. In 75 articles, this detailed
guide traces the evolution of English from its birth. A series of articles describe the many languages of the world from
which English has borrowed. Each article is linked to the etymological contents of the historical dictionary. Here, you
are told, for example, that nomadic comes from Middle French, which inherited it from Classical Latin, which had
borrowed it from Ancient Greek. Click on the name of a language and the historical guide opens to the corresponding
article.

It is this kind of interaction with Antidote’s other resources that makes the language guides so valuable. In addition to
the historical dictionary, when the corrector flags an error, it doesn’t just state its nature; it invites you to open the
relevant guide directly at the article which explains the rule that has been broken. Is this not the best way to learn?
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Antidote’s corrector provides a user-friendly working environment focused on your text. The corrector’s services are
displayed in the left panel of the main window as prisms: Correction, Revision, Statistics and Inspection. Each of these
prisms, divided into views and more precise filters, looks at the text from a specific angle. Behind this simple interface,
the corrector deploys a powerful analyzer that first segments the text into its major divisions, and then performs a
detailed analysis of each word in the sentences that compose the text. The result is a grammar checker that pushes the
boundaries of current computer science.

Antidote cooperates closely with your writing software: it reads your text directly and makes whatever corrections are
necessary within that program. When you’re writing, run the corrector at any point to check a sentence, a paragraph or
the entire text. This may be at the beginning of your writing process, if something you’re drafting makes you hesitate. It
could also be after making some edits to ensure that you haven’t introduced new errors, or after finishing a text for a
final check. If you need several working sessions to correct a long text, Antidote will remember all detections that you
previously ignored, so that you can pick up your work later just where you left off.

ACCESSING THE CORRECTOR
Antidote begins analyzing your text from the cursor’s position. Place the cursor in the sentence where you want the
checking to begin. If you wish to submit only part of your text, select it and then call up the corrector.

 THE CORRECTOR3

To optimize access to Antidote from your other software, see Using with your other software, in the Antidote Help menu.➞
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THE CORRECTION PRISM
The results of Antidote’s correction are presented in three parts. This section describes how
the Language view and the Typography view operate. The Style view is described
separately (see The Style View)

THE LANGUAGE VIEW

The corrector’s Language view can help you avoid a wide variety of language pitfalls: errors related to spelling,
conjugation, possessives, grammatical agreement, irregular syntax, hyphens, punctuation, upper and lower case,
homophones, etc. Antidote does not just identify and correct mistakes: it actually explains them in the context of what
you have written, enabling you to learn while making corrections.

THE TYPOGRAPHY VIEW

Antidote will correct the type of spacing required before or after a given punctuation mark, detect hyphens that are
used where dashes should be, correct the format of numbers, times and addresses, etc. Certain typographical elements
are invisible (is that a hard space or a soft one?) or difficult to detect with the naked eye (is that a breaking or a non-
breaking space?). By checking them automatically with Antidote, you can be sure they are all accurate and complete.

THE CORRECTION PROCESS
When the corrector is first called up, Antidote initially displays the results of the Language view. To proceed with the
correction, select the Typography view. If you haven’t checked all flagged typographical errors before closing the
corrector, Antidote will display a warning dialogue. You have the option of confirming your decision to close, or you can
review the typography. If you wish, you can request that Antidote no longer display this dialogue.

The corrector analyzes the complete text you submit to it and displays that text
in the correction panel, underlining each error or questionable word.

The tooltip

See the Corrector section in the Settings chapter to adjust the corrector’s general operations.➞

See the Language section in the Settings chapter to adjust the parameters for this view.➞

Typographic conventions have been codified to varying degrees; Antidote applies “generally accepted rules”.➞
See the Typography section in the Settings chapter to adjust the parameters for this view.➞

A setting in the General panel of the Corrector section allows you to correct language and typography simultaneously.➞

The underlining serves to flag a detection. For rapid and intuitive
interpretation, each type of detection (error, alert, etc.) uses a distinct
type of underlining.

The tooltip contains everything you need to understand the detection
and to take action. Antidote may propose a correction, but will not modify your text unless you approve it. This
can be done using the following methods:
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Tooltips appear next to the detections themselves, so they are the ideal place to deal with
detections without losing the thread of the text. They include an options bar allowing you
to choose between relevant actions according to the detection, all in the blink of an eye.

The toolbar
The tooltip’s options are also available in the corrector’s toolbar, located at the top of the
corrector window. To apply a toolbar button’s action to an underlined word, first select the
underlined word and then click on the button.

The context menu
The context menu appears when you right-click on a word (or ctrl  + click on a Mac). The content of the menu varies
with the nature of the detection, so that only the relevant options are presented.

The mouse
Shortcuts allow you to apply most of the corrector’s actions to a detection simply by pointing and clicking on the
underlined word. This allows you to correct an entire text very quickly. These shortcuts together with their
corresponding commands are described in the Handling a detection section later in this chapter.

The keyboard
You can correct your entire text using only or mainly the keyboard. Keyboard shortcuts give you access to almost all of
the corrector’s actions. These shortcuts together with their corresponding commands are described in the Handling a
detection section later in this chapter.

Editing a text during correction
At any time during the correction process, you can modify your text directly in the correction panel. One of the main
ways to do so is via the Edit button in the tooltips. You can also return to your text editor and make changes to your text
there. When you return to the corrector, it will take those changes into account and reanalyze the modified sentences.

Set the languages of a multilingual text
Antidote uses an algorithm to identify non-English passages in multilingual documents. It does not analyze or correct
these passages. If, for example, Antidote is unable to identify one of these passages itself, you can do so manually using
the Language of the selection and Language of the document options in the context (right click) menu or in Antidote’s
Corrector menu.

Interrupting a correction session
To interrupt a correction session and return to your text editor, simply close the correction window by clicking on the X
button in the corner. To interrupt the correction process but remain in the corrector, hit Esc  in Windows and in Linux.
On a Mac, hit cmd  + . .

Non-English passages are shown in a different colour and are marked with a light blue area in the margin.

The Languages filter under Statistics shows the overall distribution of languages in the text.
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TYPES OF DETECTIONS AND UNDERLINING

Underlining colours
Antidote uses two colours, red and orange, to present its correction results. These colours apply to different types of
errors and they help you to determine which should be addressed first.

In the Language view, the red underlining is more striking and serves to indicate the most important errors. The orange
underlining, which is more discreet, is used for a word which may be a possible error. The red underlining may be solid
or dotted. The orange underlining may be thin or wavy. The following paragraphs explain how each type of underlining
is used in Antidote.

Solid red underlining: a corrected error waiting for approval
Solid red underlining flags a major error that Antidote can correct on its own:
in the tooltip, it displays the proposed correction in green. You need only
approve it to have it applied in the text. If you refuse the proposed correction,
your text is not modified.

Dotted red underlining: an error to correct manually or an inconsistent spelling
Dotted red underlining flags a major error that Antidote can’t correct on
its own: it’s up to you to modify the text.

You can make the correction directly in the correction panel by clicking the Edit option in the tooltip, or by returning to
your original document. The context (right click) menu option Edit in original document will take you quickly to the word
to be modified.

Inconsistent spelling
Antidote can detect cases where different spellings are used for the same word within
the same text (e.g.: ax and axe). It underlines the less frequent spelling in the correction
panel and groups together all the variant spellings in the Inconsistencies section in the
list of detections. The tooltip will propose the most plausible replacement for each of
these variant spellings: simply click on Make uniform to standardize the spelling across the text.

Thin orange underlining: an alert
Thin orange underlining flags an alert, i.e. a potential error. Antidote indicates
that this word may be an error, but it’s up to you to decide.

This may be because you are using a word that is unknown to Antidote or a word
that is perhaps inappropriate in the context (e.g.: clod is an informal word in the
sense of “a dull person” but not in the sense of “lump of earth”).

If Antidote was right in signalling this alert, you can rephrase the text with the help of the suggestions provided in its
tooltip. You can also use the context (right click) menu to look for a replacement synonym (select Synonyms of “word”).

In the list in the right-hand panel, these detections are grouped under Errors.➞

In the list of the right-hand panel, these detections are grouped under Errors. In
the example shown to the right, the corrector detected an incoherent date but
can’t correct it because it doesn’t know what was intended: June 30 or July 31.

➞

The settings allow you to customize the alerts (see the Settings chapter).
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Wavy orange underlining: several possible spellings
In a few cases, the corrector might come up with two or more competing
spellings for a word. Wavy orange underlining indicates words for which
the original word may be correct, but other spellings are possible
according to the intended meaning. In the tooltip, Antidote shows all these
spellings. If the original spelling is correct, click Ignore in the tooltip to
move on. Otherwise, choose the spelling that best fits the context, and
then approve the correction to have it applied in the text.

Dotted orange underlining: discontinuities
Sometimes, Antidote may have trouble analyzing a sentence in its entirety,
unable to identify the exact syntactic function of each word in relation to
others. Generally, this is caused by a complex error, such as a missing or
superfluous word. Antidote underlines the affected area with a dotted orange
line.

Examine the words in and around the underlined passage to detect the error. If needed, use the dictionaries and
guides to check your word usage. Once you understand any errors, you must correct them manually. Once you have
finished, the corrector will see your changes and will reanalyze the sentence. If the problem that prevented correct
analysis is eliminated, you may see new errors or alerts that didn’t appear before.

Discontinuities are not always caused by errors. They may be the result of unusual elements or syntax structures that
Antidote is not familiar with. If this is the case, try temporarily removing the elements in question so that the corrector
can complete its analysis. Otherwise, you can simply ignore the discontinuity and move onto the next detection.

Thick orange underlining: a corrected typographical error waiting for approval

The thick orange underlining indicates a typographical error (apostrophe,
space, quotation mark, number or time format, etc.) that Antidote can
correct on its own. In the tooltip, Antidote displays a brief explanation of the
flagged problem. You need only approve it to have it applied in the text. If
you refuse the proposed correction, your text is not modified.

Thick dotted orange underlining: a typographical error to correct manually

The settings allow you to customize the alerts (see the Settings chapter).

➞
In the list of the right-hand panel, these potential errors are grouped under Alerts or Unknown words, as appropriate.➞

In the list of the right-hand panel, these potential errors are grouped under Ambiguities.➞

Important: In areas where discontinuities occur, Antidote’s corrections are less reliable. It may both miss errors and make false detections.
To warn you of its uncertainty, it adds the warning To review to the tooltip.

➞
In the list (right-hand panel), these detections are grouped under Discontinuities.➞

To view these detections, you must select the Typography view (left-hand panel).➞
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A thick dotted orange underlining indicates a typographical detection that
Antidote cannot correct on its own. To make any corrections, you must
modify the text manually by following the indications in the tooltip.

SYNTACTIC CATEGORY AND FUNCTION TOOLTIP

The Syntactic category and function tooltip describes the syntactic
category and function of each element of the sentence (word,
expression, punctuation, etc.). To display it, select Syntactic category
and function in the context menu (right click). The category and
function then appear under the selected item.

HANDLING A DETECTION
Each underlining in the text is an indication that the corrector has detected a problem, certain or possible, concerning
that underlined word. The tooltip helps you understand the nature of the problem, and you have several options to
correct it, if necessary. When you select an underlined word, it becomes the current detection. Most commands that
follow in this section apply to the current detection. Note, however, that you can use the shortcuts offered via the mouse
instead of selecting the current detection. (See the Handling a detection in the list section as well.)

TOOLTIP

When you select an underlined word, a tooltip will appear showing all the information you need to evaluate the
detection and proceed accordingly. The tooltip is divided into three zones, described below.

The suggested correction
The suggested correction appears in the top left-hand corner of the tooltip. Its format varies depending on the type of
detection.

green bold: Suggested correction related to an error of syntax, grammar,
punctuation, etc. (bold underlining). The command correct is provided.

black italic: Suggested correction related to an alert (fine
underlining). The command Replace is provided. These detections
are often dependent on meaning, so the suggestion may not
always be valid, hence the more discreet appearance.

To view these detections, you must select the Typography view (left-hand panel).➞

In the interface settings (General panel, under Corrector), tooltips can be set to appear when the pointer hovers over them, and the time
before they appear can be adjusted.

➞
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black standard: in the absence of a specific suggested correction,
Antidote indicates the type of detection (e.g. redundancy, informal), and
gives a brief instruction (e.g. Evaluate), or asks you to check something
(e.g. Appropriate?). Refer to the contextual explanation for details.

Number of identical detections
A number in parentheses appears to the right of some detections. This indicates
that the corrector has identified other identical cases in the text. These cases are
underlined, allowing you to quickly find them. If the detection allows them to be
corrected at once, the selected action will apply to all the cases.

The contextual explanation
Each detection in the corrector includes an explanation, allowing you to understand
and evaluate Antidote’s intervention. Sometimes, it may be necessary to evaluate multiple aspects of the same word. In
this case, Antidote will provide the all the necessary contextual explanations.

[Details]
Certain explanations are followed by a [Details] option. This can occur if their
content is larger or its structure is more complex. Click to show the entire text.

Setting…

Several detections, particularly linguistic alerts, are associated with a setting.
Here, Antidote displays the word Setting after the contextual explanation. Click it
to open the relevant panel and then adjust the desired setting.

The next level of explanation
The heading introducing the contextual explanation is a hyperlink that opens the most appropriate resource,
depending on the type of detection. In keeping with the guides’ emblematic colour, an orange heading takes you to the
right page of the guides, where you will find a detailed explanation of the subject of the current detection. In keeping
with the dictionaries’ emblematic colour, a green heading opens the dictionaries to the definitions or conjugations of
the word in question.

The commands
The commands for actions relating to the current detection are located to the right of the suggestion. For detailled
descriptions of each one, refer to the later sections Approve a correction and Ignore a detection.

Searching for other words (the magnifying glass)

You can also access this second level of explanation (guides or dictionaries) by pressing the +  key. To return to the corrector, close the
guides or dictionaries window by clicking on the close button.

➞
A black heading means that no supplementary link is considered necessary.➞
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For some detections, for example unknown words, a magnifying glass ()
accompanies the commands in the tooltip. This performs a search in the
dictionary for words that are graphically similar to the detection in question. It
then displays the most relevant results in a list. If that list includes the word you
want, click on it to make an instant substitution in your text.

Several possible spellings

In the Language view, the tooltip may list several suggestions. This
happens when there is more than one possible analysis for a
sentence and the spelling of the word changes according to the
intended analysis. If the original word may also be correct, it
appears in black.

The selected suggestion has a darker background and its corresponding contextual explanation is shown below it. If
you select an alternative suggestion, the darker background will move and the contextual explanation will change.
After considering the different suggestions, make your choice and apply it, allowing Antidote to modify your text
accordingly.

Discontinuity warning
When the corrector is unable to analyze a sentence in its entirety, it will still display detections, but it will be less sure of
its diagnosis in these cases. The tooltips for such detections are labelled Review to warn you of the corrector’s
uncertainty.

APPROVE A CORRECTION

To approve a correction, click the Correct command in the tooltip. The proposed correction is inserted in your text and
underlined in green. The corrector then moves on to the next detection. For alerts including a suggestion for
replacement, click the Replace command.

The All results option at the bottom of the list opens the
dictionaries, allowing the complete range of search results to be
displayed. If you find the word you are looking for there, click on it,
then proceed to make the substitution by clicking Replace in the
dictionaries.

➞

In the interface settings (Appearance panel), the underlining colour of a corrected detection can be set to blue instead of green.➞
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In other cases, the appropriate correction must be made manually, either directly in the correction panel using the Edit
command, or in the original document, using the Edit in original document command in the context (right click) menu.
In both cases, you reactivate the corrector by clicking on its window. The modified sentence will be re-checked and you
can continue with the correction.

Correct identical cases
By default, when several detections are identical to the current one, Antidote will apply the correction of the current
detection to all the following cases as well. If you prefer, you can avoid this batch correction by using the command
Correct this case.

IGNORE A DETECTION

If you do not wish to make the change proposed by Antidote, you can simply go on to the next detection, or click on
Ignore. The original text remains intact and Antidote moves on to the next case. Clicking on Ignore changes the
underlining to a dotted black line; in the list of detections, an “X” is displayed next to the corresponding entry. This
shows you at a glance that this case has been processed. The ignored case is also subtracted from the correction
statistics.

Antidote automatically keeps a record of the cases that have been ignored during a checking session. Thus, if you have
to interrupt the checking of a document and then come back to it later, the previously ignored cases will not be
displayed again. You won’t waste time having to re-evaluate them.

Ignore identical cases
By default, when several cases are identical to the current detection, ignoring the current detection will tell Antidote to
ignore all the following cases as well. If you wish, you can ignore only the current detection by using the Ignore this
case command.

A number enclosed in parentheses in the tooltip indicates how many cases are identical to the current detection.➞
In the list of detections, identical cases are grouped under a single entry accompanied by a circled number. Clicking on this number causes
all the individual cases to be displayed, allowing them to be handled separately.

➞
Note that the corrector flags as identical only those cases that do not depend on the context, which is what allows them be corrected in
batch mode.

➞
“Identical errors” does not always mean “identical words”. Incorrect spacing between a day and a month, for example, applies to any date.➞
A setting in the General panel of the Corrector section lets you disable the automatic correction of identical cases. The Correct these cases
command can then be invoked to batch-correct a specific group of identical cases.

➞
The commands Correct this case and Correct these cases can be accessed quickly from the context (right click) menu.➞

A setting in the General panel of the Corrector section controls whether ignored cases are remembered by the corrector.➞

A number enclosed in parentheses in the tooltip indicates how many cases are identical to the current detection.➞
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Disable
Antidote allows you to hide the alerts on a particular word. Perhaps you’re already aware that reunion is a false friend
and no longer wish to be alerted about it in the future. Click the Disable command in the tooltip and Antidote will stop
alerting you about this particular word.

GO TO NEXT/PREVIOUS DETECTION

To move to the next detection or to return to the previous detection, use the navigation arrows in the corrector’s
toolbar.

ADJUST SENSITIVITY

You can adjust the corrector’s level of sensitivity for certain types of errors.

In the list of detections, identical cases are grouped under a single entry accompanied by a circled number. Clicking on this number causes
all the individual cases to be displayed, allowing them to be handled separately.

➞
A setting in the General panel of the Corrector section allows you to stop the corrector from automatically ignoring identical cases. The
Ignore these cases command can then be invoked to batch-ignore a specific group of identical cases.

➞
The commands Ignore this case and Ignore these cases can be accessed quickly from the context (right click) menu.➞

The Disable command only applies to alerts.➞
A dialog warns you that the alert for the word in question will no longer appear at all. Click on OK to continue, or click on Disabled alerts to
manage the settings for the alert. This warning can be turned off.

➞
To manage the list of words associated with disabled alerts, see the section entitled Disabled Alerts Panel in the Settings chapter.➞

The Settings chapter describes all the language and typography settings available. When the settings are opened from the corrector, they
open at the panel that applies to the current detection. The Setting command in the tooltip is more precise, since it links to the setting for an

➞
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DIALOGUES AND QUOTES

In a novel, the dialogues reproduce the characters’ spoken language, and consequently they contain certain things that
are not generally accepted in the standard written language: informal words, unusual contractions (e.g.: that’d), more
colloquial turns of phrase (e.g.: Beats me!), swear words, etc. Furthermore, quotes reproduce the words of another
person and, as such, should generally be left as is. You can tell the corrector not to flag certain stylistic errors in these
passages, while continuing to flag them in the main body of the text. See the Settings chapter for details.

PRESETS

Presets allow you to quickly switch from one configuration of settings to another. Antidote provides separate groups of
settings for its Language and Typography views, so that you can select the ideal combination for every writing context.

For a simple email to a friend, for example, you will probably opt for a tolerant combination of settings, e.g. Informal
usage and Basic typography. For an official document, on the other hand, you will likely choose Formal usage or Flag
all for the language checking, together with Formal typography.

Linguistic presets
Flag all: The corrector adjusts all the settings related to alerts to their maximum value.

Formal usage: The corrector adjusts the values of its linguistic settings in order to carry out an exhaustive check.
Informal usage: The corrector adjusts the values of the linguistic settings to a more permissive level. All the settings
related to alerts are disabled. Antidote will also tolerate certain mistakes; for example, it won’t flag the informal
determiner in Lots of people hate coriander.
Custom usage…: The corrector uses your current linguistic settings, which differ from the standard presets.
Hide alerts: The corrector displays no alerts. This is useful if you are short on time and want to progress as quickly as
possible.

Typographic presets
Formal typography: The corrector adjusts all typographic settings in order to carry out an
exhaustive check.

Basic typography: The corrector disables most settings related to typography in order to verify only the most blatant
typographical errors (double space between words, for example).
Custom typography…: The corrector uses your current typographic settings, which differ from the standard presets.

ADD A WORD TO A PERSONAL DICTIONARY

Antidote may inform you that it doesn’t recognize a certain word. To add that word to one of your personal dictionaries,
select it and click the Add command in the tooltip. The personal dictionaries window will open, showing your newly
added word. If Antidote’s automatic analysis of the word seems correct to you, you may simply close the window.
Otherwise, fill in or edit the various fields so that Antidote knows how the word should be used. See the Personal
dictionaries chapter for more details.

individual alert in the case of multiple alerts for the same word.

A small speech bubble () inserted in the left margin of the text allows you to rapidly locate dialogues and quotes.➞

The list of detections updates with each new preset selected.➞
Spelling and grammar errors are always displayed, regardless of the language preset chosen.➞
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The flagging of unknown proper nouns depends on the Flag unknown capitalized words setting in the Capital letters
panel. Click the Setting command to access it as needed.

Simultaneously add several words to a personal dictionary
Antidote groups together all unknown words in the list of detections. To add several of
these to a personal dictionary at the same time, select the desired words and then use
the Add to a personal dictionnary… command (in the toolbar or the context menu).

UNDO A CORRECTION

You can cancel a correction that has already been made to your text. When you select an error that has already been
corrected, the Correct command in the tooltip changes to Restore. Click on the arrow to undo the correction in your
text. Both the underlining and the suggested correction return to their initial state.

LIST OF DETECTIONS
The right-hand panel of the window displays the list of detections based on your
selection in the prisms panel. These results are presented in chronological order of
appearance. In the Correction prism, the results are first divided into major classes, and
then presented in chronological order within each class. In certain cases, the grouping
together of identical cases may slightly alter the chronological order. Since each entry in
the list corresponds to a detection in the text, selecting a word in one means also
selecting it in the other.

The format of the list intelligently adjusts to the view or the filter that is selected in the
prisms panel in order to take into account the specific nature of the various types of
detections. The following paragraphs describe in some detail the format of the list for
the Language view and the Typography view. For the characteristics of the Style view
and other filters, see the section devoted to each in the pages that follow.

CLASSES OF DETECTIONS

In the correction views, detections are grouped into homogeneous classes. These classes are
particularly useful in the Language view, where the errors require a different sort of thinking
than that required by alerts. Evaluating each class separately allows you to concentrate more and actually speeds up
the correction process.

In the Language view, the classes are: Errors, Inconsistencies, Unknown Words, Discontinuities, Ambiguities and Alerts.
These classes are presented in order of priority, with the most serious cases (errors) coming first.

Errors: Errors are displayed in two columns, with the incorrect word on the left and the proposed correction to the right.
Where appropriate, the modified or deleted characters are indicated in red on the left, and the modified or added
characters are indicated in green on the right.

The number of detections appears to the right of the name of each class. Only classes with at least one detection are displayed. The
triangle to the left of each class name hides or reveals its content.

➞
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Inconsistencies: Each spelling inconsistency is denoted by a title line which lists the different spellings for the same
word. Under that line, slightly indented, appears each variant spelling along with its frequency.

Unknown words: Unknown words are listed in their own class.

Discontinuities: For each discontinuity, the passage affected by it appears in the list. The discontinuity may include a
syntactic error.

Ambiguities: Ambiguities are followed by the menu of possible spellings. Click on the two small triangles to the right to
select the one that best fits the context.

Alerts: A brief description in italics is displayed to the right of each alert.

In the Typography view, the classes of detections are General, Spaces and Conventions.
The Conventions class includes errors related to the format of numbers, times, address
and other elements of business writing.

Typographical errors tend to be very uniform and do not demand much thought. For
example, all end punctuation in a text follows the same spacing conventions. The
corrector’s presentation here is more generic than specific. Thus, all flagged
typographical errors that occur in the same context are grouped under one generic
heading, displayed in italics: Dash around parenthetical expressions, Space before “;”,
etc. Click on the Correct all button above the list of detections to correct all the flagged
typographical errors in the list at once, or double-click on a generic title to correct just that subset at once.

HANDLING A DETECTION IN THE LIST

When editing a text, you can use the list of detections or the correction panel as your workspace. You can choose one or
the other depending on your needs. The main advantage offered by the list is that you can easily process a large
number of detections at the same time, or even the entire list!

All the commands described in the Handling a detection page may also be applied to the entries in the list. The major
commands that follow can be applied just as well to a single error as to several. First, select the detection or detections.

Correct
To make the proposed correction, double-click on the selection, or select Correct this
case or Correct these cases in the context menu. A green checkmark appears in the left
margin; the correction has been made in the text.

Restore

The number of occurrences of each type of detection is displayed to the right of the generic title. Click on this number to view all the
detections in question.

➞
Once clicked, the Correct all button becomes Restore all. Use this command to cancel the correction of all the errors in the list.➞

In the case of a suggested correction linked to an alert, the option Replace, rather than Correct,
appears in the context menu.

➞
In the case of an inconsistent spelling, double-click on the spelling you wish to keep, then select the option Apply uniform spelling. The
corrector will automatically modify all the other spellings. The context menu also offers this option.

➞
In case of an ambiguity, first click on the small menu to the right to choose the spelling that best suits the context.➞
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To restore the original spelling, double-click again, or select Restore this case or Restore these cases in the context
menu. The green checkmark disappears and the original spelling is restored in the text.

Ignore
To ignore the proposed correction, select the option Ignore this case or Ignore these
cases in the context menu. An “X” appears in the left margin.

Other commands
For the other commands, the context menu (right click) is ideal. Its options adjust
intelligently according to the type of detection.

Handle identical cases in the list
In the list of detections, identical cases are grouped together under a single entry
accompanied by a circled number. When you click on the circled number, Antidote
displays all the identical cases, indented under the first instance. To deal with them all at
once, double-click on the line with the number, or select the Correct these cases option in the context menu.

Search in the list
You can restrict the list to a particular word. Click on any entry to place the cursor in the list. Call up the Search…
command (via the context menu, the Edit menu, or using the keyboard with the shortcut ctrl  + f  in Windows and
Linux, or cmd  + f  on Mac), and enter the search word in the text field that appears above the list. The number of
items in the list shrinks as you type. Click on the Done button to return the list to its previous state.

Export the results
You can export the contents of the list to an external document by performing a copy and paste. Display the desired
results, e.g. the list of detections, proper nouns or borrowings from Latin. Select the desired items and then select Copy
from the context (right click) menu; then paste your selection into an Antidote document or a document of any other
program.

THE STYLE VIEW

In the case of a suggested correction linked to an alert, the option Reactivate, rather than Restore, appears in the context menu.➞

Once you have dealt with them, the detections are automatically greyed out, so you can easily identify all those that remain to be assessed.➞

In two-column lists, the search applies to the terms in the left-hand column.➞
To see the search results in the list of flagged typographical errors, you have to display the individual cases grouped under the generic
titles.

➞
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Antidote can shed light on three traditional stylistic concerns: repetitions, particular
constructions and vocabulary. It can also evaluate the general readability of a text through
its different elements. The new Gender neutrality filter examines how a text can better
represent both women and men without affecting its overall style. Unlike the Language and
Typography views, the Style view tackles the text from a qualitative angle, without being
prescriptive. The notion of error has no place here. At this stage, the corrector’s goal is to
help polish the text by making it less cumbersome and by enriching it with more dynamic or
inclusive vocabulary. Antidote makes your job easier by highlighting all instances of the
stylistic phenomenon under consideration. If a sentence has to be recast, you can edit it directly in the correction panel
or in your writing software. Not feeling particularly inspired? Use the context (right click) menu to view the main
synonyms for the selected word. Then, simply click on the synonym of your choice to insert it directly into your text. The
following sections describe in detail the nature of Antidote’s stylistic detections.

REPETITION
Two or more repetitions of the same term in close proximity can weigh a text down. Antidote intelligently locates all
potential repetitions in your text. Select a highlighted word and Antidote immediately displays all its other occurrences
in orange.

Where appropriate, you can avoid the repetition by replacing the second term with a pronoun, substituting a synonym
for the term, or reformulating the passage so that only a single occurrence is necessary.

Simple options, accessible at the bottom of the list of detections, allow you to personalize the results.➞
Dialogues and quotes often exhibit a particular style that you may want to leave intact. To exclude them from the style checking, see the
settings in the General panel of the Corrector section.

➞
Note that the underlining in the Language view remains visible in the Style view, although it is greyed out. The tooltips and their commands
also remain available.

➞
The list of detections is grouped according to category for consistent evaluation, and each one is distinguished by a colour code.➞
Only categories with at least one result are shown in the list. The total number of results is shown to the right of each category title. If there
are more than five results, only the first five are shown. Click and x others to see them all, and Reduce to 5 results to revert to the shortened
list.

➞

To disable detection of a particular category, uncheck the corresponding box to the right of its title in the detections list.➞
To hide the results of a particular category in the list of detections, click on the triangle to right of the category’s title to collapse the list.➞

Use the Synonyms of “word” option in the context (right click) menu to find a synonym quickly and make an instant substitution.➞
The corrector does not consider titles here, because they invariably repeat material from the text that follows (although a repetition within
the title itself will be flagged). As for proper nouns, it flags a repetition when there are four or more occurrences of a particular proper noun
within the same paragraph. The corrector also overlooks certain other circumstances where repetitions may be justified.

➞
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Options panel
Range: The range is the maximum distance between two terms that will be considered
repetitions. The shorter the range, the fewer the repetitions; the longer the range, the
more repetitions. Note that the range takes sentence boundaries into account.

Words from the same family: Detections may or may not include words of the same
family (such as force and forceful).

Include: In certain types of texts (scientific, legal, etc.), precision prevails over style. The
repetition of a precise expression, rather than an approximate synonym, may then be acceptable or even required. If
so, uncheck the appropriate categories of words in order to exclude them from the flagged repetitions.

CONSTRUCTIONS
An important source of a text’s verve is its syntax; ideally, we would like it to be varied, fluid and elegant. The corrector
flags certain problematic constructions that should be closely monitored: the passive voice, impersonal or negative
constructions, verbless sentences and wordiness. These are not incorrect in themselves, neither are they to be excluded
at all costs; however, they should be employed sparingly.
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Passive voice
Passive constructions (in which the verb is conjugated with be and the subject undergoes the
action rather than being the active agent, e.g.: the film was lauded by the critics) are useful when
you want to focus on the object rather than the subject. Otherwise, an equivalent sentence in the
active voice usually has more impact (e.g.: the critics lauded the film). A text with too many passives can seem
impersonal or even disembodied.

Impersonal constructions
Antidote can quickly locate the impersonal constructions in your text and help you avoid their
overuse. Although they are at times useful, impersonal constructions have the disadvantage of
moving the real subject to the end of the sentence. This is appropriate if you want to focus on the
theme of the sentence. In other cases, however, an impersonal construction (e.g. it is imperative that…) can give the text
a cumbersome feel.

Negatives
Make sure that negative constructions effectively convey your intended meaning, particularly
when a sentence contains more than one negation. It can be a challenge to understand multiple
negations when they are embedded within each other or appear in succession (e.g., it isn’t
impossible that she won't arrive on time). As a general matter of style, it is usually preferable to reformulate negative
constructions as positive ones, provided that the negation is not essential to your message.

Verbless sentences

Clicking on the options bar will show you sliders associated with each category of construction. You can choose whether to perform
exhaustive checking or to speed things up by focussing only on the most blatant cases of the construction in question. See the tooltips
associated with each of the slider’s positions to help you decide which one to select.

➞
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Because it expresses the action that links the subject and its object, the verb normally forms the nucleus of the
sentence. Hence, a sentence without a verb, or a sentence whose nucleus is nonverbal, immediately appears shaky. The
corrector highlights the sentences in your text that lack a main verb, allowing you to determine whether a paraphrase
with an explicit subject and verb would be preferable.

Split infinitives
A verb in the infinitive is said to be “split” when an adverb is placed between the particle to and the verb itself (e.g. to
heartily agree). Split infinitives are widely accepted in both written and spoken English. Nonetheless, they are
occasionally considered incorrect. If this concerns you, using this filter will allow you to locate and reformulate split
infinitives if you consider it necessary.

Wordiness
This filter locates passages in which many words are used to express a relatively simple idea. These wordy
constructions can usually be reformulated, making your text lighter and easier to read. For example, you may wish to
replace what you can do is with you can, or in addition to with and.

VOCABULARY
Words convey our thoughts; hence, we need to select them carefully, so they reflect those thoughts as accurately as
possible. Antidote will draw your attention to certain classes of words in your text which may be problematic, including
redundancies and words that may be inappropriate or offensive, which you will generally want to avoid; regionalisms
and words that belong to a particular register, which you will also want to verify; and certain commonplace verbs,
which you might like to liven up. If any reformulations are necessary, use the Synonyms of “word” option in the context
menu to find a synonym quickly and make an instant substitution.

Note that in checking for verbless sentences, Antidote ignores titles.➞
The number shown to the right of each detection shows the number of words in each verbless sentence. Longer verbless sentences are
more likely to be the result of an omitted word, so you may wish to check them first.

➞
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Redundancies
A redundancy is an expression whose meaning is unnecessarily repetitive (e.g.: young puppy, free gift, added bonus,
etc.). They are best avoided!

Register
A word that belongs to a non-standard register is likely to strike a false note in your text. The word may be the result of
a deliberate stylistic choice, or it may be a mistake, in which case you will probably want to replace it with a neutral
synonym.

Offensive
The corrector draws your attention to words that could be considered offensive (slurs, insults, vulgar terms, etc.). Make
very sure their use is justified in your text.

Regionalisms
Employing a word or phrase whose use is limited to a particular linguistic region can increase the risk of
misunderstanding. Antidote allows you to quickly spot words that are specific to a given English-speaking country,
including Canada, the US, the UK and others.

Commonplace verbs

A tooltip is provided for all vocabulary detections except for commonplace verbs.➞
The vocabulary problems that are flagged (except for commonplace verbs) depend on your language settings. Click on the small settings
icon to the right of each class to access the corresponding settings. Note that the new values of the settings will also apply to the checking
done in the Language view.

➞

THE CORRECTOR  33



The verb expresses the action of a sentence, serving to link the subject and the object. Thus, the
verb has an important role to play: it has to make a good impression on the reader. Antidote will
locate the “empty” verbs in your text and those that are overused, so you can replace them with
“full” verbs that carry a distinct and precise meaning. So instead of writing She is doing an
experiment in nuclear medicine, you might prefer She is conducting an experiment in nuclear
medicine.

Nominalization
Nominalization is the use of nouns that are derived from verbs or adjectives by the addition of a suffix such as ment or
ment. Excessive nominalization, particularly when the verb or adjective is much more common than the noun, can
weigh down a text or make it less easy to understand.

Non-contracted forms
Careful use of contractions (e.g. haven’t, won’t), as opposed to non-contracted forms (e.g. have not, will not), can help
your text flow smoothly.

READABILITY
A text’s readability is considered optimal when it reads fluently and its content is easily understood by the target
audience. It is measured according to various elements in the text, particularly the length of words and sentences, as
well as the accessibility of its vocabulary. Antidote provides you a list of the elements in a text that may be detrimental
to readability, prompting you to examine them more closely.

Long sentences

The verbs be and have are not included among commonplace verbs when they function as auxiliaries.➞
A slider allows you to verify all the commonplace verbs in your text or, for faster processing, only the most flagrant cases. Consult the
tooltip associated with each point in the slider for the selection that best suits your needs.

➞
Include the verb be: The verb to be is extremely frequent, and in many constructions it is difficult to find a synonym for it. Antidote therefore
allows you to exclude it. To do so, uncheck the box.

➞
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Overly long sentences can confuse your readers or slow them down.
Separate your ideas and divide up long sentences using a period or a
semicolon. But be careful not to introduce unnecessary repetitions!

Nested phrases
Sequences of nested phrases can affect the flow of your text and make it hard to understand. The corrector flags those
sentences which would benefit from a paraphrase with fewer embedded modifiers. To make things easier, the
prepositions, conjunctions and possessives that introduce these phrases are highlighted.

Long words
Long words can be detrimental to a text’s readability, especially if they are not in frequent use and contain a large
number of both letters and syllables. Try not to use them excessively, particularly in texts written to be read aloud, or
your reader might stumble!

Rare words
Certain uncommon words can hinder your readers’ comprehension of the text. These include, for example, highly
technical terms, neologisms, or terms that are no longer in use. The Rare words filter reveals all such words that are not
frequently used, allowing you to modify them for your readers’ benefit. Replace them, if need be, with a more common
synonym, or paraphrase them.

Foreign expressions
Certain expressions that originate in other languages are well established in English (e.g. curriculum vitae). However,
others are less common and may make your text more difficult to understand. Make sure that they are correctly used
and adapted to your intended readership. If needed, you can choose a more universal synonym by selecting Synonyms
of “word” from the context (right click) menu.

Unknown words

The word count does not include punctuation.➞
Set the threshold, i.e. the number of words, above which the corrector will consider a sentence as being too long.
This threshold can vary depending on your style or the nature of the text. By default, Antidote sets the threshold at
45 words or more.

➞

The list of detections sorts sentences according to their order in a text. If you want to work through them in order of length, check the Sort
by length option.

➞

A slider allows you to choose whether to flag all long words, or those of varying degrees of significance, according to frequency and
number of syllables.

➞

A slider allows you to adjust the number of rare words that are flagged, according to their relative rarity.➞
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The Unknown words filter flags all terms that are not known by Antidote’s dictionaries. If your readers don’t know one of
them either, they may find certain passages difficult to understand. You may want to specify its meaning, or replace it
with a more universal synonym by selecting Synonyms of “word” from the context (right click) menu.

Abbreviations
Abbreviations lighten a text by reducing the length of frequent words; acronyms avoid the repetition of complex
expressions. Make sure that your text is clearly understandable by defining acronyms the first time that they are used,
even if you consider them to be well known.

GENDER NEUTRALITY
Unless you are referring to an individual person whose gender you know, or if gender is otherwise relevant to your
message, it is advisable to use gender-neutral language to eliminate bias in your text. Additionally, many gender-
specific terms are beginning to fall into disuse and may make your text seem out-of-date. The gender neutrality filter
includes two categories of detection.

Nouns
This includes nouns for gender-specific job titles, such as policeman above, as well as words that exclude a gender
when referring to a group that may be (or certainly is) mixed-gender, such as wives or mankind. In the vast majority of
cases, these nouns can easily be substituted for gender-neutral equivalents, such as police officer, spouses and
humanity.

Pronouns
Gender-specific pronouns and their associated determiners, such as he or his, are obviously suitable when referring to
an individual whose gender is known, or when their gender is otherwise relevant. In other cases, consider using
gender-neutral pronouns such as they and their.

Unknown words are also grouped together in the list of detections (right panel) in the corrector’s Language view.➞

The category does not flag abbreviations for forms of address such as Mr., Mrs. or Ms.➞
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THE REVISION PRISM
After the correction process has been completed, submit your text to the Revision prism to
inspect it from a number of different angles. The Revision prism offers a variety of filters that
address some particularly delicate features of your text. If the text is important, you should
consider examining each of these filters.

To carry out a complete revision of your text, simply navigate from filter to filter and from case to case, critically
assessing the highlighted elements and making corrections where necessary.

In the example shown below, the text is being viewed through the When (Pragmatics) filter. This allows you to identify
problems at a glance (for example, the temporal expression from 1880 to 1870 is somewhat dubious; in all likelihood,
you actually intended from 1870 to 1880).

Revision filters examine the text from three important linguistic perspectives: pragmatics, semantics and logic.

PRAGMATICS

Who

Important: The elements highlighted by the revision filters are not necessarily undesirable. Linguistically, many of the aspects that the filters
draw attention to may be perfectly correct. It is up to you to decide if they are appropriate or require modification.

➞
Each of the filters in the Revision prism is associated with an article in the guides. To access it, click on the orange link under the heading
Note in the left-hand panel.

➞

Note that the underlining in the corrector’s Language view remains visible here, although it is greyed out. The tooltips and their commands
also remain available.

➞
Some revision filters can display their results as percentages rather than as a number of occurrences. Click on the percentage button to
convert from one display to the other.

➞
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The Who filter displays the names of people or personalized entities in the text. This allows
you to identify at a glance all the actors in the text and assess how frequently they occur.

How many/much

The How many/much filter reveals all the numeric elements in the text, in both letters and
numbers (except for dates, which are handled by the When filter). This allows you to identify
at a glance all the sums and quantities in the text, and check that they are accurate.

When
The When filter reveals all the temporal elements of the text. This allows you to identify at a
glance all the dates and times, as well as the text’s chronological order, and to verify that
they are accurate.

Where
The Where filter reveals all the place names and the contact information included in the text
—address, email, phone number and other such information—as well as the adverbs of
place. This allows you to identify at a glance where the action of the text is situated, along
with the above-mentioned contact information, and to verify that these are accurate.

Protagonists
The personal pronouns I, you and we refer to the people writing and reading the text. This filter reveals all occurrences
of these pronouns so that you can verify their accuracy, frequency and distribution. The I may appear inappropriate in
some formal texts where we would be preferable. Moreover, the overuse of I or we can even betray a hint of
egocentrism. Additionally, it may be preferable to maintain a balance between us and you in a text that lays out a
mutual understanding.

Internal references
Use this filter to examine various classes of pronouns, possessive determiners and demonstratives that refer to other
elements within the text. Verify that the form of the pronoun or determiner corresponds to its antecedent, especially if
the latter’s number is not obvious: the government passed its bill (and not their bill).

An option allows you to exclude initialisms.➞

Options allow you to restrict the results of this filter to sums of money, percentages, and quantities that
are precise or approximate, for a more focused revision.

➞

Options allow you to restrict the results of this filter to dates, deixis (words whose meaning can only be
determined by reference to the extra-linguistic context) and other temporal expressions, for a more
focused revision.

➞

Options allow you to exclude contact information, proper nouns, deixis (words whose meaning can only
be determined by reference to the extra-linguistic context) and other spatial expressions, for a more
focused revision.

➞
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SEMANTICS

The semantic filters reveal opposing or complementary aspects of the text that are part of
its meaning and effect its feel and strength. The filters can be activated simultaneously in
order to compare, by means of contrasting colours, the distribution and the weight of
positive and negative elements within the text. If you need to reformulate, use the Synonyms
of “word” option in the context (right click) menu to find a synonym quickly and make an
instant substitution.

Weak
This filter highlights words and expressions whose meaning is imprecise or unclear; it identifies words that are
semantically weak or generic in scope. It may be a noun (thing, guy), an adverb (quite, roughly), a verb (seem, think), an
adjective (good, decent), a pronoun (somewhere) or another type of weak word. It’s up to you to decide, depending on
the nature of your text, whether to make your thoughts clearer by using terms whose meaning is more “rigorous” or
precise.

Strong
This filter flags words or expressions whose meaning is strong, or even emphatic or superlative. It may be a noun
(colossus, tragedy), a verb (fascinate, massacre), an adjective (superhuman, voracious), an adverb (hysterically,
viscerally) or another category. By opting for more moderate terms, you can, if you so desire, reduce the intensity of
your text and soften your words.

Negative
Some words reference things that are necessarily negative (aggression, ruin, violently, etc.),
or betray a negative opinion (abusive, reject, condemn, etc.). Using the Negative filter, you
can quickly assess the “negative orientation” of your text and reduce it, if so desired.

Positive
Some words have positive semantic content (love, benefit, honour, important, valiantly). They evoke things that are
pleasant (peace, joy) or things that are viewed positively (studious), most often on the basis of subjective criteria. The
Positive filter evaluates the distribution of these elements in your text to help you determine whether they correspond to
the message you want to convey and are suitable for the intended type of text. A text that is meant to be objective, for
example, should make moderate use of such terms.

LOGIC

Transitions

If the slider is set to minimum sensitivity, the filter will only show words that always have a weak, strong,
negative or positive meaning. As you increase the sensitivity, it will begin to include words that have one of these meanings in some
contexts only.

➞

You can restrict the filter to certain syntactic categories by checking the relevant boxes.➞

An option allows you to include “negated positives” (e.g. not appropriate) among the expressions flagged with negative meaning.➞
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The semantic content of a text is generally distributed over several sentences and
paragraphs. To connect the ideas in these sentences and paragraphs, various transition
words and expressions are used. The Transitions filter detects these transition points in the
text, from simple adverbs to long paraphrases. You shouldn’t use too many of these,
however, because they can weigh down the text, and it’s preferable to vary their usage.
Moreover, some transition words, called correlatives, display a particular logic: when firstly
is employed, for example, it should normally be followed by secondly, or an equivalent term.

Quoted text
The use of quotation marks to set off a word, a phrase or a citation in a text is very significant. The quotes mean that the
enclosed content should be considered as belonging to a different register, lexicon or author. The Quoted text filter will
help you check the order, density, distribution and accuracy of the quotations in your text. Too many quotes may
suggest that the text lacks drive, ceding its place to others too often. Too few quotes may be the mark of a text that is
too dry or insufficiently supported. An uneven distribution of quotes may indicate a text that is unbalanced.

Reporting clauses
Reporting clauses attribute a quote to its author (“It’s raining,” he said.), and describe its context. They serve to break
up the quotations in a text. The Reporting clauses filter allows you to rapidly assess the distribution of these clauses and
their logical progression. Avoid tired repetitions, i.e. the same reporting verbs that are employed too frequently, as well
as verbs that are overly expressive in these clauses.

THE STATISTICS PRISM
Several statistical filters can display their results as percentages rather than numbers of
occurrences; click on the percentage button to make the conversion.

COUNTS

Totals and lengths
These filters will give you the number of paragraphs, sentences, words and characters in
your text. They also indicate the average number of sentences per paragraph, words per
sentence and characters per word.

Reading time
These details have been expertly compiled and analyzed to give the average reading time of the entire text. This
information can be useful in a number of domains, such as education, advertising and subtitling.

Billing

A small speech bubble () inserted in the left margin allows you to rapidly locate the passages in quotes within your text.➞
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Some professional writers and translators calculate the fees they charge their clients based
on the number of data units (characters, words, phrases, etc.) in the texts they produce. The
Billing pad is designed to help with this. To rapidly calculate the amount to bill, enter the unit
cost, the currency and the textual unit being used for the calculation.

PERFORMANCE

Results
This filter provides information on the number of errors per hundred words and the number
of errors per sentence.

Antidometer
A gauge indicates your relative performance on a scale from Novice (rather poor
performance) to Druid (excellent performance).

ERROR TYPES

Error types separate language detections and group them into one of the following classes:
Spelling, Lexicon, Grammar, Syntax and Punctuation. Errors and alerts are presented in the
form of histograms that indicate the number of detections for each class. Click on the name
of a class or on the corresponding bar and a new histogram appears below it, providing a
finer set of detections. When you do so, the corresponding errors are highlighted in the
correction panel and they are the only ones displayed in the list of detections. Using these
classes, you could, for example, concentrate on spelling errors, or focus solely on the alerts
related to capitalization.

Error types from a detection
You can modify the entries displayed in the list of detections directly from a particular error
in the text. Select an error in the list of detections, then call up the context menu (right click).
The central section of the context menu indicates the category and subcategory of the error.
From a capitalization error, for example, you can display a list of all errors in the same
subcategory, so that you can verify and correct them all in a single step.

LANGUAGES

The Languages filter shows the proportions of your text that are in English, French and other
languages. Select one of the languages in the left-hand panel to display the corresponding
passages in the results.

With each correction made, the histogram bars gradually change from red to green.➞
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WORDS

The Words filter displays all the words of the text, ordered by frequency. A histogram shows
the ten most frequent words. A menu allows you to see only the words in a given category,
e.g. nouns or adjectives. Select a word in the list or in the histogram and all its occurrences
are highlighted in the text and displayed in the right-hand list of detections.

ETYMOLOGY

The Etymology filter shows the distribution of words in the text according to their origin. A
pie chart with three sections shows the relative proportion of words that derive from the
native stock of the English language, were borrowed from other languages, or were created
through native word formation. The list of source languages appears at the bottom of the
chart, presented in order of frequency, and initially displays the origin of all the words in the
text, according to the three sections of the pie chart. When you click on one of the sections of
the chart, the list changes to display just the origin of the words corresponding to that
source:

In all cases, clicking on a particular origin given in the list highlights all words of that origin in the text, e.g. all the words
derived from Germanic or Old French.

for words derived from the native lexical stock, the list includes those languages
from which English inherited words at its birth and which are represented by words
in the text;

for borrowed words, the list includes all foreign languages, ancient and modern,
from which English has borrowed over the centuries;

for derived words, the list includes second-tier languages, i.e. the original languages used to create new
English words found in the text, as well as those origins that are not languages as such, like proper names,
onomatopoeic forms and interjections.

For more information on the origin of English words, click on one of the sections of the pie chart, and then on the guides icon to display the
relevant article.

➞
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TENSES

The tenses filters show the number and distribution of the verb tenses used in your text. Click
on one of the sections of the pie chart to have all occurrences of that verb tense displayed in
the correction panel.

CATEGORIES

These filters show the number and distribution of syntactic categories in your text. Click on
one of the sections of the pie chart to have all occurrences of words that belong to that
category highlighted in the correction panel. By default, only the major syntactic categories
are displayed. To display all categories, click on Other categories…

THE INSPECTION PRISM

The one hundred or so filters of the Inspection prism dissect the basic elements of your text,
allowing you to examine it in depth.

Consider, for example, the distribution of participial modifiers (Syntactic function), e.g. The
candidate supported by the majority is elected. Are there too many of them, or not enough?
What is the distribution of verbs in terms of verbal mood (Conjugation)? Does the text
conform to British or American spelling conventions, or both, and if so in what proportion
(National Varieties)?

The inspection filters are primarily intended for educational purposes. Being able to see the category and syntactic
function of all the words displayed in a complete text, for example, can help people understand these grammatical
concepts.
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National varieties
These filters highlight the words that use American English, British English (traditional or Oxford spelling), or Canadian
English spelling.

Categories
These filters display all the words and expressions that belong to a particular word category (e.g. all proper nouns).

Phrases
These filters display the phrases that form the various syntactic constituents of the text (e.g. all noun phrases).

Syntactic functions
These filters display all the groups of words that function in a particular grammatical role (e.g. all subjects).

Conjugation
These filters display all verbs that are conjugated in a given mood or tense (e.g. all imperatives).

Search
Enter a word (or any sequence of characters) into the search box, and the Search filter will
show you all its occurrences in the text. If the Inflections box is checked, it will display all the
inflected forms of a word (open, opens, opened, opening, etc.).

FAVOURITES

At the end of the prisms panel, there is a Favourites section that lets you save your favourite filters for quicker access.
To add a filter to your favourites, click on the name of the filter in the prisms panel, using the right mouse button. In the
context menu that appears, select Add to favourites. This option is also available in the Edit menu, or you can simply
drag and drop the filter into Favourites.

There are options that let you restrict the search to whole words (rather than parts of words), or words
in the same case (e.g. uppercase); or you can search not only for the word itself, but include all its
inflected forms (singular, plural, comparative, superlative), as well as all its conjugated forms.

➞
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To remove an item from the Favourites list, display it and then, using a right click, choose Remove from favourites in the
context menu. This option is also available in the Edit menu, or you can simply drag and drop the filter into the trash.

NAVIGATING IN THE FILTERS

Navigating through the filters
To go from one filter panel to another, use the navigation arrows in the top bar of the prisms
panel or right-click to call up the context menu.

Navigating among the cases highlighted by a filter
To review all the cases flagged by the current filter, select the first result in the list on the right, then
navigate using the arrows on your keyboard. You can also use the navigation arrows in the toolbar,
or the equivalent arrows on the keyboard ( Ctrl  + K  or M  in Windows and Linux; Cmd  + K  or M

on a Mac).

MODIFYING THE TEXT
When a filter has detected a genuine error or an awkward construction you would like to correct, make your changes
directly in the correction panel or in the original document. Once you are done, the corrector immediately re-analyzes
the sentence and the filter display is modified to reflect the changes you made.

PRINTING THE RESULTS
For each of the corrector’s views, you can print the complete corrected version of your text, or the corrected version
from the point of view of one particular filter. Display the desired results on the screen, then select the Print… option
from the File menu.

DETAILED ANALYSIS

If you need inspiration, you can use the context (right click) menu to view the main synonyms of the word in question. Clicking on a
synonym will insert it straight into your text.

➞

If the highlighting is not clearly visible on paper, enable the Print highlighting in black and white setting in the Appearance settings panel.➞
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Antidote carries out a detailed analysis of each
sentence. If you wish to evaluate its diagnostics, or
simply to satisfy your linguistic curiosity, you can consult
the results of this analysis, which Antidote displays in
linear form.

To view the detailed analysis of the current sentence,
click on the button  in the corrector’s toolbar. Antidote
will display the detailed analysis in a separate window.

Each element of the sentence (word, expression,
punctuation, etc.) is followed by its category and an
indication of its syntactic function. It sometimes
happens that a given sentence will have more than one
analysis. When you view the detailed analysis, the
number of alternate analyses is displayed in the upper
left-hand corner of the window.

To navigate from one sentence to another, select the
sentences one by one in the correction panel, or click on
the last word of the current detailed analysis and use
the down arrow key on the keyboard.

Printing the detailed analysis
To print an analysis, select the Print… option from the File menu. If there are multiple analyses, Antidote asks you to
choose between printing the current analysis or printing all the analyses.

TEXT DISPLAYED IN GREY
On rare occasions, the corrector may display some sentences in grey. These are usually sentences that Antidote was
unable to analyze and therefore cannot provide any information. If this happens, try to modify the sentence to remove
the segment that Antidote finds problematic.

UNDERSTANDING HOW THE CORRECTOR WORKS
The corrector carries out an in-depth analysis of every sentence in your text. It first identifies each word along with its
syntactic category, number, tense, etc. It then determines all the relevant grammatical links between the words:
subject–verb, verb–object, etc. Once that is done, Antidote can then verify the appropriate agreement relationships
between the words and propose any necessary corrections.

The following are some of the features of your text that Antidote automatically verifies: the correctness of various
grammatical agreements (subject–verb, including agreement with coordinated subjects; articles and determiners with
count and mass nouns), verbal mood, the written form of numbers, the use of hyphens, false friends, homophones,
register, regionalisms, repetitions, capitalization, punctuation, etc.

It should be noted that Antidote’s grammar checking is based on the syntactic, grammatical and orthographic properties of your text, not

THE CORRECTOR  46



Discontinuities
Despite all of the tools at its disposal, the corrector may not be able to analyze every sentence it receives. It uses a
dotted line to indicate the area where its analysis ends. Any detections that fall within this area are less reliable, and
their tooltips display the warning Review, inviting you to pay special attention.

Unknown words
Antidote knows more words than most of us—its lexicon includes over 94,000 words—but English is a living entity! Like
us, the corrector can analyze a sentence even if it contains a word it does not know. However, it is rarely able to
propose a correction for that word. Share your knowledge with Antidote: add the unknown word to one of your
personal dictionaries. When Antidote later corrects you on that word, you’ll be glad you did.

THE IMPACT OF THE CORRECTOR ON THE STYLE VIEW
Antidote uses the results of the corrector’s analysis to determine as precisely as possible all the detections in the Style
view and the results in the various revision, statistical and inspection filters. This analysis is what allows it to distinguish,
for example, a number that is part of a date from a number denoting a quantity. It is also why it can process all the
sentences in your text at once and detect whole passages, not just individual words, and even flag certain pragmatic
elements.

The quality of the detections highlighted in the Style view therefore depends directly on the quality of the corrector’s
analysis: if the analysis is weak, so too will be the detections. For example, an unknown proper noun will sometimes be
classified as a place rather than a person, or a passive construction will not be properly interpreted.

For this reason, we strongly advise you to first tackle the corrections suggested in the Language view. Help Antidote
resolve its analysis issues (for example, by adding unknown proper nouns to your personal dictionary), before
proceeding to the verification of style and to the other prisms. The results will benefit from your efforts.

It should be noted that Antidote’s grammar checking is based on the syntactic, grammatical and orthographic properties of your text, not
on any deep semantic factors. Antidote does not really understand the deep meaning of a sentence and can’t necessarily turn a poorly
written text into a literary masterpiece.

➞

To make things easier, all unknown words are grouped together in the Language view’s list of detections. They can also be displayed using
the Rare words filter in the revision prism, under Vocabulary.

➞

THE DICTIONARIES  47



You can consult Antidote’s dictionaries at any time when you’re writing or editing a document. The Dictionaries window
opens automatically for the word selected and, as shown in the illustration below, tells you the number of results for
each of the dictionaries in the list. Antidote also suggests words with identical or similar spelling or phonetics, if any, as
you are entering the term.

The colour of the dictionaries is green. Their icon is a green book .

ACCESSING THE DICTIONARIES

From other software

 THE DICTIONARIES4
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Place your cursor on a word or click on it with your mouse, then call up
Antidote and choose whichever dictionary you want. The way you call up
Antidote’s dictionaries depends on which software you are using. From
Microsoft Word, for example, just click on the dictionaries icon in the Antidote
toolbar.

From other Antidote resources
From the Corrector or the Guides, you can call up Antidote’s dictionaries by
clicking on the Dictionary icon or pressing Cmd  + D  (Mac) or Ctrl  + D

(Windows and Linux). You can also select Resources in the Antidote menu
bar, then click on Dictionaries and choose the dictionary you want.

INSTANT SEARCH MENU
The instant search menu appears as soon as you start typing in the headword
field. Antidote tries to help you by guessing what you’re looking for as you type.
Click on one of the suggestions displayed to see the entry in the dictionary. You
can also press Enter or Return when the word you want is highlighted in the list.

There are three search modes, shown in blue at the top of the menu: Matches,
Contains and Anagrams. You can choose the mode you want by clicking on it.

MATCHES

This search mode displays a list of suggestions similar to the string entered.

Suggestions
This section displays words (maximum 10) that have a similar spelling to the string
entered in the headword field. A preview of the definition appears under each
word to help you choose

All results
This section of the menu performs a search for words that are similar to the chain in the headword field, either in terms
of their phonetics or their spelling. Results are shown in the search panel.

CONTAINS

This mode displays a list of suggestions (maximum 15) containing the string entered. Three buttons (abc—, —abc—, —
abc) let you display words that start with, contain or end with the string.

All results

To find out how to use Antidote with your favourite programs, see Using with your
other software, in the Help menu.

➞

Words identical to the headword are displayed in green, and words from a personal
dictionary appear in blue.

➞
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Click on All results to open the search criteria panel and display a more complete list of results. For more details, see
the section on Searching by Criteria.

ANAGRAMS

This mode displays a list of anagrams formed with the letters entered in the headword field. It may contain several
sections, with a maximum of 10 results for each one.

Complete
This section displays anagrams formed with all the letters entered.

Partial
This section displays anagrams formed with at least one letter fewer than the number of letters entered.

With added letters
This section displays anagrams formed with at least one more letter than the number of letters in the search string.

With substitutions
This section displays anagrams formed by replacing one of the letters in the search string.

All results
Click on All results to open the search criteria panel and display a more complete list of results. For more details, see
the section on searching by criteria.

HOMOGRAPHS BAR
When the headword has homographs (words with the same spelling), they are displayed in
the homographs bar above the header for all the dictionaries. Antidote automatically
chooses the most probable category according to its analysis of the context, if available; if
not, it chooses the most frequent word relevant to the current dictionary. Click on another
word in the homographs bar at any time to display an alternative entry.

DEFINITIONS DICTIONARY
This dictionary gives definitions of the 110,000 words in Antidote, as well as the 50,000 expressions, idioms, phrasal
verbs and proverbs formed from these words. The detailed definitions, backed up by examples, are even more useful in
that you can look up each word in a definition simply by double-clicking on it.
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DEFINITIONS

Main meanings
Each main meaning is preceded by a large green diamond (◆).

Sub-meanings
Each sub-meaning (nuance in meaning or use) is preceded by a smaller green bullet (●).

Examples
The many examples are displayed in shaded characters. They follow the definition they are intended to illustrate and
refine.

Labels
Labels, in small caps, indicate the context in which the meaning they precede is used. Domain labels, in black font,
indicate the sector of activity to which the meaning applies (e.g. ASTRONOMY, MEDICINE, MUSIC). Usage labels
indicate specific linguistic registers of the meaning (e.g. formality, regionalism, metaphor). Most of the usage marks
are shown in blue (e.g. INFORMAL, UK, EUPHEMISM). Others, in cases calling for close attention, are displayed in red to
attract your attention (e.g. TABOO, SLUR, VULGAR).

Semantic and syntactic divisions
When a single word has many different meanings, their definitions are sometimes divided into semantic groups, making
the entry easier to read and particular definitions easier to find. For example, the definitions for the verb have are
grouped into three sections: “Possess”, “Experience”, and “Do Something”. You can use the hide/show triangles to hide
any semantic groups that are not of interest.

Additionally, entries for cardinal numbers feature syntactic divisions, since they can occupy more than one syntactic
category. They are split into the following groups: Determiner or Adjective (e.g. seven years, the twelve people I saw)
and Pronoun or Noun (e.g. I’ll see you at eleven, six of my friends).

Map links
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About 16,000 place names (including World Heritage Sites, see below) have a definition followed by a  icon, linking you
directly with an online map (the map service is controlled by Antidote settings).

World Heritage links
Definitions of UNESCO World Heritage sites are followed by the  icon, which provides a direct link to the relevant
UNESCO website.

EXPRESSIONS AND IDIOMS

The dictionary of definitions lists expressions (a fixed sequence of words that communicates a thought), idioms (a
phrase whose meaning is usually unclear from the meaning of its constituent words), and phrasal verbs (a verb +
preposition unit with a specific meaning) that are formed with the headword, as well as proverbs (a short and popular
saying that generally states a truth or gives some form of advice). Shortcuts to each section (“Expressions”, “Idioms”,
“Phrasal verbs” and “Proverbs”) appear at the bottom of the definitions screen, when applicable.

Expressions
Expressions, idioms, phrasal verbs and proverbs are given separately, when they apply, displayed in green and
indicated by a green diamond to make them easier to find. Smaller diamonds introduce each definition, one for each
meaning. Domain or usage labels, in small caps, may precede a definition. Definitions, in black, are usually
accompanied by examples, shown in slightly paler text.

A hide/show triangle lets you shrink the list of expressions so that you can easily see and compare all the meanings.
Click on the triangle for the meanings you want, to expand only those you want to see. The Hide definitions option lets
you see just the lists of expressions, idioms, phrasal verbs and proverbs themselves, without the definitions, examples
and labels. Click on Show definitions to display all the associated information again.

Some expressions are followed by a � icon; clicking on it opens a pop-up with links to additional sources such as
Wikipedia.

Proverbs
The Proverbs section lists any applicable proverbs in green, preceded by a green diamond and followed by their
definition, which is introduced by a smaller diamond. Usage labels help you choose the appropriate proverb.
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DETAILS PANEL

This panel on the right-hand side of the window has three sections (Details, Difficulty and More), offering a variety of
complementary information on the headword. The main categories are explained below.

Etymology
Most words are accompanied by a note on their etymology. You can click on the language of
origin, in orange, to read the article on that language in the History guide. The example on
the right shows that the word passport is likely a borrowing from Middle French passeport,
meaning “document enabling its bearer to enter a port”. Click on the  symbol for the
complete history of the word.

Frequency index
A frequency index is shown for most words in the form of a point on a line going from 0 (rare) to 100 (frequent). This
logarithmically calculated number shows the relative frequency of the word in a corpus of several billion words. A
textual frequency rank (very frequent, fairly frequent, etc.) based on this index is shown under the line. Hovering the
mouse over the frequency line will also display a tooltip ranking the word in terms of numbers of words of equal or
higher frequency (e.g. Of the 500 most frequent words).

Inflected forms and phonetics
Inflected forms of the headword are shown: singular and plural forms for nouns,
comparative and superlative forms for adjectives and conjugated forms for verbs.
All forms are accompanied by their phonetic transcription, which can be displayed
in two alphabets: phonetic respelling or the International Phonetic Alphabet (IPA).
You can click on “Show respelling” and “Show IPA” to alternate between the two.
Click on a transcription for examples of each phoneme used. Click on the orange �
icon to the right of a transcription to see regional variants in pronunciation, when
applicable.

The phonetic transcription displayed reflects the user’s chosen variety of English,
shown in the User panel of Antidote’s Language settings. If the selected variety is
American English, for example, the transcription will reflect the American way of
pronouncing a given word. The transcriptions are enclosed in square brackets,
respecting the tradition in linguistics of enclosing narrow transcriptions in square
brackets.

Variants
When a word can be spelled in more than one way, the Variant section shows the
different spellings with their relative proportion as a percentage, calculated from a
corpus of several billion words, as well as the country of use. When a variant does not appear in the corpus, it is labelled
rare.

Difficulty
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Some words are subject to a particular set of usage conventions, which come
with their own potential difficulties. These can relate to their meanings,
inflections, syntactic or grammatical requirements, etc. The entries for such
words in the definitions dictionary include a section in the right-hand panel
entitled Difficulty, where specific usage information can be found. The example
opposite explains how the comparative and superlative forms of the adjective far
may vary according to the intended meaning of the word.

More
The More section provides complementary information on the headword.

Search using predefined criteria
Click on these links to search using established criteria, e.g. all definitions that contain the headword, or all words that
rhyme with the headword or are anagrams of it.

Other search options
This section also offers links to online sources such as Wikipedia, Google (or another search engine), the Grand
dictionnaire terminologique and Termium (you can add links to other resources; see the Settings chapter). Click on the
link to Wikipedia, for instance, and the article corresponding to the headword will appear directly in the Antidote
window. You can use the History button, search bar and Replace button as if Wikipedia were one of Antidote’s own
dictionaries. The Accessing Wikipedia section of this chapter gives a detailed description of how to use Wikipedia from
Antidote.

DICTIONARY OF SYNONYMS
Antidote’s dictionary of synonyms is a treasure trove, overflowing with 1.5 million synonyms, including expressions like
scarf down and dead to the world. It also lists more than 40,000 hyponyms (words more specific than the head word)
and hyperonyms (words less specific than the headword).
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Main meanings
Synonyms are grouped by meaning, with each group introduced by a triangle. When the headword has more than one
possible meaning, a short text label in green specifies the meaning in question.

Sub-meanings
Every sub-meaning (nuance of meaning or use) is indented under the main meaning and introduced by a bold green
bullet (●).

Hide/show triangle
Use the triangle to change the way the list of synonyms for each meaning is displayed. It lets you switch between a
detailed display, which is practical when you want to thoroughly research the meaning you are seeking, and a summary
display, useful for a quickly perusing the various meanings. A similar triangle, in the heading, lets you shrink or expand
all the lists at once.

Hyperonyms and hyponyms
Hyperonyms are synonyms with a broader meaning than the headword. For instance, enter the word car and you will
see ride, motor car, carriage, automobile, etc., but also the more general transportation, vehicle. Hyperonyms are given
under the MORE GENERAL heading, and are indented to the right of a vertical line. A hide/show triangle lets you
display or conceal them (the number of hidden hyperonyms is indicated).

Hyponyms are synonyms with a more specific meaning than the headword. For instance, hyponyms of car are cabriolet,
roadster, saloon, etc. which are specific types of car. Hyponyms are given under the MORE SPECIFIC heading and are
indented to the right of a vertical line. A hide/show triangle lets you display or conceal them (the number of hyponyms
hidden is indicated).

A small blue circle with a number indicates either that a hyponym has hyponyms of its own, or that a hyperonym has
hyperonyms of its own. Clicking on that circle will reveal these secondary hyponyms (shown with a right-pointing
arrow) or hyperonyms (shown with a left-pointing arrow) in a list. The same process can be repeated should any of the
newly revealed words have their own hyponyms or hyperonyms, letting you explore the semantic hierarchy and easily
find the specific term you are seeking, or expand your knowledge by exploring different semantic families.
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Labels
Labels, in small caps, indicate the context in which the synonym is used. Domain labels, in black font, indicate the sector
of activity to which the meaning applies (e.g. ASTRONOMY, MUSIC, MEDICINE). Usage labels indicate specific linguistic
registers of the meaning (e.g. formality, regionalism). Most usage labels are shown in blue (e.g. INFORMAL, UK,
EUPHEMISM). Others, in cases calling for close attention, are displayed in red (e.g. TABOO, SLUR, VULGAR).

Context
The context, in grey and parentheses, is intended to keep you from making a hasty choice, by indicating an important
nuance in the meaning of the synonym.

Slash
A slash is used to link hyponyms that are synonymous with each other.

Main morphological sections
Some entries are separated into large divisions when their specific forms have different meanings. The entry for
“depart”, for example, is divided into “depart” and “departed”.

Sorting the Synonyms
You can choose between four ways of sorting the synonyms: alphabetically, by relevance, by frequency or by length
(number of letters). Sorting options are accessible from the menu bar underneath the main synonyms panel.

Filters
The same menu bar also contains two filters that cause only certain synonyms, hyponyms and hyperonyms to be shown.

The first filter is based on the words’ semantic or expressive strength (strong, weak or neutral). By default it shows
everything.

The second filter allows only words without usage or domain labels to be shown. By default it shows everything.

DISPLAYING DEFINITIONS

The right-hand panel displays the definitions of the
synonym selected. With both the synonyms and their
definitions at hand, you can efficiently find the most
suitable synonym.

When you open the synonyms dictionary or after you
have conducted a search, the definitions that appear
are those corresponding to the headword. You can
then select each synonym in turn, using the mouse or
the arrow keys, to quickly display the definition of each synonym.
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DICTIONARY OF ANTONYMS
Antonyms are words whose meanings are more or less opposite from one another. Antidote’s antonyms dictionary, with
its more than 125,000 antonyms, can be an invaluable tool for finding the opposite meaning that fits best.

Antonyms are arranged in lists grouped according to sense, a brief description of which is shown to the left of the list.
For senses that are more specific, the overall sense is shown as a subheading and a secondary sense is shown to the
left of the list. The senses in the titles correspond to the various senses of the headword (and thus the opposite senses of
the displayed antonyms).

Clicking on an antonym will display its full definition in the right-hand panel. You can then cycle through definitions for
all of the antonyms in a list by using the keyboard arrows or by clicking on each word.

Each list includes a hide/show triangle, letting you switch between a detailed display and a summary display, useful for
when quickly perusing the various meanings. A similar triangle in the heading lets you collapse or expand all the lists at
once.

DICTIONARY OF COMBINATIONS
The dictionary of combinations gives all the most significant lexical combinations of the headword, grouped by
syntactic context, the strength of the combination and, if applicable, the various meanings of the headword. In its first
version, this dictionary includes 700,000 combinations, all accompanied by sentences exemplifying their use.
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Significant lexical combinations are made up of two or more words (the base and the co-occurrent words) with a
strong, frequent and spontaneous association in the language. How, for instance, can one describe a bright light? It
may be a flashing light, blinding light, clear light, brilliant light, and so on. The dictionary of combinations gives you an
exhaustive list of the statistically strongest associations, in all the relevant syntactic contexts.

List of combinations
The headword’s combinations are shown in a vertical list. In some cases, longer sub-combinations, such as set of traffic
lights in the above figure, are grouped under a combination they contain, in this case traffic lights. You can select a
specific combination and then use the Replace button to insert it in your text. When a particular determiner or
preposition is part of a combination (wait at traffic lights, bathe in blue light), it means that that function word is
significantly frequent in that particular context. You can scroll through the combinations using the vertical keyboard
arrows and show sub-combinations using the horizontal arrows.

Labels
If a combination belongs to an informal register, a usage label (e.g.: INFORMAL, OFFENSIVE) is shown to its right. If a
usage label applies to all combinations in a given sense, it is not repeated next to each combination; instead, it is shown
next to the heading that indicates the sense.

Strength of combinations
A blue bar opposite each combination shows its relative statistical strength: the longer the bar, the stronger the
combination in comparison with the other combinations in the same context. The strength depends on a combination’s
frequency, but also on the uniqueness of the association between the terms.

Syntactic contexts
Combinations are grouped by syntactic context: With adjective, With noun adjunct, With possessive and so on; the
number and nature of the contexts depend on the category of the headword. To allow an overall view of all the
contexts, only the first five combinations for each context are displayed. You can see the others by clicking on the
shaded and x others, if applicable. You can expand or shrink each context using its hide/show triangle. The number of
combinations for each context is shown in parentheses after the name of the context.

Meanings
When a word has several meanings, its combinations are grouped by
meaning. In this case, the meanings are displayed in green, accompanied by
a hide/show triangle.

Sorting
Combinations are sorted according to their strength by default. You can also
sort them in alphabetical order of the first word in each combination by
clicking on the title bar.

Hide/show triangle
The hide/show triangle lets you expand or shrink all the meanings or contexts at once, as applicable.

Examples and definitions
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Selecting a combination gives you access, in the right-hand panel, to examples of combination in real texts (with the
Examples button, at the bottom) or to the definition (with the Definitions button, at the bottom). In each example, the
words in the combination are highlighted. Each example is accompanied by the name of the author and title of the
source, if applicable, as well as a link to the source corpus, in blue. This hyperlink lets you open the website of the corpus
in your browser with one click.

Web search
At the bottom of the list of examples is the Web search link, which lets you search for the words in the combination in
Google, if you wish to search in more detail.

List of sources
At the bottom of the list of examples, the List of sources displays the source texts used in creating the list of
combinations and their examples.

Text filter
The text filter lets you display only the combinations containing the character string you enter in the filter field.

Thematic filters
Click on the Options… button to filter the list of combinations based on their value (positive or negative) or meaning
(strong or weak). By focusing the search, the filters help you choose the combinations that are most likely to meet your
criteria. Click on the X to close the thematic filters and return to the full list.

DICTIONARY OF SEMANTIC FIELDS
The dictionary of semantic fields lists all the words that are semantically related to the headword, grouped by meaning
and ranked by relative strength. It illustrates the semantic neighbourhood of the words and lets you navigate through
their conceptual web. All in all, 61,000 entries are connected by means of 2.7 million links.

List of words in the semantic field
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Words belonging to the semantic field of the headword are presented in a vertical list and grouped by category. The
nature of semantic links between these words varies: a semantic field may consist of combinations, words of the same
family, synonyms, hyponyms, meronyms, etc. You can select a specific word and then click on the Replace button to
insert it in your text. Use the vertical keyboard arrow keys to scroll through the list of words in the semantic field.

Strength of words in the semantic field
A blue bar opposite each word in the semantic field indicates its relative strength: the longer the bar, the more the word
is semantically related to the headword.

Main semantic sections
Entries for words with multiple meanings are usually divided into main semantic sections, with each meaning indicated
by a green text label.

Sorting
Click on the title bar to sort the words in the semantic field in alphabetical order or by strength.

Global hide/show triangle
The hide/show triangle lets you expand or shrink all the meanings or categories at once.

Definitions panel
The definition of a word selected in the list is displayed in the upper right-hand panel.

Text filter
The text filter lets you display only the words in the semantic field containing the character string you enter in the filter
field.

Thematic filters
Click on the Options… button to display or hide words based on their value (positive or negative) or meaning (strong or
weak). Click on the X to close the thematic filters.

THE INTERACTIVE SPHERE

To complement the list, the interactive sphere lets you visualize a semantic field in the form of a cloud of words whose
size reflects the strength of the link with the headword. Click on a word in the sphere to call up its own semantic field,
and you can embark on a semantic journey through the whole lexicon.

Expanding the sphere
Click on Expand [+] and the sphere will fill the central panel, and then on Minimize [-] to see it next to the list again. The
larger the sphere, the more words it contains. When the sphere is expanded, one or two new menus may be displayed
in a menu bar below the sphere. These allow you to modify the set of words displayed in the sphere.

Meanings menu
When the sphere is expanded, if the headword has several meanings, a label in the lower menu bar will show the
meaning currently displayed with arrows to its right. Click on the label to display a menu of all the meanings, and
choose the desired meaning.
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Category menu
By default, the sphere displays words of all categories. When the sphere is expanded, the lower menu bar will show a
menu initially labelled “All categories”. To restrict the sphere to a given category of words, choose a category from this
menu.

Visual history
Your journey through the semantic fields is recorded visually: when you click a word in the sphere, it is displayed in a
timeline below the sphere. You can click on a word in the timeline to go back to that field, and then return to where you
were.

CONJUGATION DICTIONARY
Antidote is one of the few English-language resources offering complete conjugation information for all of the verbs in
its dictionary. You will find a total of around 30,000 conjugated forms for over 8,500 verbs—all accessible with a simple
click of the mouse.

Conjugated forms
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Conjugation information is
presented intuitively in the
form of a table, with the
appropriate verb forms for all
relevant tenses and moods, as
well as the progressive aspect.
If an auxiliary verb is required,
this is shown with the verb
form in question. The form that
you search for is highlighted to
help you identify it.
Additionally, you can click on
any form to select it, then insert
it into your text by clicking
Replace.

Show all
By default, the conjugation
dictionary displays a
condensed table featuring only
the principal forms of a given
verb, along with any
auxiliaries. This view may well
provide all the information you
need, as English verbs take
identical forms for many
tenses and aspects. However,
you may also find it useful to
click on Display all in the top
right corner of the main panel,
revealing an exhaustive list of
conjugations by person, tense
and mood. If you wish to return
to the condensed table after
clicking Display all, simply click
Condense view, also in the top
right corner.

Progressive aspect
The
conjugation
dictionary
also provides
conjugation
information
for all tenses
and moods in
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the progressive aspect (formed with the auxiliary verb to be and the –ing ending). Progressive conjugations are located
in a separate section below the other conjugated forms, and can be expanded or collapsed by clicking on the small
triangle next to the section title.

Other conjugation resources
You can, of course, count on the corrector to spot errors of conjugation in your
text, and to find the appropriate form for you. Additionally, a basic summary of
inflected forms can be found in the Details panel in the definition for any verb.

DICTIONARY OF FAMILIES
The dictionary of families presents all the words in the headword’s morpho-
semantic family. A family consists of the words that have a common
morphological root and variations on a common meaning. The following example
shows the family of the word destroy.

Selecting a word from the list calls up its definition in the right-hand panel. You can move from one word to another in
order to see the definitions of all the words in a given family. Click on the column name in the title bar and you can sort
the family in alphabetical order or by syntactic category.

DICTIONARY OF QUOTATIONS
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The dictionary of quotations is a
compilation of 300,000
sentences from great authors
and leading publications to
illustrate the different uses of
words—such as the word heart
in the example.

The dictionary gives up to fifteen
quotations per word, starting
with literary ones, and followed
by examples from the media.
Each example is accompanied
by the name of the author and
title of the source, if applicable, as well as a link to the source corpus, in blue.

HISTORICAL DICTIONARY
The historical dictionary gives
the detailed etymology of
75,000 words, accompanied by
explanatory comments in many
cases. It also gives the
etymologically related words of
60,000 words.

Etymology
Antidote gives all the details on
the origin of the headword: how
it was created, its language of
origin and its spelling and
meaning in that language. If you
would like to learn more about
the language of origin, just click
on the orange link to see the corresponding article in the historical guide. Words whose unusual evolution merits more
explanation are accompanied by a detailed note.

Etymologically related words
Words that share the same origin are listed in this section, with an indication of their common etymon (the word or
morpheme from which a later word is derived) and the source language. They are grouped into separate subsections
when their more recent etymons are different. An arrow shows the words derived from an English word in the list, while
a bullet (•) indicates a word derived directly from the same etymon as the first word in the subsection.
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In the Etymologically related words section, clicking on an etymon displays its meaning; clicking on a language, in small
grey characters, takes you to the corresponding article in the historical guide; lastly, clicking on a word that is one of the
“etymological siblings”, i.e. the words derived from the same etymon, displays the definition of the word in a popover
window.

In some cases a word may have more than one etymology. Pike, for instance, is derived from popular Latin and Old
English words. In these cases, the historical dictionary numbers the different etymologies (1., 2., 3., etc.) and may show
more than one family of etymologically related words.

ACCESSING WIKIPEDIA

After consulting a definition, you may wish to find out even more about
it, and even to consult an encyclopedia. In the More section of the
Details panel for a noun or proper noun, and in the More section of the
tooltip for many expressions and idioms (click on the � icon to open the
tooltip), a link to the Wikipedia online encyclopedia will be shown. Note
that the Wikipedia box of the External resources interface settings must
be checked for this option to apply.

Click on this link in the More section and Antidote will display the results
from Wikipedia for the headword or expression/idiom directly in the
dictionary window. You can use the History button, search bar and
Replace button as if Wikipedia were one of Antidote’s own dictionaries.
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Wikipedia is an encyclopedia written entirely by Internet-based contributors, and its quality is out of Druide’s control. An active Internet

connection is required to be able to consult Wikipedia articles.

Clicking on a link in a Wikipedia article
Wikipedia articles include many links (in blue). Some are internal, meaning that they point to other Wikipedia articles.
Clicking on an internal link will display the corresponding article directly in Antidote. Others are external, indicated by
an arrow. Clicking on an external link will display the corresponding page in your browser.

Viewing a Wikipedia image
Wikipedia articles often have interesting images or graphics, in reduced size. Click on them and Antidote will maximize
them. You can copy these images and use them in your documents, but first check the user rights for each image by
clicking on the Licensing message in “More details” just below the image.

Returning to a previous article
Your Wikipedia access history is recorded in the same way as for every Antidote dictionary, so you can easily go back to
an article you have already consulted. This will take a bit longer than for other Antidote dictionaries, given the Internet
communication required. The Wikipedia element will be added to the bottom of the list of dictionaries and will remain
displayed there so long as you do not change the headword. You can go and consult the definition or synonyms in
Antidote, for instance, and then return to the Wikipedia article by selecting it in the list.

Consulting Wikipedia for information on a word not recognized by Antidote
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Wikipedia recognizes many terms that Antidote does not. To see a Wikipedia article on a given word, enter it as the
headword, then click on the Wikipedia link that appears in the usual place.

Opening a Wikipedia article in your browser
At the end of a Wikipedia article, Antidote adds a “Show original web site” link. Click on this link to display the article in
your browser. You can also right-click on the Wikipedia link, in the Antidote Definitions section, to open the Wikipedia
results directly in your browser.

Settings for Wikipedia access
In some situations, you may wish to restrict or even prevent access to Wikipedia. You can adjust your Antidote settings
to remove the link to Wikipedia entirely, or to get Antidote to try to filter any offensive Wikipedia content. For more
information, see External Resources and Access Control in the Interface section of the Settings chapter.

MULTI-WORD SEARCH
You can enter several words in the headword field. If the words you enter form an expression found in the dictionaries
(live birth, for example), Antidote displays it like any other term. Otherwise, it will search all its dictionaries for each
significant word. The results will be displayed in a panel where all the information in blue is clickable, taking you directly
to the entries and dictionaries where the expression was found. The results can be narrowed down using the sorting
and filtering options in the left-hand column.

Instant search may try to replace the word you are trying to enter with another one. If so, your word will still appear at the end of the
suggestions in the Instant search menu, and you can select it.

➞
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If no result joining the search terms is found, the results will nevertheless give you access to the entry for each part of
the search term. A link to additional sources, like Wikipedia, will be provided in the left-hand panel, if you wish to
expand your search (as allowed by the External resources panel in the interface settings). In all cases, you can add the
search string to a personal dictionary by using the link in the lower left-hand corner of the results panel.

SEARCHING WITH VARIABLES
In some situations, you may wish to search for a word even if you don’t know all the letters. Maybe you’re missing a
five-letter word starting with py to finish your crossword, or you’re writing an assignment on heat sources and are
looking for words containing the string thermo. Searching with variables is an excellent way to find the word or words
you’re seeking.

The search results are displayed in a panel in the form of a list of words accompanied by their syntactic categories and
a preview of their definitions. The options in the left-hand column let you sort and filter the results.
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N.B.: The results sometimes combine different forms of the same word (e.g. several conjugations of the same verb) on one line, for easier

reading.

*: unknown character or characters
Use the asterisk (*) to replace any letter or group of letters. For example, to see which words contain thermo, enter
*thermo*.

\?: an unknown character
Use the question mark (?) to replace any letter. Enter py??? to find the word missing from your crossword.

&: an unknown vowel
The ampersand (&) replaces a single letter, but it must be a vowel (a, e, i, o, u, y). So searching for poli& will give you
polio.

The asterisk replaces a string of arbitrary length, including the empty string.➞

The string py??? searches for words of exactly five letters starting with py.➞
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#: an unknown consonant
The hash (number sign) replaces a single letter, but it must be a consonant (b, c, d, f, g, h, j, k, l, m, n, p, q, r, s, t, v, w, x, z).
So searching for poli# will give you polis.

Sorting
You can sort the list of results by clicking on the options in the SORT block of the results window. For instance, if you click
on by category, the results will be shown in ascending alphabetical order, by category.

Category filters
You can limit the displayed results to a particular syntactic category (noun, adjective, etc.) using the options in the
CATEGORIES block.

Forms

Limiting searches with variables
In some cases, searching with variables can produce such a large number of results that it will slow Antidote down. For
that reason, the number of results that can be displayed is limited to 1,000. Antidote may also consider the search
request too vague, given the number of variables. In that case, the number of results will be limited to 500.

SEARCHING BY CRITERIA
Searching by criteria is a powerful tool that will let you explore and make the most of Antidote’s dictionaries. You can
combine a series of criteria and see the results displayed as you enter each criterion.

ACCESSING SEARCH BY CRITERIA

inflections: use this option to restrict the results to simple forms (infinitive, for verbs, singular for nouns). If you uncheck this box and search
for polic?, the form policies won’t be displayed because it is the plural form of policy.

➞
with spaces: uncheck this box to exclude words containing spaces and special characters like hyphens and apostrophes. For instance, if
you search for *operate, the word co-operate will not appear, since it contains a hyphen.

➞
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There are different ways to access this function.

Select one criterion from the Criteria menu. The search panel will
be displayed, launching a search using the specified criterion
applied to the headword; you can then modify this criterion as you
wish, or add other criteria.

Click on one of the predefined searches in the More section of the
dictionary of definitions. The search panel will be displayed, with
the results of the search specified; you can then narrow down these results or add other criteria as you wish.

In Contains or Anagrams mode of the instant search menu, click on the first command in the menu or the All
results option. The search panel will be displayed with the results of the search specified; you can then narrow
down these results or add other criteria as you wish.

DESCRIPTION OF CRITERIA

Word: Look for words that contain, begin with or end with a given character string (or do not). Look for anagrams of a
given string.

Category: Look for words that belong, or do not, to one of the syntactic categories suggested (noun, adjective, verb,
etc.).

Definition: Look for words whose definition includes, or does not include, a given word, inflected or not.

Domain: Look for words that belong, or do not belong, to one of the domains suggested (medicine, music, astronomy,
etc.).

Encyclopedic information: Look for names of people, countries, cities or World Heritage sites.

Number of letters: Look for words with a number of letters equal to, smaller than or larger than a given number.

Number of syllables: Look for words with a number of syllables equal to, smaller than or larger than a given number.

Frequency: Look for words whose frequency is the same as, lower than or higher than a given frequency (from very
rare to very frequent).

Rhyme: Look for words that rhyme with a given word.

National spelling: Look for words whose spelling is particular to a given country.

Register: Look for words that belong or do not belong to one of the levels of language suggested (informal, formal,
neutral, etc.).

Number: Look for words whose form is singular or plural.

Positive/Negative: Look for words that may or may not have a positive or negative connotation.

Language of origin: Look for words that come from one of the languages suggested (Italian, French, German, etc.).

USING CRITERIA

•

•

•
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Each criterion has different parameters that you have
to define or choose: enter a text string, choose from a
drop-down menu with two or several states (is or is
not) or values (fewer than, equals, greater than) or
from a list of defined options (different domains or
languages of origin).

For example, the Word criterion starts by offering you
a drop-down menu of eight parameters: is, contains,
begins with, ends with, anagrams of, does not contain,
does not begin with and does not end with.

After you choose the contains parameter, for
example, enter the desired character string in the
headword field. If you type the three letters bal, you
will see football, ball, global, balance, etc.

Use the ? criterion with Word to add one or more unknown characters to the string. You can also use the *, & and #
symbols as described in the Searching With Variables section.

ADDING CRITERIA
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Suppose you have
already searched for all
the words whose
definition contains the
word mouse (criterion
Definition contains
mouse), but you want to
limit the results to those
that contain the
computer-related term.
Click on the + Add
criteria button and
select the Domain
criterion.

This new criterion is
added beneath the previous one. From the domains in the drop-down menu, select computer/telecommunications.

LOGICAL CONNECTORS: ALL AND ONE OF

When your search contains more than one criterion, use these logical connectors to decide how they should combine.

All
All the results must meet all the criteria. This connector is represented by the conjunction AND between the criteria: 1st
criterion AND 2nd criterion AND 3rd criterion, etc.

One of
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The results must meet at least one of the criteria. This connector is represented by the conjunction OR between the
criteria: 1st criterion OR 2nd criterion OR 3rd criterion, etc.

Thus the combination Definition contains mouse AND Domain is computer/telecommunications in our previous
example will find all the words whose definition contains the word mouse (highlighted in yellow in the previews) and is
in the computer/telecommunications domain: drag, click, rollerball, etc. With the one of connector, on the other hand,
the combination Definition contains mouse OR Domain is computer/telecommunications will display all words whose
definition contains the word mouse (like rodent and Steinbeck) or that have to do with computers (like program and
install).

DELETING CRITERIA

To delete criteria from your search, click on the minus-sign button at the far right of the
criteria bar. The results will adjust automatically.

LIST OF RESULTS

The results are displayed as a list of headwords (in blue) followed by their categories (n., v., adj., etc.) and, if applicable,
other relevant information for the criteria used (phonetic transcription, number of letters, domain, etc.). Each headword
may be accompanied by a preview, which is generally the start of its definition but also changes with the criteria used.
The number of results obtained is shown at the top of the list.

If the list of results extends over several pages, click on the arrows and page numbers at the bottom of each page to
view the rest of the results.
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Definition tooltip
To consult the complete
definition of a result
without leaving the
search panel, click on
the � button that
appears when you
hover your mouse over
the word in blue.

Clicking directly on the
headword instead of on
the � button will take
you out of the search
panel, to the corresponding entry in the dictionary of definitions.

FILTERS

To the left of the list of results is a series of filters and options that let you refine your results and change the way they
are displayed. The filters displayed depend on the search criteria. They provide statistics on the subsets of the list and
let you limit the display to a given subset. Just click on a filter, or on All to return to the complete list of results. You can
combine several filters and the list of results will adjust automatically. Below is a description of the various filters.

Categories
Lets you limit displayed results to a given syntactic category.

Domains
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Accompanies the results of the Domain criterion when the domain chosen includes two subdomains (e.g.
computer/telecommunications). It lets you display results from only one of these subdomains.

Contexts
Accompanies certain results of the Definition criterion. It allows you to distinguish definitions in which the searched
word appears in a positive context (e.g. edible) from those in which it appears in a negative context (e.g. not edible).

Number of letters
Accompanies the results of the Number of letters criterion or the Word: anagrams of… criterion. It lets you display only
words containing a specific number of letters.

Anagrams
Accompanies the results of the Word: anagrams of… criterion. It lets you display only certain types of anagrams
(complete or with letters removed, added or substituted).

Frequency
Accompanies the results of the Frequency criterion and lets you display only a specified frequency interval.

Register
Accompanies the results of the Register criterion and lets you limit the words displayed to a single register of language.

Rhymes
Accompanies the results of the Rhyme criterion and classifies rhymes according to their richness (number of common
phonemes at the end of the word). It lets you display only words with a given number of common phonemes.

Number of syllables
Accompanies the results of the Number of syllables criterion or the Rhyme criterion. It lets you display only words with a
specific number of syllables.

Number
Accompanies the results of the Number criterion and lets you separate invariable words (with identical singular and
plural forms) from singular or plural words (depending on the value set for this criterion).

Language of origin
Accompanies the results of the Language of origin criterion and lets you display only words whose etymology is derived
partially from another language.

Country of origin
Accompanies the results of the Encyclopedic information: World Heritage criterion and lets you display only UNESCO
World Heritage sites located in a specific country.

Population
Accompanies the results of the Encyclopedic information: towns/cities or Encyclopedic information: countries criterion
and lets you display only places whose population is within a given range.
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Area
Accompanies the results of the Encyclopedic information: countries criterion and lets you display only countries whose
area is within a given interval.

Currency
Accompanies the results of the Encyclopedic information: countries criterion and lets you display only those countries
using a specific currency.

OTHER OPTIONS AND INFORMATION

Criteria
This indicator, above the filters, summarizes the criteria that were applied to obtain the results displayed. It lets you
check your criteria and is useful if you wish to print the results.

Sort
You can switch between different ways of sorting results: by relevance, alphabetically, by syntactic category or by
number of letters (for searches where this information is relevant). Relevance is generally linked to frequency, but
depends on the dominant criterion. For instance, when you use the Rhyme criterion, the relevance corresponds to the
richness of the rhyme.

Forms options
The options for Forms, displayed below the filters, are described in the Searching With Variables section.

Show IPA/respelling
This option accompanies the results of a search for rhymes or number of syllables and lets you switch between the
phonetic respelling of the word and the International Phonetic Alphabet (IPA).

Show/Hide preview
This option lets you display or hide the preview of the definition accompanying each result. Hiding previews has the
advantage of showing a more condensed list of results.

TIPS FOR SEARCHING BY CRITERIA

Here are some tips to help you search more efficiently.

Repeating the same criterion
You can repeat a given criterion while changing its values. For instance, searching Word contains x AND Word contains
y AND Word contains z will list the words that each contain the last three letters of the alphabet.

Negative criteria
Negative criteria—is not and does not contain—are particularly useful to limit results, for example, when you want to
exclude proper nouns, as described in the next paragraph.

Excluding proper nouns
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To exclude proper nouns from results, add the AND Category is not proper noun criterion. For instance, if you add this
criterion to the criterion Word contains port, proper nouns like Portugal and Portland will not appear in the results.

Exclude expressions/idioms
Results sometimes include expressions and idioms, which contain at least one space (e.g. come to think of it, triumphal
arch). Uncheck the with spaces box under Forms to exclude them from your results. Note that words with a hyphen or
internal apostrophe will also be excluded.

Search for anagrams
Anagrams are words formed with the same letters, but in a different order, like crass and scars. With the Word:
anagrams of… criterion and the Number of letters filter, you can limit the results to exact anagrams, with exactly the
same letters, or extend your search to words with fewer or more letters than the original word.

Have fun!
The only limit to combining the different search criteria is your imagination and curiosity. For example, is it true that not
a single English word rhymes with depth? How many English words in the political domain are of Greek origin? Now you
know how to find out!

Exiting search by criteria
To close the search by criteria panel and return to the previous dictionary consulted, click on the Done button in the
upper right-hand corner.

NAVIGATING THROUGH THE DICTIONARIES
You can submit a word to the dictionaries in a number of ways.

Enter a word
Once you are in the dictionaries window, enter a word (which will then be the headword) and press Return. Then
choose the dictionary you want—the previews may help you decide. As soon as you start entering the first letters of the
headword, a list of suggestions will appear. If the word you are looking for is one of the suggestions, choose it by
clicking on it. You can also just press Enter or Return when the word is highlighted in the list.

Double-click on a word
In the dictionaries window, double-click on any word to launch a search. To automatically launch a search in the
dictionary of definitions, press Ctrl  + double-click ( ⌥  + double-click, on a Mac).

Drag and drop
Select a word in any application that lets you drag and drop. Hold the mouse button down while you drag the word to
the dictionaries window and drop it in the headword field or directly in the dictionary of your choice.

Context
In the dictionaries window, right-click on a word (or Ctrl  + click on a Mac) to bring up the context menu. Then you can
launch a search on the word in the dictionary of definitions or the current dictionary.
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Toolbar
In the corrector window and the guides window, select a word and then click on the dictionaries icon. Then you can
choose the dictionary you want.

Previous search menu
Antidote keeps track of your past searches. If you want to search again for a word you have already entered, click on
the search menu (, on a Mac; in Windows/Linux, click in the headword field when it is empty) to display the list of
previous searches, and select the word you want to display in the headword field. This menu also lets you delete recent
searches and offers other search suggestions.

History arrows
Antidote remembers up to thirty words you searched for and dictionaries you visited. To return to the previous display,
click on the left-pointing arrow. To return to the display you just exited, click on the right-pointing arrow.

FAVOURITES
The Favourites menu, to the left of the headword field, lets you bookmark your favourite dictionary entries for fast
access. To add an entry to your favourites while you are consulting it, just click on the Favourites button (). You also
have this option in the Favourites menu (when you click on the small black triangle to the right of the heart), in the Edit
menu. Then you can access your favourite dictionary entries using the Favourites menu.

THE DICTIONARIES  79



To delete an entry from your list of favourites, go to its entry in the dictionary and then click on the Favourites button.
Alternatively, open the Favourites window by selecting Edit from the Favourites menu. Then, select Dictionaries from
the left-hand panel, select the entries to delete from the right-hand panel, click the three dots in the top right and then
choose the option Delete selection. Selecting Delete all will delete them all at once.

To export a list of favourites, open the Favourites window, select the list, click on the three dots and select
Export.

You can also manage your favourites by selecting Favourites from the Edit menu.

PERSONALIZED WORD LISTS
You can also create personalized word lists. To do this, select Add a list from the Favourites menu (the small black
triangle to the right of the heart). You will then be prompted to give your list a title.

If you want to add the current entry to a list that has already been created, simply click on the heart (the Favourites
button), then choose a list. You will then be able to access the list from the Favourites menu.

To remove an entry from the personalized list, go to that entry and then click on the Favourites button. Alternatively,
open the Favourites window by selecting Edit from the Favourites menu. Then go to your list, from which you will be
able to select and delete multiple words at once.
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To export a personalized word list, open the Favourites window, select the list, click on the three dots and select Export.

You can also manage your lists by selecting Favourites from the Edit menu.

DISCOVERING NEW WORDS
Do you enjoy flicking through your dictionaries and learning words you’ve never seen before?
Antidote offers an easy, quick way of exploring the treasures of English. Just click on the hat ()
in the toolbar and Antidote will pull out the definitions of a word at random from its huge stock.

TEXT SEARCH
You can search for a word in one of the main panels, for example the synonyms or definitions panels. Right-click in the
dictionaries window and choose Search… to bring up a small search bar at the bottom of the screen. You can also
press Command  + f  (Mac) or Ctrl  + f  (Windows and Linux). Occurrences of the string you enter in the search bar
will be highlighted in the main panel. Click on the arrows to move back and forth between them. Click on the Done
button to close the search bar. For the Combinations, Semantic field and Family dictionaries, the search bar is
displayed at all times. Entering a string narrows the results to only those that contain it.

REPLACING A WORD IN THE TEXT
Click on the Replace button, the ▾ that appears next to the selection or in the pop-up
menu to replace the selection in your text by what you have selected in the dictionary. If
the form of the word selected isn’t right for your text, click on the menu of proposed forms
to display a list of suggestions, and select the appropriate form. For instance, you can
replace a word in your text with a synonym, an expression or a word from the same
family.

EXTRACTING THE DICTIONARY CONTENTS
We have all had to quote the definition of a word at some time: “According to the dictionary, audacious means…” With
Antidote, rather than recopying the definition by hand, you can simply insert it in your text. And in future you’ll say
“According to Antidote, …” Just select the definition you want and drag and drop or copy and paste it into your text.

Click on the small black triangle next to the hat and you can limit the search to one of the categories
displayed. By default, Antidote draws a word from these categories at random.

➞

Note that you can replace words in this way only if you have called up the dictionaries from your text or the corrector.➞
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PRINTING THE DICTIONARY CONTENTS
You can print the contents of the main panel of all the dictionaries. To print the contents displayed by the current
dictionary, click on Print… in the File menu. Results of multi-word searches, searches with variables and searches by
criteria can also be printed.
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Antidote brings together close to 500 articles on the pleasures and pitfalls of English in ten guides: Spelling, Lexicon,
Grammar, Syntax, Punctuation, Style, Business Writing, Typography, Phonetics and History. With easy-to-remember
tips and tricks, carefully chosen examples and a wide range of topics, the guides will help you understand any mistakes
you make and, more importantly, avoid them in the future.

The colour of the guides is orange (). Their icon is an orange book and orange hyperlinks point to their articles.

ACCESSING THE GUIDES

FROM OTHER SOFTWARE

To see the articles in the guides, run Antidote and select the guide you want. The way you run the guides depends on
the software you are using. To find out how to use Antidote with your favourite programs, see Using with your other
software by clicking on Help in the Antidote menu bar.

CONTEXT-SENSITIVE ACCESS FROM THE CORRECTOR

 THE LANGUAGE GUIDES5
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Access to the guides from the corrector is context-sensitive, meaning that Antidote opens the specific article that
applies to the current detection. To consult it, select a detection and complete one the following actions:

Click on the orange book in the upper right-hand corner of the tool bar.

Click on the tooltip to expand it, then click on the “+” or on the orange book to the left of the explanation, if
there is one.
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A grey bullet is displayed in front of the explanation when the guides contain no information on the current detection. For spelling errors, the

dictionaries icon replaces the guides icon.

CONTEXT-SENSITIVE ACCESS FROM THE REVISION FILTERS

Each filter in the revision prism is associated with an article so that you can evaluate the
possible edits to your text. Click on the title of the article to read it.

CONTEXT-SENSITIVE ACCESS FROM THE DICTIONARIES

Definitions dictionary

The Details panel in the definitions dictionary often includes orange
hyperlinks. Click on one of these links to open the guides to an article
that relates to the headword. Clicking on a usage label (e.g. informal)
in the body of the definition opens an article on this label.

Conjugation dictionary
Clicking on the green headings for moods and tenses will open the
corresponding article, explaining the use of that mood or tense.

Historical dictionary
The etymology section of the historical dictionary displays the source language(s) of the headword in orange. Click on
the orange hyperlink to go directly to the article on these languages and their contribution to English.

NAVIGATING THE GUIDES
There are four different ways of getting around in the guides: the table of contents, smart search, hyperlinks and the
history arrows.

TABLE OF CONTENTS

Open the context menu (right click) and select the orange book.
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The table of contents is displayed in the left-hand panel of the
guides window, and broken down into two levels: guides and
articles. In the list of guides, each guide indicates the number
of articles it contains, as well as a brief list of some of the topics
addressed. Select a guide to see its contents – topics,
subtopics and articles – in the right-hand panel, and then
select the article you want to read.

SMART SEARCH

Use the search field to quickly find all the articles on a given topic. Just enter
a word and the results will be displayed in the search field as you type. Each
result shows the title of the article containing the search term, the guide
containing the article, and a short passage showing the search term in
context. The results become refined as you enter more of the search term.

The results are ranked by relevance. The title of the article is displayed in red
when it contains the search term.

To read an article, select the corresponding result. All the occurrences of the search term are highlighted in the
article,so you can spot them easily.

To repeat a recent search, click on the magnifying glass in the search field and select one from the list of previous
searches that appears. You can delete this list if you wish (Clear list option).

LINKS

The guides often give hyperlinks in orange or red,
allowing you to quickly consult related articles. The
cursor turns into a small pointing hand when you hover
over a hyperlink. Just click on it to display the article. A
link followed by the  symbol means that it will direct you
to an external source displayed in your browser. An
active Internet connection is required to access these
external links.
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HISTORY ARROWS

To quickly return to the article you have just read in one of Antidote’s guides or the results of your previous search, just
click on the left arrow. To go back to the article or search that you just left, click on the right arrow. To display your
history in the form of a menu, click on these arrows while holding down the mouse button.

FAVOURITES
The favourites menu, indicated by a heart in the icons bar, shows you a list of your
favourite articles for faster access.

ADDING AN ARTICLE TO YOUR FAVOURITES

To add an article to your favourites, open it in the guides window and do one of
the following:

Any of these actions will cause the heart to turn blue (Mac) or become darker (Windows and Linux) indicating that the
article has been added.

Each article is then saved in the favourites menu. Click on the arrow to the right of the heart to display the list, and
select the article you want to read again.

REMOVING AN ARTICLE FROM YOUR FAVOURITES

To remove an article from your list of favourites, start by opening the article in question. You can then proceed to
eliminate it from the list by following the procedure for adding articles that is described above. In the context menu, the
Add to favourites option becomes Remove from favourites.

Another method is to click on the arrow to the right of the heart and select Edit favourites… In the window that opens,
choose the article(s) you want to remove, then click on Delete. Once you have finished editing the list, click on Done. In
all cases, the heart will turn grey again to indicate that the article has been removed.

PERSONALIZED ARTICLE LISTS

You can also create personalized article lists. To do this, select Add a list from the favourites menu (the small black
triangle to the right of the heart). You will then be prompted to give your list a title.

Click on the heart.

Click on the triangle to the right of the heart and select Add to favourites.

Place the cursor in the article, open the context menu (right click) and select Add to favourites.

Select the article in the table of contents, open the context menu (right click) and select Add to favourites.

You can also manage your favourites from the Edit menu.➞
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If you want to add the current article to a list that has already been created simply click on the heart (the favourites
button), then choose a list. You will then be able to access the list from the favourites menu.

To remove an article from the personalized list, go to that article and then click on the favourites button. Alternatively,
open the Favourites window by selecting Edit from the favourites menu. Then go to your list, from which you will be
able to select and delete multiple articles at once.

To export a personalized article list, open the Favourites window, select the list, click on the three dots and select
Export.

You can also manage your lists by selecting Favourites from the Edit menu.

PRINTING ARTICLES
You can print the contents of any of the guides. To print the current article, select Print… in the File menu.
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Hit the Send button too soon? Now you’ll never have to say “Oops!” again! With Antidote’s Anti-Oops technology, you
can make sure your emails are always carefully checked and that attachments have not been forgotten.

THE CORRECTOR IS READY

Anti-Oops! links your email program to Antidote. When you click on Send, it springs into action and makes sure you
haven’t forgotten to have Antidote check your message. If necessary, it automatically calls on the corrector. Once your
message has been checked, you can just click on Send again.

If you change the text of your message after it has been corrected, and then click on Send again, Anti-Oops! will
suggest that you check your message again (see the illustration on this page). You can agree to do this or simply send
the message. There is also an option to cancel sending.

CHECKING ATTACHMENTS

 ANTI-OOPS!6

Anti-Oops! works with most commonly used email programs, except for Web applications.➞

To enable or disable the automatic verification of your emails, see the Anti-Oops! panel section in the Settings chapter.➞
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When you click on Send, Anti-Oops! checks that you haven’t forgotten to include an attachment. If there is no file
attached, Anti-Oops! has Antidote analyze your message. If it finds that an attachment is mentioned, Anti-Oops! alerts
you by opening a window directly in your email program. You can then stop sending the message and attach the
missing file, or go ahead and send it without the attachment.

Anti-Oops! will show you the part of your message that suggests that you may have forgotten an attachment. In the
example on this page, the clue is “I am attaching a file”.

If the phrase that triggers an alert is a sentence automatically added by your email program, or you don’t think it needs to be corrected,
you can tell Antidote to ignore it in the future.

➞
To enable or disable the verification of attachments or to tell Antidote to ignore certain text, see the Anti-Oops! panel section in the
Settings chapter.

➞
If you don’t want Anti-Oops! to check a message, hold down the Shift key when you click on Send in your email program.➞
Remember: Anti-Oops! applies to messages written in English. The optional French-language module lets you also check messages written
in French, but for those written in another language, you’re on your own!

➞
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WHY ADJUST THE SETTINGS?
The settings serve to adjust Antidote’s actions when it corrects a text, as well as to customize many aspects of its
interface. A good assessment of your needs as a user, combined with the proper settings that accurately reflect them,
will ensure an optimal and user-friendly experience when you write and correct your texts.

Antidote’s settings are divided into four main groups: Interface, Corrector, Language and Typography. Upon
installation, the settings in each panel are adjusted to the value recommended by Druide. For typography, for example,
these are the values that comply with the standards in use in your language variety. These values can be modified at
any time, either individually or all at once using the presets.

ACCESSING THE SETTINGS

From the corrector
A Setting… note is included in the tooltip for any detections that are associated with
a particular setting. Clicking it will open the relevant panel. The settings are also
accessible via the Adjust settings… option in the context (right-click) menu or the
Settings icon in the corrector’s icon bar.

In Antidote for Mac, select Antidote 10 from the menu bar and then go to Preferences…, or select Settings… from the
Corrector menu. In Windows or in Linux, select Tools and then Options…

 SETTINGS7

To access the settings, you must be in Antidote, not your writing software.➞
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ADJUSTING THE SETTINGS
In the figure shown opposite, the setting for the
correction of dashes has been enabled. Hovering
the cursor over each setting and over each of its
values (if any) brings up a tooltip explaining your
options.

Recommended values
Click on the Recommended values button at the
bottom of the window in order to apply the
default values. Note that the recommended value
for certain settings may vary according to the
ability level for written English chosen in the User
panel. For example, if you have told Antidote that
your first language is French and that your
mastery of written English is not very good, the
false friends setting will be enabled by clicking on
Recommended values.

PRESETS
The presets allow you to quickly switch from one configuration to another. In a single operation,
they modify dozens of settings across a number of panels. Antidote offers separate presets for its
Language and Typography views. This allows you to choose the perfect combination of settings
according to what you’re writing.

If you normally write emails where an informal tone is appropriate, you might choose a less
restrictive combination of settings, e.g. Informal usage in the Language view and Basic
typography. When you have an important letter to write and want stricter settings, you would
likely select Formal usage or Flag all in the Language view, along with Formal typography. Once the correction process
is complete, the presets menu will allow you to easily return to your regular settings. Any active presets are indicated
with a check mark in the menu.

In the Settings window, you can access the presets by opening the Presets menu. This gives you the choice of the
following presets:

RECOMMENDED VALUES:

LANGUAGE PRESETS:

If the recommended values button is greyed,
those values are already set in the current panel.

➞

Spelling and grammar errors are always flagged, regardless of the language preset selected.➞

Antidote adjusts all settings panels to the recommended values.

Flag all: Antidote adjusts all settings linked to alerts to their maximum level in all relevant panels.
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TYPOGRAPHIC PRESETS:

INTERFACE SETTINGS
This section discusses some interface-related elements in Antidote’s various resources.

GENERAL PANEL

STARTUP

Display language
Select the language in which you want Antidote to display text in its
interface: English or French. You may also choose to base this option
on your operating system language.

At launch, open:
You can specify which window will open by default when you launch
Antidote independently, without going through your writing software.
For example, if you often look up words in the dictionary, you will
probably find it useful to automatically open this window each time
you launch Antidote.

(MAC ONLY) ANTIDOTE MENU

Include the Antidote menu in the menu bar

Flag all: Antidote adjusts all settings linked to alerts to their maximum level in all relevant panels.

Formal usage: Antidote adjusts each language setting in all relevant panels for thorough correction
of word usage, syntax, punctuation, capitalization and possible lexical confusion.

Informal usage: Antidote adjusts each language setting in all relevant panels for less rigorous
correction, disabling all settings linked to alerts.

Formal typography: Antidote will adjust each typographic setting in all relevant panels for
exhaustive correction based on the standards observed in your language variety.

Basic typography: Antidote will disable most of the settings related to typography in all relevant
panels, verifying only obvious typographical errors (e.g. two spaces between words).
The presets are also accessible from the corrector. You will find them above the list of detections in
the right-hand panel. See the chapter on the corrector for more details.

By default, the interface appears in the language of the operating system.➞

By default, the dictionaries window opens when Antidote is launched.➞

This setting has moved to Connectix Agent, located in the system menu bar.
This is the fastest way to access all of Antidote’s resources. Check this option
to display a small flask icon in the system menu bar, allowing you to open an Antidote menu.

➞
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Corrector

Close other Antidote windows when the corrector is launched / (Windows) Minimize other windows when the corrector
is launched
Checking this option forces Antidote’s other windows (dictionaries or guides) to close when you launch the corrector,
which gives you a better view of your original text.

Allow simultaneous correction of multiple documents
This option allows you to correct several documents at the same time. This can be useful to compare two texts, or to
preserve the results of a long text while correcting something else.

Show tooltips
Each of the corrector’s detections includes a tooltip showing a brief contextual explanation, as well as any possible
alternatives and relevant actions. You can choose whether to have the corrector show these tooltips upon selection of a
detection, or after an adjustable delay.

You have four options:

DICTIONARIES

Produce alert sounds for unknown words
Antidote normally emits a warning beep to alert you when the searched word is unknown or incorrect.

Close Dictionaries window after a replacement
When you replace a word in your text by clicking the replace button in the dictionaries, the dictionaries window closes
and you automatically return to your text. To keep the window open after replacing a word, disable this option.

ADVANCED

History: Delete browsing history…
Click this button to delete all browsing history in Antidote’s dictionaries and guides.

This setting is enabled by default.➞

This setting is enabled by default.➞

This setting is enabled by default.➞

Upon selection: The tooltip only appears once a detection is selected.

Immediately: The tooltip appears as soon as the cursor hovers over a detection.

After a short delay: The tooltip takes a short time to display when the cursor hovers over a detection.

After a long delay: The tooltip takes a longer time to display when the cursor hovers over a detection.
By default, tooltips appear upon selection of a detection.➞

This setting is enabled by default.➞

This setting is enabled by default.➞
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Warnings: Restore all hidden messages…
Click this button to restore all the warnings that were hidden using the option No longer show this message.

APPEARANCE PANEL

MARKS IN THE CORRECTOR

Highlighting colour
In the Style view, as well as the Revision, Statistics and
Inspection filters, highlighting helps you quickly locate the
results that you were looking for or that the corrector has
found. Antidote can highlight these elements in the colour
of your choice; simply click on the corresponding box.

Secondary highlighting colour
When the same detection occurs several times in a text, the
corrector groups them together. If you click on one of these
detections, the other identical cases will all appear in a
distinct colour. If you chose to correct identical cases in one go, they will all be modified. You can select the colour of
this secondary highlighting by clicking on the corresponding box.

Print highlighting in black and white
When printing, highlighting appears in colour on a colour printer or in grey on a black and white printer. Select this
option to force the highlighting to print in the shade of grey that provides the highest contrast.

Underlining of corrected errors
When you apply a correction, the underlining changes from red to green to indicate that the error has been corrected.
Antidote can display this underlining in blue, which is helpful for those who are colour-blind. If the underlining is set to
blue, corrected characters will also appear in blue in the list of detections.

TEXT SIZE AND FONT

You can change the font of the text used in the corrector (i.e. the text in the main panel), the dictionaries (the main
content in the running text), the guides (the text of the articles) and the documents created in Antidote’s internal text
editor.

ACCESS CONTROL PANEL

The highlighting in most filters appears in pale yellow by
default.

➞

The secondary highlighting appears in golden yellow by default.➞

This setting is disabled by default.➞

Underlining of corrected errors is green by default.➞

To quickly change the font size, use the zoom buttons in the toolbar.➞
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INAPPROPRIATE CONTENT

Filter from the dictionaries
Some words belong to an offensive register (e.g. the noun moron), or may have a
secondary sexual meaning (e.g. knockers in the sense of “breasts”). This setting
allows you to hide some words or definitions that may be unsuitable for certain
users. Note that content drawn from outside sources, such as the quotations, may
still contain sensitive subject matter.

Filter From Wikipedia
Wikipedia is an online encyclopedia whose content is written entirely by Internet users. The quality of its content is out of
Druide’s control. If you wish, Antidote can try to filter any adult content from Wikipedia.

EXTERNAL RESOURCES PANEL

EXTERNAL RESOURCES

The External resources settings panel corresponds
to the More section in the right-hand panel of the
definitions dictionary. This section contains options
for further exploring the word in question, and can
include direct links to online resources. To choose
which of these resources are displayed, click the
padlock icon to enable changes and enter your
administrator credentials.

Wikipedia
Wikipedia, the well-known online encyclopedia,
adds an encyclopedic dimension to the linguistic
richness of Antidote’s dictionaries.

Maps
Locate the cities and administrative regions known
to Antidote either on Google Maps (all platforms)
or Apple Maps (OS X). Simply click on the small  icon at the end of the definition for the place you are looking up.

Grand dictionnaire terminologique (GDT)
The GDT is the term bank of the Office québécois de la langue française. Consult the GDT to learn the correct term for
a host of specialized concepts in French as well as their English equivalents.

Termium Plus

These settings are not enabled by default. To change them, first click on the padlock icon and then provide an administrator’s account
settings.

➞

An active Internet connection is required to access
these external resources.

➞
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This is the terminological and linguistic data bank of the Translation Bureau of Canada. Nearly four million records are
available to help you with your translation and writing needs or simply for the pleasure of enhancing your knowledge.

Search engine
Look up a highlighted word in your favourite search engine: Google, Yahoo!, Bing or DuckDuckGo.

Others
Enter the URL for any other resources of your choice. Use the “+” button to add a URL and the “-” button to delete one.
In the string of the URL, use the %s sign to indicate where Antidote should insert the word to look up.

SYNC PANEL
Sync your favourites, your lists and your personal dictionaries to share them across all your devices and related
applications. Anything you add or remove subsequently will automatically apply to all applications and synced devices.

Note: synchronization is an optional service provided by Druide informatique. See more details in the Synchronization
chapter.

Sync favourites
Check this box to sync words, searches and guide articles that you have stored in your favourites, as well as your
meticulously compiled lists of words and articles

Sync personal dictionaries
You've been patiently and meticulously building up your personal dictionaries over time. Check this box to share the
fruits of your labour across all linked applications. You can also choose individual personal dictionaries to share (see
the Personal Dictionaries chapter).

Automatically add new dictionaries to the cloud
Depending on the context and purpose of a new personal dictionary, certain confidentiality restrictions may apply. Use
this option to determine whether your newly added personal dictionaries should be automatically synced.

CORRECTOR SETTINGS

The settings discussed in this section relate to the general mechanisms of the corrector’s analysis. See Interface Settings
for specific matters concerning the corrector’s interface, and Language Settings for those related to the author, alerts

You can see your favourites and your lists in the  menu, accessible from the icon bar in the dictionaries and the guides.➞
The first time you launch Antidote, you will be asked whether you want to sync your favourites. This setting is determined by your response.➞

The first time you launch Antidote, you will be asked whether you want to sync your personal dictionaries. This setting is determined by
your response.

➞

The first time you launch Antidote, you will be asked whether you want to sync your personal dictionaries automatically. This setting is
determined by your response.

➞
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and other correction options.

GENERAL PANEL

SPLITTING

Treat a carriage return as the end of a sentence
The corrector does not always consider a carriage return as the end
of a sentence. Occasionally, a carriage return may be used simply to
indicate a new line. If, for a given text, the corrector does a poor job
of segmenting your sentences, you can check this setting so that it
systematically splits the sentences at all carriage returns.

Show spaces between paragraphs
The corrector does not always consider that a carriage return marks
the end of a paragraph. If, for a given text, the corrector does a poor
job of segmenting your paragraphs, you can check this setting so that
it systematically segments the paragraphs at all carriage returns and
adds a blank line between them. Note that this setting does not affect
the grammatical analysis, only how text is displayed in the corrector
window.

LANGUAGES

Flag passages in another language in the margin
Antidote can help you quickly spot and bypass passages of text written in a language
other than English. It inserts a blue marker in the left margin of text that is not in
English: this marker is labelled fr for French, while other languages are represented
by a question mark. Above the text, Antidote displays the percentage of the text that
is written in English and the percentage in French. Clicking in the blue area in the
margin highlights the corresponding passage in the text.

DIALOGUES AND QUOTES

Flag dialogues and quotes in the margin
Antidote can insert a small speech bubble in the margin to the left of the text where
a dialogue or quote occurs. The pale green marker in the margin indicates the
extent of the quotation or dialogue; clicking in this area highlights the corresponding
passage in the text. Because dialogues and quotes are generally subject to slightly
different correction rules, visual marking of these passages will help you track the detections flagged within them more
quickly and efficiently. If you have chosen to disable some types of detection inside dialogues and quotes, they will not
be flagged in these areas of the text.

This setting is disabled by default.➞

This setting is disabled by default.➞

This setting is enabled by default.➞

This setting is enabled by default.
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Disable certain detections in dialogues and quotes
Dialogues and quotes often possess a particular style that you may wish to leave intact. You can instruct the corrector
not to flag certain stylistic errors in these passages. If necessary, specify whether these errors are to be ignored in the
Language or Style views.

CORRECTION MODE

Correct or ignore identical detections all at once
When correcting a text, Antidote may flag a number of identical detections, resulting in the same detection being
repeated in several places throughout your text. You can instruct Antidote to automatically correct (or ignore) all
identical detections, or to correct (or ignore) only the selected one.

Correct language and typography simultaneously
Checking this option causes the corrector to display all the language and typographical errors together, allowing you to
correct them at the same time. Otherwise, when the corrector opens, it first displays only language detections.

Correct by replacing entire words
If this box is checked, the correction of an error will replace the entire word in your document, rather than just the
characters that need to be modified. This can make it easier for programs that offer a “track changes” feature to spot
the changes in your text. However, some formatting features (e.g. superscripts) may be lost.

CORRECTION DATA

Remember the status of previous corrections between sessions
This setting allows the corrector to automatically recall which detections have been previously ignored in a given text. If
you close Antidote and later reopen the same document, the corrector will recognize the text and will not redisplay
those detections that you previously chose to ignore. This allows you to resume checking the text exactly where you left
off.

Clear correction data
Click on this button to delete all automatically saved data on the state of previous corrections.

EXCLUSIONS PANEL

This setting is enabled by default.

➞

This setting is disabled by default.➞
Spelling and grammar errors are always flagged in dialogues and quotes.➞

This setting is enabled by default.➞

This setting is disabled by default.➞

This setting is disabled by default.➞

This setting is enabled by default.➞
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TAGS

Ignore text between the following tags:
It may be useful to exclude certain passages from the corrector’s analysis. You may want to do this, for example, in the
case of a mathematical formula, or for some “hidden” text in certain writing software. By enclosing a passage within
the tags of your choice, you can force the corrector to ignore it.

[v2 and higher] Exclude the following character sequences:
You can tell Antidote to exclude certain character sequences from correction. This can be useful if you use certain
sequences to tag or structure your text. The “+” and “-” buttons allow you to add or delete character sequences.

DISABLED ALERTS PANEL
Using the Disable command shown in tooltips or the toolbar, you can hide alerts associated with a given word. This
causes Antidote to add the word in question to the column on the left of the Disabled alerts panel in the settings. The
words listed in this column can be viewed or modified at any time.

WORDS

This setting is disabled by default.➞

This setting is not enabled by default. For other settings relating to email-specific exclusions, see the next section on the Anti-Oops! Panel.➞
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Select a word from the list to display its
associated alert in the right-hand column. If you
click on the “-” button at the bottom of the list,
Antidote will remove that word from the list and
begin displaying the associated alert again.

Discreetly underline words with disabled alerts
If this option is checked, the corrector displays a
thin dotted line under the words for which an
alert has been disabled. This line serves as a
reminder. It might be useful should you want to
view the list or reactivate a disabled alert.

ANTI-OOPS! PANEL
The List of compatible software… button links to a page on our website containing a list of email software compatible
with our Anti-Oops! technology.

ANTI-OOPS! FUNCTIONS

Check if any attachments seem to have been
forgotten
Antidote alerts you when you are about to send off
an email mentioning an attachment that appears to
be missing.

Correct the text of emails before sending
The corrector will systematically analyze every
email before it is sent, automatically opening
Antidote if it finds an error.

EXCLUSIONS

Ignore text from the original message in replies to
emails
By checking this option, you instruct Antidote not to
correct a correspondent’s original text when it is included within your email, and not to check for that correspondent’s
attachments. Given that this is not your text, there is no need to correct it or to search for its attachments.

The right-hand column may display multiple
alerts for the same word. If the word has mutliple
alerts, none will appear in the corrector when the
word appears in the Disabled alerts list.

➞

This setting is disabled by default.➞

This setting is enabled by default.➞

This setting is enabled by default.➞
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Text to be ignored
You can instruct Anti-Oops! to ignore certain recurrent portions of text in your emails, e.g. your signature, or a string
that is automatically generated by your email software. This text will not be corrected or verified for missing
attachments. The “+” and “-” buttons allow you to add or remove new expressions.

Do not correct for these recipients
The emails that you send to certain recipients might not need to be corrected to perfection. If so, check this option, click
the “+” button, and then add the recipients to exclude from correction. You can add a complete address or part of an
address that applies to multiple receipients. As needed, use the “-” button to manage the list.

LANGUAGE SETTINGS
In addition to problems of spelling, agreement, syntax, punctuation, etc., Antidote can tackle an impressive range of
other problems, including homophones, near-homophones, and regional or informal usages, to name but a few.
Whenever there is the possibility of confusion regarding a word, e.g. bear and bare, Antidote will flag it. If the context
allows the corrector to determine that the word is being used correctly, it moves on; otherwise, it displays an alert.
However, this does not necessarily mean that it is a mistake; it is up to you to make that decision, checking the
dictionaries and guides as needed.

In this case and in many others, Antidote does its best to help you avoid mistakes, but you will probably need to adapt
its efforts to your specific needs. This is the purpose of the language settings.

GENERAL PANEL

FLAG

This setting is enabled by default.➞

Anti-Oops! verifies the complete text of the email by default.➞

Anti-Oops! is launched for all recipients by default.➞

Antidote classifies errors of language, typography and style into separate groups to provide a more uniform correction experience. The
settings in this section concern the detections in the Language view and most of the vocabulary detections of the Style view.

➞
Spelling and grammar errors are always flagged, regardless of how the language settings are adjusted.➞
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Discontinuities
Occasionally, Antidote isn’t able to identify the role of every word in
a sentence, often because of missing or superfluous words. When
this setting is enabled, the corrector places a dotted line under the
affected area. This allows you to check the sentence carefully,
especially around the dotted line, so that you can correct any
potential omissions or errors.

Unknown alphanumeric sequences
An alphanumeric sequence is an unbroken series of letters,
numerals and other non-separating symbols (e.g. LOG-6). If you
use any such sequences regularly, it may be useful to add them to a personal dictionary so that the corrector can
analyze them. Antidote invites you to do this by displaying an unknown word alert when this setting is enabled.

The pronoun who when it is used in place of whom
When this setting is enabled, the corrector favours the pronoun whom (The people whom I hate) over who (The people
who I hate) when it refers to the object rather than the subject. This usage may be recommended or even obligatory in
some styles, while others consider it formal.

Numerals in numbers under 10
When this setting is enabled, the corrector flags any numbers lower than 10 that are written in numerals (7) rather than
words (seven). Typically, these numbers should be written as words provided that the sentence does not contain any
other numbers in numeral form.

Prepositions at the end of a sentence
Sentences that end with a preposition (e.g. Which stand did you go to?) are common and widely accepted, although
some writers avoid them in very formal contexts. When this setting is enabled, the corrector flags them with an alert.

OPTIONS

Possessive form of singular proper nouns ending in -s
According to the selected option, Antidote will correct the possessive form of singular proper nouns that end in the
letter s. You can instruct it to favour the ’s ending (e.g. Charles’s mother), the apostrophe ending (e.g. Charles’ mother),
or either form.

Plurals of initialisms containing periods
According to the selected option, Antidote will correct the plural form of initialisms that contain periods (e.g. M.D.). You
can instruct it to favour the ’s ending (e.g. M.D.’s), the s ending (e.g. M.D.s), or either form.

This setting is enabled by default.➞

This setting is disabled by default.➞

This setting is enabled by default.➞

This setting is enabled by default.➞

This setting is disabled by default.➞

The ’s form is selected by default.➞
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Replace contractions with long forms
When this setting is enabled, the corrector locates the contractions in a text (e.g won’t), and suggests replacing them
with the corresponding long form (e.g. will not). Contractions are considered informal by some style guides.

USER PANEL

First language
Antidote needs to know your first language so that it can fine-tune its
correction. For example, if your first language is French, Antidote will look for
certain constructions that a French speaker is more likely to produce (e.g. *I
have 34 years for I’m 34 years old, *I suggest you to read it for I suggest you
read it, etc.).

Written English ability
Knowledge of the rules of English grammar varies from one person to another.
Depending on the level indicated, Antidote will generate more or fewer
detections, and will attempt (or not attempt) to recognize certain error-prone
constructions. Here you have the choice of three levels:

National variety
The English that is spoken around the world varies from one region to another, as do its conventions. For example, in
British English verbs like realise and organise are not spelled the same way as in American English, which favours the –
ize ending. This setting tells Antidote which variety to use in its dictionaries and corrections. Here you have a choice of
several national varieties of English.

Correct spelling according to the selected variety
When this box is checked, Antidote will correct words whose spellings vary by country, in accordance with the National
variety setting.

The ’s form is selected by default.➞

This setting is disabled by default.➞

When Antidote is first launched, a dialogue window asks you what your first language
is. The value of this setting is adjusted according to your response.

➞

Minimum level (written skills are fairly weak): The corrector flags the standard set of errors, but includes
certain additional errors typical of someone who is learning English.

Intermediate level (written skills are fairly good): The corrector flags the standard set of errors.

Maximum level (written skills are very good): The corrector flags the standard set of errors, but does not
indicate certain errors that an advanced speaker of English is unlikely to make.

When Antidote is first launched, you are asked to estimate your ability in written English. This setting is adjusted according to
your answer.

➞

When Antidote is first launched, you are asked to indicate your national variety. This setting is adjusted according to your answer.➞
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REGIONAL WORDS OR SENSES

All speakers of English employ words and expressions whose use may sometimes be restricted to their region or
country, even if they are not always aware of it. To reduce the risk of misunderstanding between English speakers from
different regions, Antidote can flag a large number of such country-specific words.

For each region you can choose three setting levels:

WORD USAGE PANEL
Antidote handles words that belong to a particular register, or words that may be inappropriate or offensive, from two
different perspectives. Depending on the nature of the text and your familiarity with your readers, inappropriate
language may constitute a genuine error or, alternatively, it may be a deliberate stylistic choice. For this reason,
detections concerning language are displayed both in the Language view for possible correction, and in the Style
(Vocabulary) view for simple verification. The following settings therefore affect both views.

REGISTER

A word that appears innocuous to us may actually belong to a particular
register (formal, old-fashioned, informal or slang). Antidote can detect this
and help you avoid unintentionally using inappropriate language.

Here, for each register, you have the choice of three settings:

Minimum level: The corrector flags no regionalisms.

Intermediate level: The corrector flags a word that is restricted to certain regions in all its senses (e.g.
cashpoint in the sense of an ATM is always a Britishism); the corrector does nothing if only one sense is
restricted to the given region (e.g. fries is used in Canada and the United States to designate what other
English-speaking countries call chips, but fries can also mean young fish).

Maximum level: The corrector flags all potential regionalisms.
When Antidote is first launched, you are asked to indicate your national variety. The setting corresponding to this variety is
adjusted to the intermediate level. Thus, if you live in the United States, the Regional words or senses setting for the US will be
adjusted to the intermediate level, while other regional settings will be reduced to their minimum level. To disable all these
alerts without having to modify each setting individually, uncheck the general box in the top left corner of this area.

➞

The regionalisms flagged in the Style (Vocabulary) view depend on these settings.➞

These word usage settings are adjusted by default to the intermediate level (except for the Formal and Old-fashioned registers, which are
adjusted to the minimum level). To disable all alerts resulting from these settings without having to set each individually to the minimum
level, uncheck each general box in this area (in the top left corner).

➞

Minimum level: The corrector does not flag any words or expressions
at this register.

Intermediate level: The corrector informs you if the word or
expression belongs to this register in all of its senses (belly is always
informal) and remains silent if only one sense of the term belongs to
the register in question (the noun smoke is informal only in the sense
of cigarette).

Maximum level: The corrector flags all words and expressions which may belong to this register.
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OFFENSIVE TERMS

When this box is checked, Antidote will flag four classes of offensive terms: words that constitute a slur or are socially
taboo (e.g. yid); informal words that are offensive (e.g. jackass); words that are vulgar (e.g. shit); and words that are
not polite (e.g. matey).

Here, for each category of offensive terms, you have a choice of three settings:

WORD CHOICE PANEL

French-English false friends
False friends are words in different languages that look or sound similar, but differ
significantly in meaning. They become “false” when they are used in the sense of their
counterparts from another language. A French–English false friend is an English word
whose meaning is confused with that of a French word of similar form. For example, the
word French word réunion (meaning “meeting”) and the English word reunion are similar
in form but different in meaning. So an expression like *my 9:15 reunion illustrates this sort
of linguistic confusion.

Here you have a choice between three settings:

Redundancies
A redundant expression is one that is repetitive in terms of meaning (e.g. young puppy, unexpected luck, remake again).
Depending on the nature of the text, this may constitute a genuine error, or, on the contrary, it may be the result of a
deliberate stylistic choice. For this reason, redundancies are flagged in the Language view for possible correction and
in the Style (Vocabulary) view for simple verification. This setting affects both views.

Here you have a choice between three settings:

Minimum level: The corrector does not flag this type of offensive term.

Intermediate level: The corrector informs you if the expression is offensive in all of its meanings (e.g. yid is
always offensive to designate a Jewish person) but does nothing if only one of the senses is offensive (e.g. pig is
offensive to designate a policeman, but not an animal).

Maximum level: The corrector flags all expressions that may be offensive.

Minimum level: The corrector does not flag any false friends.

Intermediate level: The corrector flags the most common false friends (e.g. sensible used in place of sensitive),
but not those for which the incorrect English meaning is relatively rare (e.g. character when used for
characteristic).

Maximum level: The corrector flags all potential false friends.
False friends are adjusted to the intermediate setting by default if your location is Quebec; otherwise they are set at minimum.➞

Minimum level: The corrector does not flag any redundancies.

Intermediate level: The corrector flags those redundancies that are universally criticized (e.g. added bonus),
but not those that are less serious (e.g. blend together).

SETTINGS  106



CAPITAL LETTERS PANEL

FLAG

Unknown capitalized words
If the corrector encounters a word it does not recognize that begins with a
capital letter, it assumes it is a proper noun. This allows it to continue its
analysis. If you wish, Antidote can alert you when it encounters an unknown
word that it assumes to be a proper noun. We strongly encourage you to
enable this setting. This way, you will be warned that the corrector does not
know the word, and you can add it to your personal dictionary, particularly if
it’s a name that you use often.

Only the first occurrence
If this setting is enabled, the corrector will alert you only on the first occurrence of an unknown word that begins with a
capital. The alert will be disabled upon subsequent occurrences of the word. However, the alert will be re-enabled if
you exit the corrector and relaunch it. This setting can be useful if, in a given text, you use a proper noun several times
but don’t want to add it to your personal dictionary.

Words whose meanings change with capitalization
Some words have different meanings depending on whether they begin with a capital letter. For example, advent refers
to the time leading up to any event, while Advent refers to a particular period in the Christian calendar. If this setting is
enabled, the corrector will flag such words.

Capitalization errors in titles
In English, every word in a title should normally begin with a capital letter except articles, coordinating conjunctions
and short prepositions. If this box is checked, Antidote will detect and correct all such errors in titles.

Unusual capitalization
If this box is checked, Antidote will flag words that include a capital letter for no apparent reason (e.g. *I Want to go.).

COLON

Maximum level: The corrector flags all redundancies, regardless of how serious they are.
Redundancies are adjusted to the intermediate level by default. To disable all such alerts, uncheck the Redundancies box.➞

This setting is enabled by default.➞

This setting is disabled by default.➞

This setting is disabled by default.➞

This setting is enabled by default.➞

This setting is enabled by default.➞
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Depending on the conventions followed, independent clauses that come after a colon (“:”) can start with either a capital
or a lowercase letter. Using this setting, you can instruct the corrector to require either lowercase or capital letters after
a colon, or to accept either.

PUNCTUATION PANEL

COMMA

Commas surrounding common parenthetical
expressions
Check this box if you want Antidote to flag
missing commas around common parenthetical
expressions, e.g. of course.

Commas before the conjunction linking two main
clauses
Check this box if you want Antidote to flag
instances of a missing comma before the
conjunction separating two independent clauses,
except when these clauses are very short.

Comma before the coordinating conjunction in lists of three or more terms
Here you have the choice of telling Antidote to always or never allow the serial comma (the comma preceding the
coordinating conjunction in lists of three or more items). You may also tell it to accept both. Depending on your setting,
the correction would accept either Apples, oranges, and pears or Apples, oranges and pears.

Allow omitted comma in Hello Paul!
When a speaker addresses someone using their name, a comma is usually required between this statement and the
name of the person being addressed (e.g. Wait for me, Paul!). This convention also applies in the salutation of a letter
(e.g. Hello, Paul), although it is often not observed.

Comma after etc. and et al.
Check this box if you want Antidote to insert a comma after these abbreviations when they do not coincide with the end
of a sentence.

Comma after i.e. and e.g.

This setting accepts either case by default.➞

This setting is enabled by default.➞

This setting is disabled by default.➞

This setting accepts both forms by default.➞

This setting is enabled by default.➞

This setting is disabled by default.➞
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This setting allows you to choose whether to require (always) or to reject (never) commas following the abbreviations
i.e. and e.g. You can also choose to accept either format (accept both).

PERIOD

Allow declarative questions
Declarative questions end with a question mark but are formulated in the same way as affirmative sentences; they
contain neither an interrogative pronoun nor a subject-auxiliary inversion (e.g. You left already?). Check this box if you
want the corrector to allow them.

Add a period at the end of a paragraph
A period is required to end a sentence properly. However, it is sometimes omitted, especially at the end of the
paragraph, when no other sentence follows. If this setting is enabled, Antidote adds a period at the end of a paragraph,
unless the context otherwise justifies its absence (in a title, for example).

Periods after given-name initials
This setting allows you to choose whether to require (always) or to reject (never) periods after the initial of a person’s
given name. You can also choose to accept either format (accept both).

QUOTATION MARKS AND PUNCTUATION

Correct the position of the period or comma relative to the closing quotation mark
If this setting is enabled, Antidote will correct the position of a period or a comma relative to a closing quotation mark, in
accordance with the setting you select: either before the closing quotation mark or after it.

TYPOGRAPHY SETTINGS
Not all aspects of typography are subject to hard-and-fast rules. Typographic conventions are generally accepted
principles surrounding how the different elements in written English should be displayed. In practice, these conventions
vary between countries and house styles, and the settings described in the sections that follow should be adjusted
accordingly.

GENERAL PANEL

By default, this setting corresponds to national variety of English you have selected: North American conventions generally require the
comma, while British conventions do not.

➞

This setting is disabled by default.➞

This setting is enabled by default.➞

This setting requires a period by default.➞

This setting is enabled by default.➞

The typography settings apply to the corrector’s Typography view.➞
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APOSTROPHES

Replace straight apostrophes with typographic
apostrophes
Formal typography requires the curved
apostrophe ( ’ ) and not the straight apostrophe ( '
). Uncheck this setting if you want Antidote not to
detect and correct straight apostrophes.

QUOTATION MARKS

Replace straight quotation marks with
typographic quotation marks
Check this box if you want to replace straight
quotation marks ( " " ) with typographic quotation
marks ( “ ” ), in accordance with general
typographic conventions.

Correct the type of quotation marks
If you check this box, Antidote will correct the type of quotation marks used at different levels of quotation. You can
select double quotation marks for the highest level, and then single marks for an embedded quotation; or single
quotation marks for the higher level and then double marks for the embedded quotation.

DASHES

Check this box if you want Antidote to detect various
contexts in which a dash or a hyphen is incorrectly used
and then replace it with the correct dash. Antidote can
detect the following contexts: in front of each item in a list,
to set off a parenthetical expression, to separate two
clauses, in a range, and to attribute a quote. For each of
these contexts, you can select the type of dash (em dash
or en dash), as well as the type of space to be inserted
around the dash (breaking, non-breaking, thin or none). If
you select any for this option, Antidote will not make any changes in this context.

ELLIPSIS

Correct the type of ellipses used
Check this box if you want Antidote to correct the type of characters used to represent ellipses. You can then select the
single character, three periods, three periods with non-breaking spaces, or three periods with thin spaces.

This setting is enabled by default.➞

This setting is enabled by default.➞

This setting is enabled by default.➞

This setting is enabled by default.➞

This setting is enabled by default.➞
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PARENTHESES

Correct nested parentheses
Check this box if you want Antidote to correct the type of nested parentheses, i.e. parentheses that occur within higher-
level parentheses. Your options for nested parentheses are square brackets or dashes.

SPACES PANEL

SYMBOLS

When this box is checked, Antidote will correct spacing errors in the following contexts:
before the percent symbol (%), after currency symbols ($, £, etc.), before ISO currency
codes (CAD, EUR, etc.), before units of measure (m, ft, etc.), before the degrees Celsius
symbol (°C), and after numerals representing dimensions or coordinates (51° 28’ 38").
The availability of options (breaking/non-breaking/thin space, no space, any) varies
according to the context.

DATES

When this box is checked, Antidote will correct spacing errors in the following contexts:
between the month and the numeral representing the day (e.g. March 10), between the
month and the year (e.g. March 1983), and between the year and the era
abbreviations BC, BCE, AD and CE (e.g. 250 BCE). In each context the following options
are available: breaking/non-breaking/thin space, no space, any.

LAST NAMES

When this box is checked, Antidote will correct spacing errors in the following contexts:
between a person’s title and their name (e.g. Mrs. Smith), between a person’s first and
last names (e.g. Robert Smith), between the first-name initial and the last name (e.g. J. Smith), between first and middle
name initials (e.g. J.R. Smith), and between different parts of a last name (e.g. Van Gough). The availability of options
(breaking/non-breaking/thin space, no space, any) varies according to the context.

OTHERS

When this box is checked, Antidote will correct spacing errors in the following contexts: before ellipses, between double
and single quotation marks that appear in succession (e.g. “’yes’ was her only answer”), between the numeral and
words such as million and billion, between a numeral and any noun (e.g. 3 mice), and in alphanumeric expressions such
as page 432, file G-12 and Queen Elizabeth II. The availability of options (breaking/non-breaking/thin space, no space,
any) varies according to the context.

This setting is enabled by default.➞

This setting is enabled by default, but the settings for the various contexts are not all the same.➞

This setting is enabled by default.➞

This setting is enabled by default, but the settings for the various contexts are not all the same.➞

This setting is enabled by default, but the settings for the various contexts are not all the same.➞
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SPACING BETWEEN SENTENCES

This setting allows you to adjust how many spaces should appear after a punctuation mark indicating the end of a
sentence (“.”, “…”, “!”, “?”). You can choose between one, two or any.

MULTIPLE SPACES

Flag unnecessary spaces between words
When this box is checked, Antidote will flag the presence of multiple spaces between words.

THIN SPACE

The thin space is generally represented by the Unicode character U+2009. However, some programs prefer U+202F
(narrow no-break space). Antidote allows you to choose between the two.

CONVENTIONS PANEL

TIMES

Correct the format of times
When this box is checked, Antidote will correct the format of
times in accordance with the type of spacing you select
(breaking, non-breaking, thin, or any of these) and the type of
separator between hours and minutes you select (colon or
period). You also have the option of telling Antidote to allow
times to be written in the 24-hour format.

NUMBERS

Correct separators used for groups of three digits
When this box is checked, Antidote will correct the separators
used between groups of three digits. You can also instruct
Antidote to verify that thousands are separated in four-digit
numbers (using the separator of your choice) and that numbers
after the decimal are divided into groups of three.

Correct separators used for decimals
When this box is checked, Antidote will correct the type of separator used for decimals and allow you to choose
between a period and a comma.

One space is selected by default.➞

This setting is enabled by default➞

By default, the thin space is represented by Unicode character U+2009.➞

This setting is enabled by default.➞

This setting is enabled by default with the comma as the preferred
separator.

➞

This setting is enabled by default with the period as the preferred separator.
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Type of space
If you use a space as a separator within numbers, you can choose which type of space the corrector requires: thin,
breaking, non-breaking or any.

SYMBOLS

Use the symbols ′ and ″ in coordinates and dimensions (3′ 6″)
When this box is checked, Antidote will detect any coordinates or dimensions that are written using apostrophes or
quotation marks (e.g. 3'6"). It will correct these symbols for single and double prime symbols (e.g. 3′ 6″), in accordance
with typographic conventions.

Replace the letter X with the multiplication symbol (8½ × 11)
When this box is checked, Antidote will correct the letter X when it is used to express multiplcation, replacing it with the
recommended multiplication symbol (×).

ADDRESSES

Correct address formats
When this box is checked, Antidote will correct certain errors in the format of addresses. You can tell it to Accept,
Require or Reject double spaces before the postal code and whether or to Accept, Require or Reject a comma between
the street and the municipality. If so instructed, the corrector will also verify the separator between the unit and
building numbers; here you can choose an en dash, a comma, or any separator.

TELEPHONE NUMBERS

Require a non-breaking space
When this box is checked, the corrector will replace regular spaces with non-breaking spaces between the different
sections of a telephone number.

DECADES

Allow abbreviated decades
When this box is checked, the corrector will allow the use of abbreviations for decades (e.g. ’90s for 1990s). You can
then choose from the drop-down menu below whether the corrector should Require, Accept or Reject the presence of
appostrophes before these abbreviations.

This setting is enabled by default with the period as the preferred separator.➞

This setting is enabled by default.➞

This setting is enabled by default.➞

This setting is enabled by default.➞

This setting is enabled by default.➞
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WHY PERSONALIZE YOUR DICTIONARY?
Although Antidote already has over 100,000 words in its dictionaries, there are still plenty that it doesn’t know.

It may be the name of your company, a technical term specific to your profession, or just an expression you like. If you
frequently use a word Antidote doesn’t recognize, you can save yourself time and effort by adding it to a personal
dictionary so that the corrector can recognize and correct it if necessary. The words added to personal dictionaries will
also show up in the search results in the Antidote Dictionaries window. You can edit or delete the words you have
added to a personal dictionary at any time.

You can create several personal dictionaries with different vocabulary lists (botanical, mechanical, etc.) or combine
dictionaries from a number of sources.

ACCESSING THE PERSONAL DICTIONARIES

From the corrector
When the Antidote corrector encounters a word it doesn’t recognize, you can use the  button in the toolbar to quickly
add it to your personal dictionaries. In the example on the previous page, Antidote doesn’t recognize the word
Gourmaison. Click on the  button to open the Personal Dictionaries window. If you have several personal dictionaries,
Antidote will ask you to specify where you want to add the word.

From the dictionaries
In the example below, a company name (Bovary Fur) has been typed in Dictionaries search field. Since it can’t find the
expression in any of its dictionaries, Antidote displays a hyperlink asking whether you want to add it to one of your
personal dictionaries. Click on the hyperlink to open the Personal Dictionaries window with the expression added.

A similar hyperlink is displayed in the main panel of the Dictionaries window when you enter a word that is already in a
personal dictionary. This time, the blue text asks whether you want to edit the word. Click on the hyperlink if necessary
to change the word category, add to or correct its definition, review its characteristics, etc.

 PERSONAL DICTIONARIES8
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From the Antidote menu bar
To add a word while the corrector is in the foreground, select Corrector in the menu bar, then Add to personal
dictionary…

To access your personal dictionaries from the menu bar, select Tools, then Personal Dictionaries… (on a Mac, select
Window instead of Tools).

ADDING AN ENTRY TO A PERSONAL DICTIONARY
When adding a word to a personal dictionary, you must provide some information so that the Antidote corrector can
analyze it properly. Be sure to avoid duplicating words for no reason, as it can slow down Antidote’s corrector.
Duplicate words will be marked in the list with a yellow triangle.

HEADWORD

Enter the term in this field to show how it is spelled. Enter the word’s uninflected form, i.e. the singular form for a noun
and the infinitive without to for a verb.

CATEGORIES MENU

Choose the syntactic category of the word you are adding (noun, proper noun, adjective, verb, etc.).
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VARIOUS INFORMATION

You must tell Antidote about certain semantic, syntactical or morphological properties of the new entry. The type of
information to be entered depends on the category of the term.

Adding a noun
Antidote asks you to specify whether your noun denotes a thing or concept
(e.g. jewel, butter, joy), a person (e.g. girl, linguist) or an animal (e.g.
panther). Check the appropriate box or boxes.

If it is a thing or a concept, you should also check the Uncountable entity
box if it can usually not be counted (e.g. joy, water), and the Diploma box
if it refers to an academic degree (e.g. B.Sc., Ph.D.).

If it refers to a person, check the Profession box if the noun refers to a
trade, profession or specialization (e.g. linguist).

Adding an adjective
If you are adding an adjective (Australian, for example as in
Australian beer) that can also be the name of a resident or
native of a place (an Australian), check the Demonym box. If the
word also refers to a language (Greek, for example), check the
Spoken language box, too. Otherwise, leave these boxes
unchecked. Verify that Antidote has inserted the correct form of
the comparative and the superlative, i.e. an –er/–est suffix for one-syllable adjectives, or the word more/most for most
adjectives with two or more syllables.

Adding an interjection
Do not include an exclamation mark if you add an interjection!
Choose one of the three types of interjection suggested:
emotional interjection (e.g. damn), message to others (e.g. hello)
or sound (e.g. ding).

Adding an adverb

You must specify whether you are adding an adverb of manner
(e.g. politely), of time (e.g. today) or of place (e.g. everywhere).
Check the appropriate box or boxes. You can check more than
one box if your adverb belongs to more than one type. Leave the
boxes unchecked if it does not belong to any of these three types
(see the Adverb article in the Antidote Grammar guide, in the
Other Categories section, for information on all the kinds of adverbs).

Adding a proper noun

For forming the plural, see the Inflection section below.➞
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Proper nouns normally start with a capital letter. Antidote asks
you to specify whether your proper noun is a last name, first
name, company or organization name, brand name, place
name, demonym (e.g. Australian), title of a work, or other.

If it is a place name, you will be asked whether it is a Street,
Town/city, Island, County/region, Body/course of water, or
Celestial body.

If it is a Demonym (e.g. Australian), check the language box if
the noun also refers to a language (e.g. Greek).

If your proper noun does not correspond to any of these
descriptions, check the Other option.

Adding an acronym or initialism
Antidote asks you to specify whether the acronym or initialism
you are adding is a company or organization name (e.g. UN), a
thing or concept (e.g. IPO, DNA) or a person (e.g. VIP). If it is a
thing, you may wish to specify whether it is uncountable (e.g.
DNA) and whether it is a diploma (e.g. Ph.D.). If it is a person,
indicate whether it is a profession (e.g. CEO).

Adding a verb
Antidote displays the inferred infinitive, 3rd person, past tense,
and past and present participle forms of the verb for you to edit
as necessary.

INFLECTION

When you enter a noun, a first name, or an initialism or acronym,
Antidote will ask you to confirm the suggested singular and
plural forms in the Inflection area. For an adjective, you will be
given suggested singular, plural, comparative and superlative
forms to approve or edit. For example, if you enter dibble as an
adjective, the suggested comparative and superlative forms will
be more dibble and most dibble; you can change them to dibbler
and dibblest if you wish.

DEFINITION

In this area you can add a definition for your new word. For the adjective antidotal, for instance, you could enter
“Concerning Antidote”. In fact, you can enter any information, note or comment that you consider relevant to the word
or its meaning. If you are writing a novel, you can enter a description for each of your characters. If you are working in
sales for a company, you can enter the terms used by the company or include a fact sheet on the parts or items it
makes. Then, when you come across these words in your text, you can just open the Dictionary window and display the
definition with this information.

For forming the plural, see the Inflection section below.➞
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“USE THIS WORD FOR CORRECTION” OPTION

When this box is unchecked, Antidote will use the new word in its dictionaries, for instance by displaying the definition,
but will not use it for correction. For example, you may uncheck this box if you are simply adding a new meaning for a
word that Antidote already recognizes. That way you can avoid ambiguities during the correction process.

SAVING THE NEW WORD
Once you have entered all the information concerning your new word, click anywhere
outside the right-hand panel to save it in your personal dictionary. Then you can
continue adding or editing words or close the Personal Dictionaries window.

If you add a word that Antidote already knows, either from its global dictionary or from
another personal dictionary, a warning box will appear at the bottom of the page when you save it and the word will be
marked in the list with a yellow triangle.

MANAGING ENTRIES IN THE PERSONAL DICTIONARIES

Adding words
You can add as many words as you like from the Personal Dictionaries window. To add a word, click on the + Add word
button (in Windows and Linux) or the  button (on a Mac) in the button bar below the list of words, then enter the
uninflected form (singular, or infinitive without to) of the word. Antidote automatically chooses what it considers the
most suitable category, judging by the spelling of the word. Enter the additional information on the new word and it will
be saved once you click outside the right-hand panel of the Personal Dictionaries window.

Duplicating words
To duplicate an entry from a personal dictionary, first choose it from the list, then open the Edit menu and choose
Duplicate (on a Mac, click on the Action (⚙)︎ button under the list of words, and then on Duplicate). You can also right-
click on the word and use the Duplicate command in the context menu. This operation can be useful if you want to add
a word with the same definition and semantic categories as another word that is already in the personal dictionary.
You may then change only the information that differs between the two entries.

Deleting words
To delete an entry from a personal dictionary, first choose it from the list, then click on Edit in the menu bar, and then
on Delete. You can also right-click on the word and use the Delete command in the context menu (on a Mac, you can
also click on the Action (⚙)︎ button under the list of words, and then on Delete). Once you have deleted a word, Antidote
will not recognize it the next time it encounters the word.

IMPORTING INTO A PERSONAL DICTIONARY

Importing lets you automatically add a list of words to a personal dictionary. To import terms, first select the
appropriate dictionary from the list of personal dictionaries. Then choose File from the menu bar, and Import into
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dictionary… (on a Mac, click on Import… in the Action menu below the list of dictionaries). Antidote then asks for the
location of the list to import. The list, in TEXT format, can be a simple list of words:

superhappy  [Carriage return]
unremember  [Carriage return]
...

It can also be a list of words followed by their syntactic category:

superhappy  [Tab]       Adj     [Carriage return]
unremember  [Tab]       Verb    [Carriage return]
...

The results of the import operation will be shown in a window. Antidote will tell you the number of words added, the
number of words added that underwent morphological changes and the number of words rejected.

You can save the list of rejected words so as to edit them and import them later.

Antidote may detect missing information when it imports the file. If so, a yellow warning triangle will appear. Check
whether the information that Antidote has automatically inferred and added is correct, and then click on the Accept
inflection button.

For more detail on importation from TEXT files, see this documentation on various formats, like these examples:

IMPORT FORMATS

INTRODUCTION

This document presents the structure of the export and import files of Antidote’s personal dictionaries.

STRUCTURE OF THE EXPORT AND IMPORT FILES

Other information can also be imported. For more details, see Importation format (in the Documents folder in the Antidote directory on
your hard disk).

➞

exemple-importation-fr.txt

exemple-importation-en.txt

exemple-importation-ml.txt

exemple-importation-en-fr-ml.txt

Text format

Each line must contain 1, 2 or 8 tokens separated by tabulations

Lines beginning with “//” are ignored with some exceptions (see the sections Word Language and Encoding)

Empty lines are ignored.
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Word Language

Encoding

Antidote tries to guess the file’s encoding based on the content and your system platform. You can also tell Antidote
which encoding you are using without it having to guess: Use the special comment coding: at the beginning of the file
followed by the encoding identifier.

Here are the encoding identifiers :

Example :

// coding: utf_8

To specify the language of the words to import, the following three identifiers are used :

FR: French

EN: English

ML: Multilingual (English and French)

These identifiers can be used in two places:

Globally, indicating the identifier in parentheses at the beginning of the file in the following comment:

Name : DICTIONARY_NAME (LANGUAGE_IDENTIFIER)

For each word, indicating the language identifier as the first attribute (see the section Importing 8
tokens below)

If the language is unspecified according to the previous methods:

In multilingual Antidote, an import error will occur.

In monolingual Antidote, the default language will be that of Antidote.

 mac_roman

 iso8859_15

 cp1252

 utf_8

 utf_16_le

 utf_16_be
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Importing One Token

If a line only contains one token, that token is considered the base form and Antidote infers the word category, and (if
required by the category) word morphology or verb model. In multilingual Antidote, the word language must be
globally specified at the top of the file with a special comment (see the section Word Language)

BASE_FORM __END_OF_LINE__

Importing Two Tokens

If a line contains two tokens, the first token is considered the base form and the second is considered the category.
Antidote infers the word morphology or verb model, if required by the category.

In multilingual Antidote, the word language must be globally specified at the top of the file with a special comment (see
the section Word Language)

BASE_FORM __TAB__ CATEGORY __END_OF_LINE__

Importing 8 tokens

If a line contains 8 tokens, these tokens are considered in the following order:

Base form

Category

Inflection 1 field

Inflection 2 field

Inflection 2 field

Inflection 2 field

Attributes separated by +

Definition

To introduce a new definition, insert the “◊” character

To introduce a new paragraph, insert the “” and “r” characters

For a multilingual word, it is possible to specify a definition for each language. All definitions are
specified in the same field. The French definition must be preceded by the keyword |FR|  and the
English definition by the keyword |EN| .

Example:
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Accepted Categories
French Words

English Words

Multilingual Words

Inflection Fields
French Words

|FR|Définition de « ABCDEFG »|EN|Definition of “ABCDEFG”

Acronyme  (acronym or initialism)

Adj  (adjective)

Adv  (adverb)

Interj  (interjection)

LocutionLatine  (Latin expression)

Nom  (common noun)

NP  (proper noun)

Verbe  (verb)

Pref  (préfix)

Acronym  (acronym or initialism)

Adj  (adjective)

Adv  (adverb)

Interj  (interjection)

Noun  (common noun)

PN  (proper noun)

Verb  (verb)

Acronyme  (acronym or initialism)

Acronym  (acronym or initialism)

NP  (proper noun)

PN  (proper noun)

Acronym, adjective, adjectival Latin expression, noun, proper noun

Inflection 1 field: Masculine singular
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English Words

Inflection 2 field: Masculine plural

Inflection 3 field: Feminine singular

Inflection 4 field: Feminine plural

Verb

Inflection 1 field: Verb model

Inflection 2 field: Leave empty

Inflection 3 field: Leave empty

Inflection 4 field: Leave empty

Adverb, adverbial Latin expression, interjection, prefix

Inflection 1 field: Leave empty

Inflection 2 field: Leave empty

Inflection 3 field: Leave empty

Inflection 4 field: Leave empty

Noun, acronym

Inflection 1 field : Singular

Inflection 2 field : Plural

Inflection 3 field : Leave empty

Inflection 4 field : Leave empty

Adjective

Champ de flexion 1 : Singulier

Champ de flexion 2 : Comparatif

Champ de flexion 3 : Superlatif

Champ de flexion 4 : À laisser vide

Verb

Inflection 1 field: 3rd person

Inflection 2 field: Past

Inflection 3 field: Past participle

Inflection 4 field: Present participle

Adverb, interjection, proper noun

PERSONAL DICTIONARIES  123



Multilingual Words

Attributes Accepted for Each Category
French Words

Inflection 1 field: Leave empty

Inflection 2 field: Leave empty

Inflection 3 field: Leave empty

Inflection 4 field: Leave empty

Acronym, proper noun

Inflection 1 field: Masculine singular

Inflection 2 field: Masculine plural

Inflection 3 field: Feminine singular

Inflection 4 field: Feminine plural

Noun

Chose

 Entite

 Diplome

Personne

 Fonction

 Animal

Adjective

Habitant

 Langue

Interjection

 Sensation

 Message

 Bruit

Adverb

 Maniere

 Temps

 Lieu
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Locution latine

 Adjectif

 Adverbe

Proper Noun

 Famille

 Prenom

 Compagnie

 Marque

Lieu

 VoieDeCirculation

 Ville

 Ile

 Region

 CoursDeau

 CorpsCeleste

Habitant

 Langue

 TitreOeuvre

 Autre

Acronym

 Compagnie

Chose

 NonComptable

 Diplome

Personne

 FonctionSociale

Verb

No attribute is accepted

Accepted models

 Aimer

 Finir
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English Words

 Courir

 Rendre

Prefix

 FacultTDU

 BesoinTDU

 ErreurTDU

 FacultTDUReforme

 BesoinTDUReforme

 ErreurTDUReforme

Noun

Thing

 Entity

 Diploma

Person

 Profession

 Animal

 Group

Adjective

Demonym

 Language

Interjection

 Emotional

 Message

 Sound

Adverb

 Manner

 Time

 Place

Proper Noun
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Multilingual Words

 LastName

 FirstName

 Company

 Brand

Place

 Street

 Town

 Island

 Region

 CourseOfWater

 CelestialBody

Demonym

 Language

 TitleOfAWork

 Other

Acronym

 Company

Thing

 Uncountable

 Diploma

Person

 Profession

Verb

No attribute is accepted

Proper Noun

 Famille , LastName

 Prenom , FirstName

 Compagnie , Company

 Marque , Brand
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SYNCING PERSONAL DICTIONARIES
You can sync your personal dictionaries across your different devices. To do this, select Modify sync options from the
Action menu (Mac) in the left-hand panel of your personal dictionaries. On Windows and Linux, you can find these
options by selecting File from the Antidote menu bar.

Note: Synchronization is an optional service provided by Druide informatique. See the Synchronization chapter for more details.

EXPORTING A PERSONAL DICTIONARY

You can export a personal dictionary by choosing File in the menu bar, then Export dictionary… (on a Mac, click on
Export… in the Action menu below the list of dictionaries). Antidote produces a file with all the information you provided

Lieu , Place

 VoieDeCirculation , Street

 Ville , Town

 Ile , Island

 Region , Region

 CorpsCeleste , CelestialBody

Habitant , Demonym

 Langue , Language

 TitreOeuvre , TitleOfAWork

 Autre , Other

Acronym

 Compagnie , Company

Chose , Thing

 NonComptable , Uncountable

 Diplome , Diploma

Personne , Person

 FonctionSociale , Profession
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for each of the entries in the personal dictionary: inflected forms, definition, syntactic category, semantic information,
etc. This file, in tab-separated TEXT format, can be opened in your word-processing program, your spreadsheet or any
other software that reads this format. It can also be imported back into Antidote.

COPYING A PERSONAL DICTIONARY
The words you enter in the personal dictionaries are saved in .atq and .xml files whose names correspond to those
displayed in the list of personal dictionaries.

To find a personal dictionary, in Windows and Linux, select File in the Antidote menu bar, then Show dictionary in
Explorer… On a Mac, click on Show in Finder in the Action menu below the list of dictionaries.

These files are created by Antidote itself, and only Antidote can change them. They contain all the new words you have
added, along with their definitions. These files are very important, so make sure not to delete them accidentally as you
would lose all the words you have added. It’s best to back up these files regularly.

MANAGING PERSONAL DICTIONARIES
Your personal dictionaries are listed in the left-hand panel of the window.
You can manage separate word lists, depending on your writing needs. If you
prefer, for example if you only use one personal dictionary, you can use the ⚙︎
button to hide or show the list of dictionaries.

Create
To add a new personal dictionary, click on the + Create a dictionary button (in
Windows and Linux) or the  button (on a Mac). This creates an empty personal
dictionary. You can add words by following the instructions in the section on
Managing Entries in the Personal Dictionaries.

Add existing dictionary
This option is available in the Action menu (on a Mac) or in the File menu in the menu bar (Windows and Linux). It lets
you add an existing personal dictionary, for instance one created by a colleague. After clicking on Add existing
dictionary…, you will have to decide whether to add a copy or the original; if you choose the original, the initial file will
be changed when you add or edit entries.

Rename
You can rename your personal dictionaries at any time. Select the dictionary you want to rename in the list of
dictionaries. Then click on File in the Antidote menu bar and select Rename dictionary (Windows and Linux); on a Mac,
click on the Action menu below the list of dictionaries and select Rename. You can also use the Rename command in
the context (right-click) menu when you select a personal dictionary. A third way of renaming a dictionary is to click
once on its name after you have selected it, and then edit it.

Activate and Deactivate
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By default, the entries in all your personal dictionaries are visible in the definitions dictionary and used by the corrector.
If you would like Antidote not to use the words in one of your personal dictionaries, you can deactivate that dictionary.
Select the dictionary to deactivate in the list of personal dictionaries. In Windows and Linux, select File in the menu bar,
then Deactivate the dictionary; on a Mac, select the Deactivate option from the Action menu below the list of
dictionaries. The name of the deactivated personal dictionary will be greyed out in the list.

To reactivate a personal dictionary, select it from the list in the left-hand panel and then click on Activate the dictionary
in the File menu (Windows and Linux) or on Activate in the Action menu below the list of dictionaries (Mac). You can
also use the Activate and Deactivate commands in the context (right-click) menu when you select a personal
dictionary.

Delete
To delete a personal dictionary, select it from the list and then click on Delete in the Edit menu (Windows and Linux) or
on Delete in the Action menu below the list of dictionaries (Mac). You can also use the Delete command in the context
(right-click) menu. Antidote lets you decide whether you want to delete the file in which the dictionary is saved, or
simply remove it from the list.

THE FRENCH MODULE  130



The English module of Antidote you have been using is the worthy successor to the French version, developed over
twenty years by a highly experienced team of linguists and computer scientists and incorporating a colossal amount of
information on the French language. All the features you have come to appreciate in the English module – the
corrector, the dictionaries, the guides and all their support modules – were created to the same high standard as in the
French module, scrupulously tailored to the linguistic, stylistic and typographic particularities of that language.

Every effort has been made to ensure that the two languages elegantly coexist. The same three-button bar allows you
to make use of Antidote’s resources in both languages; the program will automatically select the appropriate language
according to the context. The corrector can alternate between English and French texts, even within the same
document if necessary, and sorts its results accordingly. In this edition, Antidote builds on the integration of its French
and English resources with the creation of full-fledged bilingual dictionaries, including translations for each definition
of each word. What’s more, the guides now allow you to switch seamlessly between languages to articles that deal with
equivalent subjects.

With the French module, you add a whole new dimension to your Antidote, obtaining a state-of-the art grammar
checker that’s as rich and efficient in the language of Molière as it is in the language of Shakespeare.

This chapter lays out all the varied content and powerful functions that come with Antidote’s optional French module. It
concentrates on those features that are particular to the French module, referring you to the previous chapters for
those that are shared with the English module.

CORRECTOR
Working in conjunction with its English counterpart, Antidote’s French corrector is a powerful yet subtle tool that
analyzes the linguistic, stylistic and typographical characteristics of your text – whether it is written exclusively in French
or includes passages in both languages.

 THE FRENCH MODULE9
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Antidote’s French corrector covers a wide range of language issues. It can detect and correct errors involving spelling,
hyphens and capitalization; errors of grammatical agreement, including the notoriously difficult past participle;
homophones (différent/différend, ces/ses, voir/voire, etc.) and other frequently confused words; the correct way to
write dates, numbers or addresses in French; repetitions; inconsistent spelling; punctuation and spaces before
punctuation marks; etc.

Ever since the far-reaching reforms to French spelling proposed by the Conseil supérieur de la langue française in 1990,
two standards of French orthography have coexisted, called graphie traditionnelle and graphie rectifiée. Antidote can
automatically correct your spelling to comply with either of these two standards, whichever you choose. It can even flag
inconsistent spellings of the same word within a text.

To help polish your texts, Antidote’s Style view highlights critical questions of style in the French language through its
five filters. They look for repetitions, long sentences, verbless sentences, various potentially awkward constructions,
semantic redundancies, commonplace verbs, rare or long words, and many more. The Style view also highlights
passages in which more equal representation of men and women is possible.

In addition, the French corrector includes various linguistic filters that let you examine your text from several angles.
The filters in the revision prism focus on certain pragmatic, logical and semantic aspects of the text. The inspection
prism lays bare the sentence’s constituent elements: syntactic categories and functions, verb tenses, etc. And the
statistical prism compiles statistics on various linguistic parameters of the text and illustrates them graphically: the
various error types, the most frequent words, the distribution of words according to their etymology, etc.

Clicking on Antidote’s Help menu, under Other documents, you will find an HTML document entitled Démonstration de correction, which
illustrates a wide range of the corrections that Antidote can make in French.

➞
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BILINGUAL TEXTS

A text written largely in French may also include passages in English, and vice versa. These can consist of quotes, titles
of books, etc. Antidote automatically identifies a text’s predominant language, and flags passages in the other
language using a blue tab in the left margin labelled fr (for French passages) or en (for English passages). If the
automatic language detection does not produce the expected result, you can manually specify the language of a
particular passage or of the entire document by simply right clicking on the text and going to Language of the selection
or Language of the document. These options are also available from the Corrector menu. If the passage is a quote or a
dialogue in quotation marks, the flagged area in the margin will be green, with a speech bubble containing the
language labels mentioned above.

Statistical information on the distribution of the two languages is displayed along the top of the corrector’s window, for
example, 92% English, 8% French.

Important: the number and type of errors flagged by Antidote’s French corrector depend on your settings, including
those listed under First language and Written French ability. Various other settings are found in both the English and
the French versions; see the Settings section in this chapter for more details.

The list of detections
The list of detections is divided by language: under each class of detection, the
headings English and French appear, in order to clearly distinguish their language.

Separate filters for each language
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For multilingual texts, certain filters include two buttons, English and French, which allow
you to view the analysis of the French passages and then the English passages. The filters
that display these buttons are: (in the Statistics prism) Error types, Etymology and
Categories; (in the Inspection prism) Categories, Phrases, Syntactic, Functions and
Conjugation.

USING THE CORRECTOR

In many respects, the French corrector is similar to the English corrector described in the
Corrector chapter. Please refer to those pages for the details on the corrector’s operation
that apply to both languages: accessing the corrector, the meaning of the different types of
underlining, explanations of the different types of detections, the various settings, etc. Here,
we describe those features of the corrector’s operation that are particular to French texts.

Language-specific features of the Style view
The options for the Style view apply to both languages, except when the language is
specifically mentioned above the option.

The sections within the Style view adapt to the particularities of each language. For
example, split infinitives are irrelevant to French, and so the Constructions section of the
French Style view does not detect them. However, it does include a number of
detections specific to French, such as participial phrases and the formation of negatives.
Similarly, in the Vocabulary section, the French module distinguishes between offensive
(e.g. racist, insulting, sexist, etc.) and inappropriate vocabulary (e.g. sexual,
scatological, violent), while it does not detect contractions or nominalizations. Similarly,
the Gender neutrality section produces different detections in French compared with its
English counterpart, reflecting the different concerns specific to each language.

Language-specific features of the Inspection and Statistics prisms
The National varieties filter that appears in the Inspection prism of the English module
does not exist in the French module. However, the French module does include three
filters that don’t apply to English but are very relevant for French grammar checking:
Agreement, which is far more complex in French, (grammatical) Genders and Spelling
rectifications. The Syntactic functions and Conjugation filters also differ in the French
module, owing to the differences between French and English grammars. You will also notice changes in the results of
the Etymology filter (Statistics prism), since far more words in French derive from Latin, Gaulish and Frankish origins.

DETAILED ANALYSIS
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As in the English module, Antidote produces a detailed
analysis for French sentences, with the difference that it
employs certain notions that pertain to French grammar
(e.g.: épithète, genre, incise). For a clear definition of
these terms, you can consult Antidote’s dictionaries.

DICTIONARIES

INTRODUCTION

Antidote’s French dictionaries contain a wealth of
information on all aspects of the French language: the
meaning of words and idioms, pronunciation, spelling
variants, synonyms, conjugations, semantic fields,
combinations, etymologies, and more.

Accessing the French dictionaries
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Antidote opens its French dictionaries automatically when you type a non-ambiguous French word in the headword
field. You can also open them yourself from any of the English dictionaries by clicking on the French button located
above the list of dictionaries. Depending on how you have chosen to configure the button, it will either take you from
the English entry to that of its French translation, or will perform a search in the French dictionaries for words that are
graphically similar to the English headword. The settings for the button are described in the Interface Settings section
and are accessible from the General panel of the Interface settings or the shortcut Alt  + click. If the button is
configured to take you to a translation and multiple translations are possible, a chevron will appear on the right of the
French button. Clicking on that chevron will give you a choice of which entry to show. The default entry is the one with
the highest frequency.

Instant search menu
The instant search menu appears as soon as you start entering letters in the
headword zone and proposes, as you continue typing, the most relevant search
results. For many expressions, Antidote’s dictionaries also contain results in the
other language; to see them, just select Show French results in the English
dictionaries or Show English results in the French dictionaries, which appear at the
bottom of the menu.

Homographs bar
When the headword has homographs, like the word force, which is a noun, a verb,
and a plural determiner in French, they are displayed in the homographs bar
located above the header for all dictionaries. For some dictionary searches, results
exist in both languages; the options n additional results in French… and n
additional results in English… allow you to view the results in the other language.

DEFINITIONS DICTIONARY (DÉFINITIONS)
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This dictionary
provides definitions
for 128,000 French
words, in addition to
55,000 expressions,
idioms and proverbs.
The structure of the
French definitions is
similar to that found
in the English
dictionary: the
entries are divided
into meanings, sub-
meanings and
semantic divisions,
with examples
provided in grey
characters. There
are, however, some
notable differences.

In many cases, especially when the word being looked up is common, the meanings and sub-meanings are
accompanied by example expressions. These are categorized and presented as follows:

All definitions in the French dictionary begin with a capital letter.

The examples are separated by a period and begin with a capital letter, regardless of whether they are
grammatically complete sentences.

Domain labels (e.g. ÉCONOMIE, DROIT, CINÉMA, MUSIQUE) appear in black and usage labels appear in blue
(e.g. SOUTENU, ARGOT, FAMILIER, VIEILLI) or in red (e.g. OFFENSANT, DIFFAMATOIRE, PÉJORATIF). The usage
labels indicating the region or regions where a particular word meaning is used (e.g. QUÉBEC, SUISSE,
ANTILLES, AFRIQUE, BELGIQUE) are also displayed in blue. As in the English version, a click on a usage label
opens the article in the Antidote guides where it is described in full.

Figurative expressions or idioms
(locutions in French), in which the
meaning of the headword has a
certain metaphorical or metonymic
sense that is different from its usual
sense (e.g. in the expression ouvrir le
bal, which means “to be the first to do
something”, the French noun bal no
longer has its primary meaning). The
symbol � appears to the right of certain expressions, which allows you to access additional information on that
expression: an indication of its frequency, or links to external search tools which can be activated in the
settings.
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Translations
Translations are a major new feature in Antidote 10 and its French module. Every definition of every word and
expression is now accompanied by a translation, both from French to English and from English to French. These
translations are displayed using the Hide/Show translations command located in the top right corner of the definitions
area. When shown, the translations appear in italic grey text underneath each definition and are introduced with the
symbol ⇄.

For example, in the French adjective entry titulaire, each of the three definitions has its own translation. In the context
of religion (third definition) the English translation is titular. Simply clicking on this translation will cause a tooltip to
appear showing the religion-specific English definitions of titular. This allows users to compare the French definitions
with the English ones. Double clicking on the translation will open the English entry for the word in question.

Expressions and proverbs are also translated. As such, in the Locutions section of the entry titulaire, the expression
évêque titulaire is accompanied by the translation titular bishop.

Formulations — Some translations are preceded by formulations in the source language, shown in roman type and
followed by a colon. These formulations show the headword as part of a particular expression or construction. For
example, one of the translations of the French entry embarcation is shown as follows: embarcation de sauvetage :
lifeboat. This shows users the full expression corresponding to one of the principal translations of the noun
embarcation.

Usage contexts — Some translations are preceded by an indication of the context to which they apply, shown between
parentheses and in roman type. For example, the first definition of the French word abattre can have a number of
appropriate English translations depending on the context. Accordingly, many of the translations include contexts such
as the following: (arbre) fell.

Usage labels — Usage labels accompany translations whenever appropriate. For example, the informal French verb
faucher includes the translations snatch and nab, preceded by an INFORMAL label. In general, Antidote provides
translations of the corresponding register in the source language.

Proverbs, i.e. sayings that are often
short and purport to state a general
truth or provide a piece of advice, e.g.
Qui ne risque rien n’a rien, which is
equivalent to the English Nothing
ventured, nothing gained.

Non-standard constructions, usually
consisting of literal translations from
English or other improper uses. These
constructions are shown in red to
highlight the fact that they are
incorrect.
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Connected translations Certain lists of translations are followed by an ellipsis enclosed in square brackets, indicating
that connected translations are available. They can be revealed by clicking on the ellipses and are shown in a lighter
grey font. These translations are generally less relevant than the principal translations for a number of reasons, such as
relative rarity, a difference in register, or a more restricted meaning. Still, they may be useful in certain contexts. For
example, the first definition of the French verb dépasser includes a number of connected translations, some of which
are informal or specific to a particular region. To hide the list of connected translations, simply click on the ellipsis
again.

Details panel
Under Précisions in the Details panel (right-hand column), you will find the following:

If the looked-up word is subject to the 1990 French spelling rectifications, Antidote displays a note with the rectified
spelling (e.g. flute, rectified spelling of flûte). In the case of a word with alternate spellings, one of which is
recommended by the rectifications, a blue dagger symbol (†) highlights the recommended spelling (e.g. baseball,
recommended without a hyphen).

Under the Difficultés heading, you will find the following:

Etymological notes on the headword and the  symbol which provides a link to the
historical dictionary where you can find more information on the history of the
headword

A scale indicating the relative frequency of the word in French

Inflection information: If the word being looked up has more than one form (noun,
adjective, pronoun, etc.). Antidote shows its inflections for the masculine, feminine,
singular and plural. Inflections for nouns begin with the determiner un, une or des,
so that they can be interpreted intuitively. For verbs, Antidote shows the infinitive
form (e.g. avoir), as well as the tense, mood and person if a conjugated form is
looked up (e.g. avais)

The phonetic transcription of the headword and its inflected forms, if applicable.
There is also an option that allows you to switch between two different phonetic
transcriptions, the International Phonetic Alphabet (Show IPA) and the French phonetic alphabet (Show FPA)

Alternative spellings of the word

An explanation of any linguistic difficulties (grammar, spelling, syntax or other)
related to the use of the headword
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Under the Compléments heading, you will find the following:

DICTIONARY OF SYNONYMS (SYNONYMES)

Antidote’s dictionary of French synonyms is a
treasure trove of information, offering hundreds of
thousands of synonyms that express myriad shades
of meaning and semantic correspondences. In it, you
will find the following:

Sorting the synonyms
According to your requirements, you can choose between four ways of sorting the synonyms: alphabetically, by
relevance, by frequency or by length (number of letters). Sorting options are accessible from the menu bar underneath
the main synonyms panel.

Predefined search criteria (definitions containing the headword, English words
translated as the headword, rhymes and anagrams)

More search tools, e.g. the Wikipedia encyclopedia and the Google search engine,
which can be activated in the settings. Other online linguistic resources can be
added manually

The headword’s main meanings, each
preceded by a green hide/show triangle (‣
or ▼)

Further information on meaning or use,
preceded by a bold green bullet (•)

The labels, in small caps, which indicate the
context in which the synonyms they
introduce may be employed. These are
divided into domain labels in black (e.g.
ALIMENTATION, CHASSE, INFORMATIQUE,
MÉDECINE, etc.), and usage labels in blue (e.g.: SOUTENU, FAMILIER, ARGOT, VIEILLI, etc.) or in red (e.g.
OFFENSANT, PÉJORATIF, etc.). The usage labels indicating the region or regions where a synonym is used (e.g.
BELGIQUE, QUÉBEC, FRANCE, etc.) are also displayed in blue. Clicking on a usage label opens the article in the
Antidote guides where it is described in full.

Hyperonyms and hyponyms, identified by the headings PLUS GÉNÉRIQUE (more general), PLUS SPÉCIFIQUE
(more specific). The lists of hyperonyms and hyponyms are preceded by a solid green square (◼)︎. A small blue
circle with a number indicates either that a hyponym has hyponyms of its own, or that a hyperonym has
hyperonyms of its own. Clicking on that circle will reveal these secondary hyponyms (shown with a right-
pointing arrow) or hyperonyms (shown with a left-pointing arrow) in a list. The same process can be repeated
should any of the newly revealed words have their own hyponyms or hyperonyms. A list can be hidden again
by clicking on its arrow.

The contexts, in grey and in parentheses, which specify the context of use of the synonym (e.g. “louve
(femelle)” as a synonym of the word loup).
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Filters
The same menu bar also contains two filters that cause only certain synonyms, hyponyms and hyperonyms to be shown.

The first filter is based on the words’ semantic or expressive strength (strong, weak or neutral). By default it shows
everything.

The second filter allows only words without usage or domain labels to be shown. By default it shows everything.

DICTIONARY OF ANTONYMS (ANTONYMES)

An antonym is a word with a meaning which is opposed to that of another word. Antidote contains over 100,000
antonyms, which can be extremely useful in finding a term whose opposite one knows better. If the word in question is
polysemous (such as remercier, which can mean either “to thank” or “to fire”), Antidote classifies the antonyms
according to the sense in question, making it easier to select the proper term. You can click on the show/hide triangles
(for each list or that of the whole entry) to switch between an exhaustive view and a summary of the antonym lists.

DICTIONARY OF COMBINATIONS (COOCCURRENCES)

The dictionary of
combinations (called
“cooccurrences” in
French) provides all
the most significant
combinations of the
headword with other
words, grouped by
syntactic context, in
addition to the
strength of each
combination and, if
applicable, the
various meanings of
the headword. For
the noun feu (“fire”), for example, you will find combinations like jouer avec le feu, combattre le feu avec le feu, feu de
camp, feu purificateur, feu et sang, feu sacré, le feu s’éteint, péter le feu and hundreds of others. The manner in which
the French combinations are displayed is similar to that found in the English dictionary of combinations, except for the
following:

Labels
If a combination belongs to an informal register, a usage label (FAMILIER or TRÈS FAMILIER) is shown to its right. If a
usage label applies to all combinations in a given sense, it is not repeated next to each combination; instead, it is shown
next to the heading that indicates the sense.

Translations

the syntactical contexts are adapted to French grammar and include classes that don’t appear in the English
dictionary, e.g. avec nom complément (“with noun complement”), avec adjectif descriptif (“with descriptive
adjective”), en apposition (“in apposition”).

the List of sources, a link that lists all the French texts used to build up the dictionary of combinations.
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When the French module is installed, each of the combinations shown in both the English and the French dictionaries
includes a translation into the other language. To show or hide the Translation column, click the ⇄ button located in the
title bar. For example, the French word eau , the combination eau potable includes the translation drinking water. If a
combination includes a second translation, it is separated from the first by a middle dot. For example, for the
combination eaux usées the Translation column shows the following: “wastewater • sewage”.

Examples and definitions — Whenever the translation for a combination is itself included in the other language’s
combinations dictionary, as is the case with drinking water, a > symbol appears to its right. Clicking on one of these
translations will cause any examples or definitions associated with it to display in the right-hand panel. The buttons at
the bottom of this panel are for switching between examples and definitions. When the translation is not a combination
in the other language, no > sign is present and clicking on the translation will cause definitions of its constituent words
to display in the right-hand panel. For example, water for washing is the translation of the French combination eau
pour laver. Since water for washing does not feature in Antidote’s English combinations, clicking on it causes definitions
for the words water and washing to display on the right.

Search — When the Translations column is shown, the search box located at the bottom of the main combinations
panel searches in both the combinations and their translations.

Sorting — It is possible to sort the translations in alphabetical order by clicking on the title of the Translations column.

DICTIONARY OF SEMANTIC FIELDS (CHAMP LEXICAL)

This dictionary
displays all the
French words that
are semantically
related to the
headword. These
are grouped by
syntactic category
(nouns, adjectives,
verbs) and ranked
by relative strength.
In total, 69,000
entries, including
10,000 proper nouns,
are joined by 2.8
million links.

CONJUGATION
DICTIONARY
(CONJUGAISON)
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Antidote’s French
conjugation
dictionary provides
the complete
conjugation for more
than 9,000 French
verbs, in total more
than 450,000
conjugated forms.
For each verb, the
conjugation
dictionary displays a
complete
conjugation table
that includes all the
conjugated forms in
all the tenses and
moods, both for the
simple form of the
verb and the pronominal form (if it exists). The form typed in the headword zone is highlighted in the table to make it
easier to find. Click on any form in the table to select it, and then on the Replace button to insert it into your text.

To make it easier to consult, the table groups the numerous conjugated forms into simple tenses (temps simples),
compound tenses (temps composés), including the auxiliary with which the verb is conjugated, and periphrastic tenses
(temps périphrastiques).

For compound tenses, a menu is available to illustrate the different agreements of the past participle according to the
position, gender and number of the complément d’objet direct (if applicable) or according to the gender and number
of the subject. This menu is only available for verbs with variable past participles; otherwise Antidote shows PP
invariable. To learn more about past participle agreement, click the link to the guides shown in the Notes box.
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DICTIONARY OF FAMILIES (FAMILLE)

The French dictionary of families
presents all the words in the
headword’s morpho-semantic family.
When the headword exhibits multiple
meanings that are sufficiently
distinct, a horizontal grey line
separates the families related to
each.

DICTIONARY OF QUOTATIONS
(CITATIONS)

To illustrate how the words of the
language are actually used, the
French dictionary of quotations offers
a compilation of more than 280,000
sentences taken from great authors
and major newspapers. Each quote
comes with a hyperlink that allows
you to find its electronic source on the
Internet.

HISTORICAL DICTIONARY
(HISTORIQUE)
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The historical dictionary provides the
detailed etymology of 98,000 words,
accompanied in most cases by a
hierarchical list of etymologically
related words (Parents
étymologiques), and often
supplemented with explanatory
remarks.

Entries in the French historical
dictionary are divided into the
following components:

The etymology of the
headword, including at least
the etymon (i.e. the word
from which the headword is
derived), its meaning and
the language from which it
derives (in orange and
linked to an article in the historical guides). Other information may be provided, e.g. whether the headword
belongs to the native stock of the language (“fonds primitif”), the influence of a second etymon on the main
etymon, the apparent (morphological) etymology of a derived form, etc. For some words whose etymology is
difficult or very interesting, an explanatory remark may provide further information.

The etymologically related words (Parents étymologiques), which, beginning with the main etymon, form a
sort of family tree that traces the word’s evolution. For example, for the French word texture (from the classical
Latin texere, “to weave”), the etymologically related words include the Old French tistre (which gave rise to the
French noun tissu), the Middle French tissir (from which the modern French verb tisser is derived), the medieval
Latin textualis (from which modern French gets the adjective textuel), etc. All these words share a common
etymon: the Latin verb texere. To clarify the list of etymologically related words, a simple line of Ascendance is
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Remember too that a summary of the word’s etymology appears in the Précisions panel in the definitions dictionary,
where the symbol  allows you to access the historical dictionary.

ACCESSING WIKIPEDIA

You can access the
French version of
Wikipedia, the well-
known online
encyclopedia, by
clicking directly on
the Wikipédia link in
the Compléments
section of the
details panel or by
clicking the � button
which is found to
the right of many
expressions in the
French dictionaries.
Access to Wikipedia
or its sensitive
content can be
restricted using the
settings. Antidote
displays the results
from Wikipedia
directly in the
dictionary window.
The hyperlink in
English in the upper
right corner of the article lets you switch to the English version of the article, if it exists in Wikipedia. Conversely, an
article that is displayed in English will include the hyperlink in French.

also included, which indicates sequentially, from the oldest etymon to the most recent, the major steps in the
headword’s evolution. The symbol > can be read as meaning “gave rise to, produced, formed”.

Historical changes in the spelling of over 26,000 words,
from their origins to the present day, presented on a
timeline and attested by 275,000 sentences gathered from
historical sources. Using this, we discover that azote
“nitrogen”, for instance, was coined by Lavoisier from
Greek affixes meaning “not” and “life”, and that fleur 
“flour” was written as both fleur and flour until the 17th
century.
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MULTI-WORD SEARCH

Like its English counterpart, French multi-word search allows you to search for complex expressions in the dictionaries.
This feature makes it easy for you to find the links between words, like those that occur in expressions, combinations,
proverbs, etc.

SEARCHING WITH VARIABLES

Searching with
variables in
French is very
similar to
searching with
variables in
English.

SEARCHING BY
CRITERIA
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Searching by
criteria is a
powerful tool
that lets you
make the most
of the vast
stores of
information
residing in
Antidote’s
French
dictionaries.
The same tools
are offered for
searching by
criteria in
French as in
English, and
the two are
also accessed
in the same way. For the most part, the search criteria are also the same in both languages; you can search by word,
lexical category, definition, domain, encyclopedic information, number of letters, number of syllables, frequency, rhyme,
register, number, positive/negative proverb, translation and language of origin. To these, French adds gender and
rectified spelling.

In French, there’s an extra option in the Forms section allowing you to require an exact match of the accented
characters (exact accents), in addition to searching for all inflected forms (inflections) and including spaces in the
results (with spaces).

FAVOURITES AND PERSONALIZED WORD LISTS

Adding and
removing
favourites and
personalized
word lists is done
the same way in
the English and
French
dictionaries (see
the Dictionaries chapter). The Edit… command in the favourites menu, accessible by clicking on the arrow to the right
of the heart, opens the Favourites window. This window displays English and French lists separately and offers several
options for managing them. The favourites menu also includes the command Also in English/French, which is used to
alternate between the English and French lists.

THE FRENCH MODULE  148



DISCOVERING NEW WORDS

By clicking the Discover button (), you can discover and learn new French words, both frequent and rare, in addition
to the names of famous people, countries, cities or World Heritage sites, and read interesting notes about French
etymology.

GUIDES

INTRODUCTION

The French guides cover a wide range of topics. They can help you write better French, whether you’re a francophone,
an anglophone or bilingual. You many need to consult the guides on a very specific question – What’s the correct way
of writing an address in French? What are the rules for spaces before and after a colon? – or simply because you want
to learn more about a particular aspect of the language – What are the principal recommendations of the last spelling
reform? What languages contributed the most to the French lexicon? The guides are replete with examples, tips and
advice that will give you a better understanding of the French language and help you overcome many of its difficulties.

Antidote’s French module contains more than 825 articles on the difficulties of writing correct French and how to
overcome them. These are divided into eleven guides.

Orthographe (Spelling)
Articles on the formation of the plural, homophones, capitalization, diacritics, hyphens, the spelling reform, etc.
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Lexique (Lexicon)
Articles on French inflectional and derivational morphology, Anglicisms, various types of lexical and semantic
confusions, Antidote’s dictionaries, etc.

Grammaire (Grammar)
Articles on the basic notions of French grammar, the various lexical categories, syntactic functions, rules of agreement,
etc.

Syntaxe (Syntax)
Articles on the different types of sentences, i.e. declaratives, questions, negatives, coordinated sentences, cleft
sentences, etc.

Ponctuation (Punctuation)
Articles on the use of all the various punctuation marks, French quotation marks, hyphens, different types of
parentheses, etc.

Style
Articles on French stylistic conventions, registers, figures of speech, transitions, etc.

Rédaction (Business Writing)
Articles on the correct way to write business letters in French, emails, abbreviations, dates, addresses, sums of money,
the feminization of nouns and titles, etc.

Typographie (Typography)
Articles on the correct use of breaking and non-breaking spaces in French, italics, French quotation marks and other
paired symbols, case in enumerations, special characters, etc.

Phonétique (Phonetics)
Articles that discuss the relationship between French spelling and pronunciation, the two standards of phonetic
transcription, elision, liaison, Parisian pronunciation compared to Montreal pronunciation, etc.

Historique (History)
Articles on the evolution of French vocabulary, the French spelling system, French grammar, the many languages from
which French borrowed, etc.

Points de langue
The Points de langue guide contains language-related articles published by Druide’s linguists on our website. They
contain answers to the most frequent or complex questions that arise and may further clarify subjects dealt with in the
other guides.

FROM ONE LANGUAGE TO THE OTHER
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The English and French buttons located in the upper left corner of the table
of contents let you move quickly between guide articles in each language
dealing with equivalent subjects. It is also possible to go from one language
to the other via the results displayed in the instant search menu. The link Also
n additional English articles…, at the bottom of the search results, indicates
the number of articles corresponding to the current search in the other
language, and, when clicked, takes you directly to the pertinent guides.

When the language of the search term is unambiguous, Antidote takes you
from one language guide to the other intelligently. For example, if you search
for “ponctuation” in the English guides, Antidote will understand that this is a
French term and will automatically display the results it finds in the French
guides.

FAVOURITES AND PERSONALIZED ARTICLE LISTS

Adding and removing favourites and
personalized article lists is done the same
way in the French guides as in the English
(see the Guides chapter). The Edit…
command in the favourites menu,
accessible by clicking on the arrow to the
right of the heart, opens the Favourites
window. This window displays English and
French lists separately and offers several
options for managing them. The favourites
menu also includes the command Also in
English/French, which is used to alternate
between the English and French lists.

ANTI-OOPS!
The French module includes a version of Anti-Oops! (spelled Anti-Oups! in French) that is specially adapted to French
emails. As soon as it spots English or French text in your message, it sends it to Antidote’s corrector to detect any
possible errors and remind you of a file you may have forgotten to attach. To this end, Anti-Oops! scans your emails for
sequences of words such as veuillez trouver le fichier ci-joint (“please find the attached file”) or je vous envoie une
ébauche… (“I am sending you a draft”).

The same settings apply to the French and English versions of Anti-Oops!, including those that govern the list of words
to be excluded from the corrector’s analysis and the prevention of correction for certain recipients (see the Settings
chapter).
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SETTINGS

INTRODUCTION

The settings serve to adjust Antidote’s actions when it corrects a text and to customize many aspects of its interface.
They are divided into four sections – Interface, Corrector, Language, Typography – two of which, Language and
Typography, have submenus that apply specifically to French. For a general presentation of the operation of Antidote’s
settings that apply to both languages, see the Settings chapter. Here, we discuss those settings that apply only to
French.

ACCESSING THE FRENCH SETTINGS

The English and French settings are found within the same window, which can be accessed in
different ways: via the main menu, with Antidote > Preferences… or Corrector > Settings…; from
the corrector, by clicking on the settings icon in the main window or directly from the tooltips associated with certain
corrections; or by using the keyboard shortcut Cmd  + r  on a Mac or Ctrl  + r  on Windows and Linux. Once in the
Settings window, the different sections can be viewed using the left-hand column. Settings specifically concerning the
French module can be found in the following locations: Interface (General panel), Language (General, User,
Protagonists, Word usage, Word choice, Capital letters, Punctuation and Spelling rectifications panels) and
Typography (General, Spaces and Conventions panels). Within these panels, clicking the blue French button on the top
line lets you view the French settings, except in the Protagonists and Spelling rectifications panels, which only apply to
the French module.

INTERFACE SETTINGS

GENERAL PANEL

Dictionaries and guides... French and English buttons: Enable translation
When the Enable translation option is checked, the French and English buttons
alternate between equivalent content in each language: in the dictionaries, it
switches to the most frequent translation for the word in question, while in the
guides, it switches to an article dealing with the same subject. If the option is
unchecked, the button will perform a search in the other language using the text
entered into the headword field, whether in the dictionaries or the guides.

LANGUAGE SETTINGS

GENERAL PANEL
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Flag ambiguities
When this setting is enabled, Antidote will place an orange, wavy line under
any words that can be written in more than one way according to the
intended analysis.

Flag gender-specific job titles
Traditionally, the French words for certain job titles only had a masculine
form. Since these jobs are not limited to men, corresponding feminine
forms, such as avocat/avocate and ingénieur/ingénieure have now
developed. Some speakers still hesitate to use these feminine forms,
although they are recommended and closely follow the grammatical and
morphological rules of French.

By default, the corrector favours the feminine form of titles when they refer
to a woman (e.g. Rose est une écrivaine de grand talent). If this setting is disabled, the corrector allows masculine forms
of titles when they refer to a woman (e.g. Rose est un écrivain de grand talent).

Flag abbreviated doublets (e.g. client(e)s)
Abbreviated doublets are sometimes used to represent both genders (e.g. client(e)) or both plural and singular (e.g.
elle•s). However, they can complicate a text both visually and gramatically. What’s more, it is unclear how they should
be pronounced. For these reasons, they are not recommended, regardless of the chosen format (parentheses, hyphens,
etc.). You can choose whether Antidote flags them.

Flag missing ne (e.g. j’aime pas)
The negative particle ne is often omitted when speaking but is not recommended in written language, unless the writer
intends to represent informal speech. You can choose whether the Antidote flags instances of a missing ne.

Abbreviations that are usually non-standard (e.g. qqn)
Abbreviations such as qqn, (“quelqu’un”) and pquoi (“pourquoi”) speed up writing and may be used in some contexts.
Otherwise, they are considered non-standard. You can choose whether the corrector replaces them with their
unabbreviated forms or allows them.

Flag the use of 2  for 2 , 1  for 
2  and 1 , as well as their plural variants, are not the recommended way to represent these ordinal numbers in
French. You can choose whether the corrector allows them or replaces them with the correct forms 2  and 1 .

This setting is enabled by default➞

This setting is enabled by default➞

This setting is enabled by default➞

This setting is enabled by default➞
You can specifically prevent correction of missing ne in dialogues or quotes. See the setting Disable certain detections in dialogues and
quotes in the General panel of the corrector’s settings.

➞

This setting is enabled by default➞
ème e ère 1re

ème ère

e re

This setting is enabled by default➞
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Pas participles agreeing with en
Traditionally, past participles do not inflect to agree with the antecedent of the pronoun en. However, this is becoming
more and more common (e.g. des tartes, elle en a faites tout le weekend). You can chose whether Antidote flags this
usage.

Disable certain detections by statistical filter
You can tell the corrector not to apply certain statistical filters that are intended to refine its analyses, but which may
cause some errors to go undetected. This is done by unchecking the Disable box.

Lorsque, puisque and quoique
Finally, you can tell Antidote to verify the elision of the final vowel in the subordinate conjunctions lorsque, puisque and
quoique. Here you have the choice of enforcing elision before all vowels or a silent h (which is the standard rule), or only
before certain words (un, une, il, ils, elle, elles, on, en and ainsi).

AUTHOR PANEL

First language
Antidote needs to know what your mother tongue is in order to fine-tune its
correction. For example, if your first language is English, it will try to recognize
certain mistakes that an English speaker is more likely to produce in French
(e.g.: je *suis 34 ans, or être libre *faire qqch.).

Written French ability
Here you have the choice of three levels:

Regional language variety
Antidote needs to know what region of the French-speaking world you live in, and asks you to select between Belgium,
France, Quebec/Canada, Switzerland, Africa/Caribbean/ Louisiana, and Other. The corrector’s suggestions are
influenced by the linguistic region you indicate here. Some language and typography settings are also adjustable
according to regional language variety, reflecting the preferred conventions in that area (for example, number formats,
the type of spacing for use with symbols, etc.).

Regional words or senses

This setting is enabled by default➞

When Antidote is first launched, a dialogue window asks you what your first language
is. The value of this setting is adjusted according to your response.

➞

Minimum level (written French skills are rather weak): The corrector
flags the standard set of errors, but includes certain errors that are
somewhat rare.

Intermediate level (written French skills are quite good): The corrector flags the standard set of errors.

Maximum level (written French skills are very good): The corrector flags the standard set of errors, but does
not indicate certain errors that an advanced speaker of French is unlikely to make.
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If this box is checked, Antidote will flag certain expressions that are unique to a particular linguistic region, depending
on which of the following three settings you select using the sliders: minimum level (the corrector flags no regionalisms);
intermediate level (a regionalism will be flagged if its regional character applies to all its meanings); and maximum
level (a regionalism will be flagged if its regional character applies to at least one of its meanings). Antidote recognizes
a large number of regionalisms from various parts of the French-speaking world, including those that are specific to
Quebec (e.g.: achalant meaning “disturbing”); Belgium (e.g. fricadelle meaning “meatball”); Provence (e.g.: canier
meaning “place where rushes grow”) and other French-speaking regions such as Switzerland and Acadia.

Protagonists panel
The corrector can use context to determine the gender of the French pronouns je, tu, nous and vous, and whether the
pronouns nous and vous refer to one or several people. For example, in the expression Vous êtes gentille, the corrector
can deduce that vous refers to one female person, because the adjective gentille is in the feminine singular form.
However, you also have the option to manually determine the number and gender of people that these pronouns
designate in your text. For example, if you designate tu as feminine, Antidote will correct the expression *Tu es gentil
with Tu es gentille, and *Sois gentil with Sois gentille. By default, these settings are set to case-specific, meaning that
gender and number correction will depend on the context. We recommend that you adjust the particular gender and
number in the settings whenever possible.

WORD USAGE PANEL

Register, inappropriate and offensive terms
Depending on your settings, the corrector will attempt to identify and assess the
appropriateness of those terms that belong to the various registers that Antidote
recognizes in French. These include offensive, e.g. merdeux for “voyou”; informal,
e.g. fortiche for “habile”; slang, e.g. que dale for “rien”; formal, e.g. forfaire for
“manquer à”; and old-fashioned, e.g. consomptueux for “atteint de tuberculose”.

The corrector will also flag terms that are considered highly offensive or
inappropriate, in accordance with your settings. The French module recognizes
many different categories here, including the following: racist, e.g. youpin for
“juif”; homophobic, e.g. pédé for “homosexual”; vulgar or blasphemous, e.g.
merde for “excrément”; and sexual, e.g. bite for “pénis”.

For each of these register, three settings are possible: minimum level (nothing is
flagged); intermediate level (an expression is flagged if it belongs to this register
in all its meanings); and maximum level (an expression is flagged if it belongs to
this register in at least one of its meanings).

CONFUSION PANEL

To disable all these alerts, uncheck each of the three boxes: Registrer, Inappropriate terms
and Offensive terms.

➞
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The French module recognizes three major classes of confusion: non-standard
Anglicisms, lexical confusions and redundancies.

Non-standard Anglicisms
Not all borrowings from English should necessarily be avoided; much depends on
whether an equivalent and appropriate term exists in French. Antidote focuses on
those Anglicisms that are universally considered non-standard, and among these
it can flag imported English words – Alerts for English words, e.g. container for
“conteneur” – and multiword French expressions that are patterned on English
phrases – Alerts for calques, e.g. manuel de service for “guide d’entretien”. In both
cases, you have the option of automatically replacing the errors that Antidote
flags by checking the Treat as errors box. Antidote also recognizes a large
number of false friends – words in English and French that look or sound alike but
differ significantly in meaning, e.g. librairie in French, which means “bookstore”,
and library in English, which designates “a book-lending institution“. Here too you
have the choice of three settings: minimum level (no false friends are flagged);
intermediate level (the corrector flags the most frequent false friends); and
maximum level (the corrector flags all potential false friends).

Lexical confusions
Antidote distinguishes three different types of lexical confusions: homophones, i.e. words that are pronounced alike but
are spelled differently, e.g. ballade and balade; near-homophones (paronymes in French), i.e. words that have a similar
pronunciation but a different meaning, e.g. luxurieux (meaning “lustful”) and luxuriant (meaning “lush”); and lexical
choice errors, i.e. various types of incorrectly used words, e.g. téléphone for appel téléphonique. Once again, you have
the choice of three levels of settings for these: minimum, intermediate and maximum.

There are two additional settings you can activate in this panel: non-standard words, for certain terms and expressions
that some linguistic authorities find objectionable, e.g. ceci dit for cela dit; and rare words, which tells Antidote to flag
certain rare words which may have been entered inadvertently in place of a more frequent word, e.g. paissance
(“grazing”) might be a typing error for naissance, puissance, plaisance, etc.

Redundancies
A redundancy is an expression that is repetitive in terms of its meaning, e.g. dire verbalement, which translates as “say
verbally” in English. Some redundancies are universally criticized, while others are considered less serious (e.g. devoir
obligatoirement). Here again, you can choose between three levels of settings: minimum level (nothing is flagged);
intermediate level (the corrector flags those redundancies which are widely criticized, but not those that are less
serious); and maximum level (widely criticized and less serious redundancies are flagged).

CAPITAL LETTERS PANEL

By default, the setting for redundancies is adjusted to intermediate level.➞
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Flag unknown capitalized words
If this box is checked, all words beginning with a capital letter which are not in
Antidote’s dictionaries are flagged. There is also an option – only the first
time – which tells the corrector to do so only on the first occurrence of the
word.

Flag words whose meaning changes with capitalization
If this box is checked, the corrector flags words whose meaning changes
when they are capitalized, e.g. renaissance, which signifies “a revival”, as
opposed to Renaissance, which designates a particular period of history.

Flag possibly incorrect demonyms
If this box is checked, Antidote will verify the capitalization of demonyms, i.e. those words which designate the
inhabitants of a country or a region. In French, the same word may sometimes refer to an inhabitant (e.g. Zorba le
Grec), or to the language spoken in the inhabitant’s region (Zorba parle le grec). In the first case, the noun should be
capitalized; in the second case, it should not.

Allow capital letters missing accents
If this box is checked, Antidote will allow words containing a non-accented capital, e.g. Eveil. Note the typographic
standard normally requires an accent on capital letters, e.g. Éveil.

Allow capital letters after “;“
If this box is checked, Antidote will allow a capital letter following a colon, even when the context suggests that a
lowercase letter would be preferred.

Allow unknown words at the beginning of a sentence
Words that begin a sentence should start with a capital letter regardless of their syntactic category (e.g. Enfants et
parents s’amusent. Joël s’amuse.). Should the first word in a sentence be unknown to Antidote’s dictionaries (e.g. Julian
s’amuse.), the corrector may hesitate between flagging it as a unknown proper noun (the first name Julian) and
attempting to correct it for a word that it knows (the first name Julien instead of Julian). You can choose which
approach Antidote should take.

PUNCTUATION PANEL

This setting is disabled by default (Antidote attempts to correct these words)➞
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Comma before mais or car
If this box is checked, the corrector will flag a missing comma before “mais” or “car”,
e.g.: Le site était inauguré en 1987 mais on l’a fermé l’année d’après par manque de
fonds. A comma is normally required in this context, except if the subordinate clause
introduced by these conjunctions is very short, in which case the comma is optional.

Other commas
You can tell Antidote to flag the absence of a comma in a number of other contexts,
e.g. after an adverbial complement in sentence-initial position. Here too there is a
three-position slider allowing you to adjust the sensitivity of the setting.

Allow declarative interrogatives
If this box is checked, the corrector will allow a question mark at the end of a sentence that doesn’t include a question
word or subject-verb inversion, e.g. Tu viens? This is more characteristic of speech, and may not be considered
acceptable when written.

Role of square brackets in the sentence
If the box Text added by a third party is checked, the corrector will analyze the text contained within brackets as being
part of the larger sentence. This setting is recommended when brackets are used to frame text that comes from
someone else.

SPELLING RECTIFICATIONS PANEL

Require traditional spellings
If this box is checked, the corrector will flag all words with rectified
spelling and suggest the traditional spelling in their place. In the
dictionaries, Antidote shows traditional spellings where applicable.

Require rectified spellings
If this box is checked, the corrector will flag all words with traditional
spelling and suggest the rectified spelling in their place. In the dictionaries, Antidote shows rectified spellings where
applicable.

Accept both spellings
If this box is checked, Antidote will allow both spellings in all its components. If a word in rectified spelling is entered in a
search box, all the generated forms will be rectified, and if a word in traditional spelling is entered, all the generated
forms will be traditional.

TYPOGRAPHIC SETTINGS

You may also tell Antidote which spelling to prefer in cases of ambiguity.➞
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GENERAL PANEL

Quotation marks
If this box is checked, Antidote will correct the use of
quotation marks according to the options selected
below. Selecting Apply standard typographic
conventions will require French quotation marks (« ») in
all contexts, except when the quotes are embedded
within other quotations, where English quotes (“ ”) may
be used, e.g. « Nous l’appelions “le petit prince” quand il
était petit », se souvint-elle. Otherwise, you can tell
Antidote to allow the quotation marks of your choice by
selecting Allow the following quotation marks and the
choosing from French (« »), English (“ ”), single French (‹
›) single English (‘ ’) or straight (" ") quotation marks.

Dashes
If this box is checked, Antidote will correct the use of
dashes, allowing you to choose your preferred dash in
any of the following contexts: In front of each item in a
list, To change between speakers in a dialogue, To set
off a parenthetical expression, To separate two
elements and In double-compound proper nouns (e.g.
Nord–Pas-de-Calais).

œ and æ ligatures : Correct missing ligatures
If this box is checked, Antidote will replace the letter
sequences o e and a e with the characters œ and æ in those French words where the ligature is obligatory, e.g. the form
coeur will be replaced by cœur.

Allow “ ° ” (degree) to indicate the letter o in superscript
If this box is checked, Antidote will allow the degree symbol where normally a superscript o would be required, e.g. in
the abbreviation n  (for numéro).

Allow “ o ” (used in Spanish ordinal numbers) to indicate the letter o in superscript
If this box is checked, Antidote will allow the Spanish ordinal symbol where normally a superscript o would be required,
e.g. in the abbreviation n  (for “numéro”).

SPACES PANEL

o

o
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Marks that go in pairs
If this box is checked, Antidote will correct spacing errors around paired
symbols, according to the individual settings you choose for each of the
following: (), [], “ “, “ “, ’ ’, "", – –. For each paired symbol, you may choose a
breaking space, a non-breaking space, a thin space or no space.

Punctuation marks
If this box is checked, spacing errors around punctuation marks are corrected,
according to the individual setting you choose for the period, ellipsis, question
mark, exclamation mark, colon and semicolon. Following the period, the ellipsis,
the exclamation mark, the question mark and the colon, you may choose either
one space, two spaces, or either. Before the exclamation mark, the question
mark, the colon and the semicolon, you may choose a breaking space, a non-
breaking space, a thin space, or no space.

Symbols
If this box is checked, Antidote will correct the use of spaces around symbols,
allowing you to choose the type of space to use for the following types of
symbols: %, $, €, F, etc. and m, cm, etc.. Depending on the type of symbol, you
may choose a breaking space, a non-breaking space, either or none.

Dates
If this box is checked, Antidote will correct the use of spaces in dates, allowing
you to choose the type of space to use in the following date formats: lundi 2, 2
mai, and mai 2050. In all cases, you may choose a breaking space, a non-
breaking space or either.

Last names
If this box is checked, Antidote will correct the use of spaces in last names, allowing you to choose the type of space to
use in the following types of names: Mme Roy, Luc Roy, L. Roy and de Lamartine. In all cases, you may choose a
breaking space, a non-breaking space or either.

Others
If this box is checked, Antidote will enforce your choice of spacing in a number of precise
contexts. In all cases, you may choose a breaking space, a non-breaking space or either.

CONVENTIONS PANEL
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The settings for the French Conventions panel work in the same way as
those of their English counterpart, but are adjusted separately to allow for
the different conventions in the two languages. Standard formatting
conventions for times, numbers, addresses and telephone numbers in
French are quite different from those of English. The French settings also
offer the option for the corrector to allow certain non-standard currency
symbols.

PERSONAL DICTIONARIES

INTRODUCTION

You can add all the French words not recognized by Antidote – little-known
proper nouns, neologisms or infrequent technical terms, various acronyms
and abbreviations – to your personal dictionaries, either as specifically
French entries (usable only within French texts) or as multilingual entries
(usable in both French and English texts).

For a description of how the personal dictionaries applicable to both
languages function, see the Personal dictionaries chapter. Here, we
describe only the features that are particular to French personal
dictionaries.

MANAGING ENTRIES BY LANGUAGE

The All button displays all entries, regardless of language. The French button displays entries marked as French or
multilingual. The English button displays entries marked as English or multilingual. The Lang. column identifies the
language of each entry and lets you sort them according to the three possibilities: English (en), French (fr) and
multilingual (ml).
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ADDING A FRENCH ENTRY

You add a new French term to the personal dictionaries in the same way as you do an English term, i.e. by typing its
uninflected form (the masculine singular for a noun or adjective, the infinitive for a verb) in the headword field.
However, you need to identify the language of the new word in the language menu: French, English or Multilingual. For
each of these, there are different options in the categories menu, located to the right of the language menu. For French,
the possible categories are: noun, adjective, interjection, adverb, Latin expression, proper noun, acronym or initialism,
verb and prefix.

Adding a noun
When you identify a word to be added to the personal
dictionaries as a common noun, Antidote requires that you
check or uncheck the boxes corresponding to the following
properties: does the noun represent a thing or a concept (e.g.
bijou, beurre, joie) and, if so, is it an uncountable entity (e.g.
bijou, beurre), or a qualification (e.g. B.Sc.)? Does the new noun
designate a person (e.g. fillette) and, if so, does it correspond to
a profession (e.g. linguiste)? Does it designate an animal (e.g.
panthère)? The Inflection zone indicates the gender of the noun
and its singular and plural forms. (Antidote inserts the expected
forms for these.)

In the Definition zone, you can then add your own definition of
the noun, as you can for new words of all categories. Finally,
when the Use this word for correction option is checked,
Antidote will use the word and the information in its entry in the
corrector’s analysis. (This is the default option; unchecking it would exclude the word.)

Adding an adjective
When entering a new word as an adjective, you are asked to
indicate whether the word can also be used to designate a
resident (e.g. Belge), as well as a spoken language (e.g. grec).

Adding an interjection

When entering a new word as an interjection, you are asked to
specify whether it corresponds to an emotional reaction (e.g.
zut!), a message to others (e.g. allo) or a noise (e.g. dring).

Adding an adverb
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When adding a new word as an adverb, you are asked to
specify whether it is an adverb of manner (e.g. poliment), time
(e.g. aujourd’hui) or place (e.g. partout).

Adding a proper noun

When adding a new word as a proper noun, you are asked to
indicate whether it is a last name, a first name, the name of a
company or an organization, a brand name, a place name, a
demonym as well as the name of a language, the title of a work,
or, finally, whether the proper noun belongs to some other
category.

Adding an acronym or initialism
When adding a new word as an acronym or initialism, you are
asked to specify whether it is the name of a company or
organization (e.g. ONU), a thing or a concept (e.g. O.P.A., ADN)
or a person (e.g. G.I.G., O.P.) and, if so, whether it designates a
profession (e.g. O.P.). The Inflection zone indicates the inflected
forms of the word in the masculine and feminine, singular and
plural (the expected forms are displayed by default).

Adding a verb
When entering a new word as a verb, you are asked to indicate
how it conjugates. Here, you are given four verbal models to
choose from: verbs ending in –er, like aimer; verbs ending in –ir,
like finir, whose third-person imparfait form is –issait; verbs
ending in –ir, like courir, which form the imparfait in regular
fashion; and verbs ending in –re, like rendre.

Adding a prefix
When adding a new word as a prefix, you are asked to indicate
whether it must be followed by a hyphen, whether it never
requires a hyphen, or whether the hyphen is optional, and this,
for both its traditional and rectified spellings.

Adding a multilingual entry
Because proper nouns and acronyms are often identical in
English and French, the personal dictionaries let you add
“multilingual” entries, in order to avoid having to enter them
separately in each language.

Adding a multilingual proper noun
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When adding a new word as a multilingual proper noun, you are asked to
identify the same properties as with an English or French proper noun
(i.e. last name, first name, company name, etc.). In the Inflection zone,
you indicate the masculine, feminine or gender-neutral forms of the
word. Finally, a drop-down menu added to the top-right corner of the
Definition zone allows you to add both a French definition (◊ Définition
de “Gourmaison”.) and an English one (◊ Definition of “Gourmaison”.).

Adding a multilingual initialism or acronym
When adding a new word as a multilingual initialism or acronym, you are
asked to identify the same properties as for their monolingual
counterparts (i.e. company name, thing or concept, person). In the
Inflection zone, you indicate the masculine, feminine or gender-neutral
forms of the word. Finally, the same French/English language menu is
added to the Definition zone.
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Antidote integrates with your other software so that it can help you wherever you write. To do this, it uses connectors
adapted to individual software applications. Connectix, a utility software provided with Antidote, installs the connectors
into each application. Connectix executes when you install Antidote, and can then be run when you need it, for example
when you install a connector in a new software application.

Install with your other software - To install Antidote in your other software, go to Install with your other software in
Antidote’s Help menu. You will be guided to the Connectix utility, which will automatically recognize compatible
software on your computer and ask if you want to integrate them using the appropriate connectors.

Using with your other software - For guidance on how to make use of Antidote’s resources from within other software
applications, go to Using with your other software in Antidote’s Help menu or under Connectix Agent’s icon. You will be
taken a set of to Web-based documentation detailing how Antidote interacts with each of your applications.

Integration settings - The Connectix Agent oversees integration with your other software applications. It provides a
menu with management options for certain aspects of integration, such as the content of the context menu or the
Antidote toolbar. In Windows, the Connectix Agent can be found in the notification area. On a Mac, it is in the menu bar.
In both platforms, it is represented by a small Antidote flask icon.

Compatibility - Antidote’s integration compatibilities can change over time and with the evolution of the software
applications themselves. To learn the array of applications that Antidote can integrate with, see the compatibility page.

WINDOWS
Antidote includes an advanced corrector, dictionaries and language guides, all of which integrate with your software to
help you write. This guide will assist you in optimizing your use of Antidote with your other software.

You can call Antidote from your other software in any of the following ways.

Mechanism Description

The Connectix Agent The Connectix Agent is installed next to the Windows clock.

The context menus Antidote appears in the contextual menus of many applications; all you need to do is right-click.

The toolbar Access Antidote’s language tools from the Antidote toolbar, displayed within some applications.

Copy and paste Use the Clipboard to send Antidote the text to be corrected or the word to be looked up.

Drag and drop Drag the text to be corrected or the word to be looked up directly into Antidote’s language tools.

THE CONNECTIX AGENT
The Connectix Agent is installed near the Windows clock. The Agent provides quick access to Antidote’s resources.

 USING WITH YOUR OTHER SOFTWARE10
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USE

Note — if a program has a button bar for accessing Antidote, you can still use the Agent as another method for calling Antidote.

You can choose which Antidote commands appear in the Agent menu; see the Antidote settings.

CORRECT COPIED TEXT
New to Antidote 10 v2

You can correct copied text using the Connectix Agent menu.

In your document, select the text to be corrected and copy it (CTRL + C, menu Edition - Copy or right click).

In the Connectix Agent menu, select “Correct copied text”.

Antidote’s corrector window, along with an internal document window, will open automatically and analyze
the copied text directly.

Once the correction is finished, click “Copy and close” in the corrector. Your corrected text can now be copied
into any document. (Careful! Certain formatting features may be lost.)

New to Antidote 10 v4

With the right mouse button, click on the Agent’s icon (the Antidote vial); a menu opens giving you access to
Antidote’s resources.

To access Antidote’s resources from WordPad or Notepad, place the cursor or make a selection in the desired
location, then call the resources via the Agent.

•

•

•

•
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You can correct copied text using a global shortcut.

INSTALLING ANTIDOTE’S CONNECTORS
Antidote automatically installs its connectors in the software you selected during Antidote’s installation.

To reinstall Antidote in a given program, run Connectix (the integrator) by choosing "Connectix (install with your
software)" under Antidote’s "Help" menu or under Antidote’s icon in the notification area.

Note — If automatic installation with Connectix does not work, click on the link to the connectors folder; detailed instructions for installing the

connectors manually are found in the folder of each program.

FIREFOX AND THUNDERBIRD
Antidote integrates with Firefox and Thunderbird by means of add-on modules. These add icons to the toolbar as well
as elements to the context menu.
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ACCESSING ANTIDOTE’S RESOURCES

Select the text to correct or the word to be looked up, then call Antidote’s resources by means of:

UPDATING THE EXTENSION
Within the application, open the menu Tools> Add-ons.

Click the "Extensions" tab.

Click the tools icon.

Select the menu item "Search for updates".

the buttons in the toolbar

the context menu (right click)

the Tools menu (Thunderbird).

•

•

•

•
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GOOGLE CHROME
Antidote integrates with Google Chrome by means of an extension. This extension adds an icon to the toolbar and
certain elements to the context menu.

CHROME’S CONTEXT MENU

Antidote is accessed via a context menu. You can change the options offered in this menu as follows:

Right-click the Antidote icon in the toolbar.

Click Options.

Choose an option.

•

•

•
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Click OK.

Close the options tab.

UPDATING THE EXTENSION

Make sure you update the extension regularly

Click Chrome’s personalize icon in the upper right corner.

Select the menu item "More tools" and then the sub-item "Extensions".

Check the "Developer mode" box .

Click the "Update extensions now" button.

•

•

•

•

•

•
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KEYBOARD SHORTCUTS

Action Shortcut

Corrector ctrl  + alt  + K

Dictionaries ctrl  + alt  + D

Guides ctrl  + alt  + G

GOOGLE DOCS

SETUP

For help on setting it up, please view this article.

USE

Antidote integrates with Google Docs with an add-on compatible only with Google Chrome's Antidote connector.
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This add-on requires your authorisation to interact with your documents. At the start of each session, you must start the
script to allow execution.

The corrector, dictionnaries and guides are available in the side bar.

You can correct the whole document or a simple selection.

GROUPWISE
Select the text to correct or the word to be looked up, then call Antidote’s resources by means of:

Note 1 — The context menu is not present in the HTML editor.

Note 2 — You can choose which Antidote commands appear in the Tools menu and the context menu; see the Antidote settings.

ILLUSTRATOR, INDESIGN AND INCOPY

the buttons in the toolbar;

the Tools menu;

the context menu (right click).
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The following table shows how to call Antidote from Illustrator, InDesign and InCopy. For Illustrator, access via the
context menu is replaced by shortcuts in the Edit menu.

Application Connectix Agent Context Menu Edit menu

Illustrator ✓ ✓

InDesign ✓ ✓

InCopy ✓ ✓

CORRECTING TEXT WITHIN ILLUSTRATOR

Note - Antidote displays all corrected text blocks in sequence.

CORRECTING TEXT WITHIN INDESIGN

Note - Antidote displays all corrected text blocks in sequence.

CORRECTING TEXT WITHIN INCOPY

INTERNET EXPLORER
Within Internet Explorer, Antidote’s resources are accessed via the toolbar.

If a segment of text is selected, Antidote only corrects that segment.

If the cursor is in a block of text, the correction starts at the sentence where the cursor is located and continues
to the end of the block.

If no block of text is selected, Antidote corrects the entire document.

If a part of the text is selected, Antidote only corrects that part.

If the cursor is in a block of text, the correction starts at the sentence where the cursor is located and continues
to the end of the block.

If no block of text is selected, Antidote corrects the entire document.

If a part of the text is selected, Antidote only corrects that part.

If no text is selected, Antidote corrects the entire document.
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Select the text to correct or the word to be looked up, then call Antidote using the buttons in the toolbar.

If the toolbar is not visible:

LATEX
Antidote can process a document containing standard LaTeX commands.

In the editor you use for your LaTeX documents, select the text to be corrected, and call Antidote by any of the
usual methods (Antidote buttons and menus, Antidote’s floating menu bar, the icon for the Antidote Agent, etc.
).

Correct the document normally. The corrections should be reflected directly in your editor, without affecting
the formatting instructions.

Notes :

Launch Antidote.

Click on the Internet Explorer window to put it in the foreground.

Open the Connectix Agent menu by right-clicking on the icon in the notification area (near the time).

Choose "Show Antidote toolbar for Internet Explorer."

•

•

If your editor cannot connect with Antidote, you can copy and paste the text (including formatting instructions)
into Antidote’s internal editor, and then copy and paste the corrected version back into your editor.

Antidote recognizes the 7-bit ASCII accent sequences used by TeX (eg \’e), but these can be difficult to correct.
If so, you may have to make these corrections manually.
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LIBREOFFICE
Antidote integrates with the Writer, Calc, Impress and Draw modules of LibreOffice.

To access Antidote, place the cursor at the desired location in the document, then call Antidote’s resources using the
buttons in the toolbar or the context menu.

CUSTOMIZING THE CONTEXT MENU

The context menu panel in Antidote’s settings allows you to customize the context menu, e.g. by adding direct access to
synonyms or conjugation.

Antidote will not interpret macrocommands.
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MICROSOFT OFFICE
When Antidote is installed, it automatically integrates with Word, Excel, PowerPoint and Outlook.

THE RIBBON

Antidote’s resources are displayed in the Ribbon, under the Antidote tab.
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You can access the various dictionaries and guides using the dropdown menus next to the icons. A few additional
commands are found in the column to the right of the icons.

ADDING ICONS TO THE QUICK ACCESS TOOLBAR
Right-click on the icon of the corrector and select "Add to Quick Access Toolbar" from the context menu that
opens.

Repeat with the icon for the dictionaries.

Repeat with the icon for the guides.

THE CONTEXT MENU

You can access Antidote’s resources via the context menu. Right-click in the text to display the context menu, then
select the desired resource.

FEATURES SPECIFIC TO POWERPOINT

You can call Antidote on the following selections:

FEATURES PARTICULAR TO EXCEL (TEXT CORRECTION)

When the corrector is called:

•

•

•

on text within a frame or on the entire frame;

on all the frames in a slide (with ctrl  + A  or in Outline view);

on a series of consecutive slides (in Outline view);

on all the slides beginning with the current slide (by clicking on the background of the slide);

on text in the presentation's notes.

If an empty cell is selected, Antidote will correct the entire sheet, including comments and charts.
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Note — Antidote cannot be called while editing a cell. Numerical cells are ignored.

FEATURES PARTICULAR TO OUTLOOK

To access Antidote’s resources, first open a window for composing an email.

WORDPERFECT
A WordPerfect document is composed of several structures, including the body of the text as well as different types of
headers and footers. The corrector has to be launched separately on each structure to be corrected.

ACCESSING ANTIDOTE’S RESOURCES

After placing the cursor at the desired location in the document, you can call Antidote’s resources in one of two ways:

Note — You can choose which Antidote commands appear on the Tools menu; see the Antidote settings.

MAC
Antidote includes an advanced corrector, dictionaries and language guides, all of which integrate with your software
applications to help you write. This guide will assist you in optimizing your use of Antidote with your other software.

You can call Antidote from your other software in the following ways.

Mechanism Description

The Connectix Agent The Connectix Agent is installed in the menu bar. The Agent enables Antidote to be accessed
from many applications.

The context menu Antidote integrates with the system’s context menu, which can be viewed from most
applications; all you need to do is right-click.

Services You can access Antidote within any application that is compatible with the Services menu.

The Dock All of Antidote’s resources are accessible from the Dock menu.

The toolbar Call Antidote’s resources from the toolbar, which is accessible within most applications.

Copy and paste Use the clipboard to transfer the text to be corrected to Antidote, or the word to be looked up.

If non-empty cells are selected, Antidote will only correct those cells.

If a chart is selected, Antidote will correct the titles and names on the chart’s axes.

Click on the Antidote icon in the toolbar;

Select the desired Antidote resource in the Tools menu.
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Drag and drop Drag the text to be corrected or the word to be looked up directly into Antidote’s resources.

APPLICATION-SPECIFIC INTEGRATION

Antidote installs connectors that are specifically adapted to the context of certain software applications. Read the
pages devoted to those applications to optimize your use of Antidote with them.

THE CONNECTIX AGENT
The Antidote Agent is installed in the menu bar. The Agent allows for Antidote’s integration with many applications.

USE
Select the word to be looked up or the text to be corrected.

In the menu bar, click the icon of the Antidote Agent to open its menu.

From the menu, select the desired Antidote resource.

The Agent menu can be used in place of Antidote’s floating menu bar or access via the context menu; it is functionally
equivalent to them.

Note — An exclamation mark is superimposed over the icon if the Antidote Agent is no longer functioning. In this case, click on the icon and

select the Quit option that appears at the bottom of the menu. To restart the Agent, quit and then relaunch Antidote.

THE CONTEXT MENU
Antidote installs a context menu that is accessible within several applications.

•

•

•
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A few examples:

ACCESSING ANTIDOTE’S RESOURCES FROM THE CONTEXT MENU
Select the text to be corrected or the word to be looked up.

Click the right mouse button (or hold down the ctrl  key while clicking).

In the context menu that opens, Antidote’s resources are in the lower section.

Select the desired resource.

Mail

LibreOffice

Thunderbird

Nisus Writer

and many others...

•

•

•

•
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Note — With certain programs, Antidote first copies the text into a working document in order to make its corrections. After the correction is

completed, to import the changes, copy and paste the result into the original document.

CUSTOMIZING THE CONTEXT MENU
The context menu panel in Agent Connectix’ settings allows you to personalize the context menu, e.g. by adding direct
access to synonyms or conjugation.
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Note — Customizing the context menu in Chrome is done directly in the application.

CORRECTING COPIED TEXT
New to Antidote 10 v2

You can correct copied text using the Connectix Agent menu.

In your document, select the text to be corrected and copy it.

In the Connectix Agent menu, select “Correct copied text”.

Antidote’s corrector window, along with an internal document window, will open automatically and analyze
the copied text directly.

Once the correction is finished, click “Copy and close” in the corrector. Your corrected text can now be copied
into any document. (Careful! Certain formatting features may be lost.)

New to Antidote 10 v4

You can correct copied text using a global shortcut.

•

•

•

•
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THE DOCK
Antidote’s resources are all accessible from the Dock menu bar.

ACCESSING ANTIDOTE’S RESOURCES FROM THE DOCK MENU BAR
Launch Antidote.

Select the text to correct or the word to be looked up from within any application (for example, an application
that does not implement the macOS Services menu).

Use the clipboard to transmit the text to correct or word to be looked up to Antidote.

Click the Antidote icon in the Dock while holding down the mouse button, then select the desired resource from
the menu. Antidote opens the selected resource. In the case of the corrector, it pastes the text into a working
document, then launches the corrector on this document.

Introduce the changes by copying and pasting them into the original document.

THE TOOLBAR
You can access Antidote’s resources from the toolbar, which is available within most applications.

In some applications, the toolbar is floating, which allows you to move it by dragging it by the title bar.

You can close the floating toolbar. You can reopen it with the Connectix Agent.

SERVICES
Antidote can be accessed from any application that is compatible with the Services menu in macOS.

••

•

•

•
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ACTIVATION

To display Antidote’s resources within the macOS Services menu:

From the application desired, here TextEdit, select Services from the application's menu.

Select Services Preferences...

Under the section Text, check the desired services:

Note - Antidote already inserts its commands in the context menu of most applications. In such cases, the Service commands may appear in

duplicate. The first are generally preferable.

USE
Select the text to be corrected or the word to be looked up.

Right-click (or Ctrl+click) on the selected text. In the context menu that opens, select the desired resource or
select Services then the desired resource.

Antidote opens that resource.

Note — The corrector will sometimes copy the text into a working document before correcting it. If so, you will need to copy and paste the

corrections back into the original document. Some formatting may be lost when the text is transferred to Antidote.

INSTALLING ANTIDOTE’S CONNECTORS
Antidote automatically installs its connectors in the software you selected during Antidote’s installation.

To reinstall Antidote in a given program, choose "Connectix (install with your software)" from the "Help" menu or under
Antidote’s icon found in the menu bar.

•

•

•

Antidote — Corrector

Antidote — Dictionaries

Antidote — Guides

•

•

•
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Note — If automatic installation does not work, click the link to the connectors folder; detailed instructions for installing the connectors

manually are found in the folder of each program.

BEAR
Antidote integrates with Bear by means of macOS' Accessibility SDK.

ACCESSING ANTIDOTE’S RESOURCES

Select the text to correct or the word to be looked up, then call Antidote’s resources by means of:

Note : Bear's integration requires your intervention intially. Please follow these instructions.

The Connectix Agent

The Toolbar
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FIREFOX AND THUNDERBIRD
Antidote integrates with Firefox and Thunderbird by means of add-on modules. These add icons to the toolbar.
Integration in Firefox (or in versions prior to 78 in Thunderbird) add as well as elements to the context menu.

ACCESSING ANTIDOTE’S RESOURCES

Select the text to correct or the word to be looked up, then call Antidote’s resources by means of:

the buttons in the toolbar:

the context menu (right click)
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the Tools menu (Thunderbird).
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CONFIGURATION OF FIREFOX’S CONTEXT MENU

Access to Antidote via Firefox’s context menu is similar to the standard context menus, except for one point: customizing
this menu is done directly in Firefox, as follows.

Right-click the Antidote icon in the toolbar.

Choose "Manage Extension".

Choose an option.

Click OK.

Close the options tab.

UPDATING THE EXTENSION
Within the application, open the menu Tools> Add-ons.

Click the "Extensions" tab.

Click the tools icon.

Select the menu item "Search for updates".

GOOGLE CHROME
Antidote integrates with Google Chrome by means of an extension which adds an icon to the toolbar and certain
elements to the context menu.

ACCESSING ANTIDOTE’S RESOURCES

Select the text to correct or the word to be looked up, then call Antidote’s resources by means of:

•

•

•

•

•

•

•

•

•

the buttons in the toolbar:
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CONFIGURATION OF CHROME’S CONTEXT MENU

Access to Antidote via Chrome’s context menu is similar to the standard context menus, except for one point:
customizing this menu is done directly in Chrome, as follows.

Right-click the Antidote icon in the toolbar.

Click Options.

Choose an option.

Click OK.

Close the options tab.

the context menu (right click).

•

•

•

•

•
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UPDATING THE EXTENSION

Make sure you update the extension regularly.

Click Chrome’s personalize icon in the upper right corner.

Select the menu item "More tools" and then the sub-item "Extensions".

Check the "Developer mode" box .

Click the "Update extensions now" button.

KEYBOARD SHORTCUTS

Action Shortcut

Corrector ctrl  + ⌥  + K

Dictionnaries ctrl  + ⌥  + D

Guides ctrl  + ⌥  + L

•

•

•

•

USING WITH YOUR OTHER SOFTWARE  190



GOOGLE DOCS

SETUP

For help on setting it up, please view this article.

USE

Antidote integrates with Google Docs with an add-on compatible only with Google Chrome's Antidote connector.

Works with documents using Google Documents' extension. The add-on is not compatible with DOCX formats.

This add-on requires your authorisation to interact with your documents. At the start of each session, you must start the
script to allow execution.

The corrector, dictionnaries and guides are available in the side bar.

You can correct the whole document or a simple selection.

ILLUSTRATOR, INDESIGN AND INCOPY
The following table shows how to call Antidote from Illustrator, InDesign and InCopy. For Illustrator, access via the
context menu is replaced by shortcuts in the Edit menu.

Application Connectix Agent Context Menu Edit menu
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Illustrator ✓ ✓

InDesign ✓ ✓

InCopy ✓ ✓

CORRECTING TEXT WITHIN ILLUSTRATOR

Note — Antidote displays all corrected text blocks in sequence.

CORRECTING TEXT WITHIN INDESIGN

Note — Antidote displays all corrected text blocks in sequence.

If a portion of text is selected, Antidote only corrects that text.

If the cursor is in a block of text, the correction starts at the sentence where the cursor is located and continues
to the end of the block.

If no block of text is selected, Antidote corrects the entire document.

If a part of the text is selected, Antidote only corrects that part.

If the cursor is in a text block, the correction starts at the sentence where the cursor is located and continues to
the end of the document.

If no block of text is selected, Antidote corrects the entire document.
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CORRECTING TEXT WITHIN INCOPY

LATEX
Antidote can process a document containing standard LaTeX commands.

In the editor you use for your LaTeX document, select the text to be corrected and then call Antidote by any of
the usual methods (context menu, Connectix Agent, Services menu, Dock menu ...).

Correct the document normally. The corrections should be reflected directly in your editor, without affecting
the formatting instructions.

Notes :

LIBREOFFICE, OPENOFFICE AND NEOOFFICE
Antidote integrates with the Writer, Calc, Impress and Draw modules of LibreOffice, OpenOffice and NeoOffice.

ACCESSING ANTIDOTE’S RESOURCES

Place the cursor at the desired location in the document, or select the text to correct or the word to be looked up, then
call Antidote’s resources by means of:

If a part of the text is selected, Antidote only corrects that part.

If no text is selected, Antidote corrects the entire document.

•

•

If your editor cannot connect with Antidote, you can copy and paste the text (including formatting instructions)
into Antidote’s internal editor, and then copy and paste the corrected version back into your editor.

Antidote recognizes the 7-bit ASCII accent sequences used by TeX (eg \’e), but these can be difficult to correct.
If so, you may have to make these coections manually.

the buttons in the toolbar:
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LibreOffice only When LibreOffice switches to editing XML or HTML, the toolbar can be pinned at the desired location.

MAIL
Antidote integrates with Mail by means of an extension (bundle) which adds certain elements to the context menu and
the Anti-Oups! functionality.

ACCESSING ANTIDOTE’S RESOURCES

Select the text to correct or the word to be looked up, then call Antidote’s resources by means of:

the context menu (right click)

contextual menu (right click) :
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Note : Mail's connector requires your intervention after an update. Please follow these instructions.

MICROSOFT OFFICE
Antidote integrates with Word, Excel, PowerPoint and Outlook.

Interaction with Antidote is mainly via the toolbar or by the Connectix Agent. In both cases, place the cursor at the
beginning of the text to correct or the word to be looked up, then call Antidote’s resources by the method of your choice.

Connectix Agent

Anti-Oups! (automatically launches upon sending an email)
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FEATURES SPECIFIC TO POWERPOINT

You can call Antidote on the following selections:

FEATURES PARTICULAR TO EXCEL (TEXT CORRECTION)

When the corrector is called:

Note 1 — Antidote cannot be called while editing a cell. Numerical cells are ignored.

!

Note 2 — In Excel for Mac, Antidote cannot correct a cell containing more than 256 characters. Antidote will flag any corrections, but you have

to introduce them manually.

QUARKXPRESS
The Connectix Agent and the Dock are the suggested means of interacting with Antidote from QuarkXPress.

When Connectix offers finer integration, the floating bar is also possible.

Select the text to correct or the word to be looked up, then call Antidote’s resources from the menu of the Antidote
Agent.

Note — Antidote displays all the corrected text boxes in sequence.

on text within a frame or on the entire frame;

on all the frames in a slide (with ⌘  + A  or in Outline mode);

on all the slides beginning with the one currently displayed (by clicking on the background of the slide);

on text in the comments page.

If an empty cell is selected, Antidote will correct the entire sheet, including comments and charts.

If non-empty cells are selected, Antidote will only correct those cells.

If a chart is selected, Antidote will correct the titles and names on the chart’s axes.
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SAFARI
Antidote integrates with Safari by means of an extension which adds certain elements to the context menu.

ACCESSING ANTIDOTE’S RESOURCES

Select the text to correct or the word to be looked up, then call Antidote’s resources by means of:

SCRIVENER
Antidote integrates with Scrivener by means of macOS' Accessibility SDK.

ACCESSING ANTIDOTE’S RESOURCES

Select the text to correct or the word to be looked up, then call Antidote’s resources by means of:

Note : Scrivener's integration requires your intervention intially. Please follow these instructions.

the context menu (right click):

The Connectix Agent

The Toolbar
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TEXTEDIT, PAGES AND KEYNOTE

CORRECTING A PAGES DOCUMENT

To correct the entire document, nothing must be selected. Then:

You can also limit your selection to:

Then use either the Antidote logo or the floating bar and select the desired Antidote resource.

CORRECTING A KEYNOTE DOCUMENT

To correct the entire presentation, first click in the margin of a slide to deselect everything.

You can also limit your selection to:

Then use either the Antidote logo or the floating bar and select the desired Antidote resource.

CORRECTING A TEXTEDIT DOCUMENT

To correct the entire document, nothing must be selected.

You can also limit your selection to only the desired elements to be corrected.

Then use either the Antidote logo or the floating bar and select the desired Antidote resource.

ULYSSES
Antidote integrates with Ulysses by means of macOS' Accessibility SDK.

ACCESSING ANTIDOTE’S RESOURCES

Select the text to correct or the word to be looked up, then call Antidote’s resources by means of:

Note : Ulysses' integration requires your intervention intially. Please follow these instructions.

click in the upper left corner of the document;

display the page thumbnails and then click on them.

text within a text box;

one or more complete text boxes.

text within a text box;

one or more complete text boxes;

one or more slides in the Navigator.

The Connectix Agent

The Toolbar
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INTEGRATION UNDER MACOS 10.11 AND 10.12

INTEGRATION PROBLEMS WITH TEXTEDIT, PAGES, KEYNOTE AND NUMBERS

Beginning with 10.11, Apple introduced SIP (System Integrity Protection), a new barrier designed to protect the system
from malicious intrusions. Apple has also chosen to include Pages, Keynote, Numbers, and TextEdit within the scope of
SIP. In doing so, Apple closed the door through which Antidote integrated with these four applications.

Druide has succeeded in implementing a new integration for Pages and TextEdit on 10.11. Efforts are underway to
enable integration on 10.12 as well. In the meantime, to access Antidote from these applications on 10.12, you must use
copy and paste.

For more details on SIP
https://support.apple.com/fr-fr/HT204899

To encourage Apple to create an API in order to facilitate integration with Antidote
http://www.apple.com/feedback/pages.html

MANUAL INTEGRATIONS

What is a manual integration ? It is a process requiring your intervention to allow Antidote to communicate properly with your software. For

security reasons or technical limitations, it is impossible for us to apply those changes to your environment. If you do not follow these

instructions, we can't guarantee Antidote's usage in your software.

To complete integration with Antidote 10, please follow these steps:

Google Chrome

Go to the Chrome Web Store :
https://chrome.google.com/webstore/detail/antidote/cchfigjcpjmclmmphipdkeocklpnjecm

•

USING WITH YOUR OTHER SOFTWARE  199

https://support.apple.com/fr-fr/HT204899
http://www.apple.com/feedback/pages.html


Launch Google Chrome.

Select Window > Extensions.

Activate Antidote's connector.

Opera
From your Opera browser, access the Chrome Web Store with this URL :
https://chrome.google.com/webstore/detail/antidote/cchfigjcpjmclmmphipdkeocklpnjecm.

Accept the warning to install extensions from Chrome Web Store.

Add it to Opera.

In order to complete, open the extensions manager and confirm the installation by clicking on Install button.

Mail
Launch Mail.

Open Mail's preferences.

In this menu, select the tab General and click Manage Plug-ins...

•

•

•

•

•

If you're unable to install extensions from Chrome Web Store, install the following extension:
https://addons.opera.com/en/extensions/details/install-chrome-extensions/.

•

•

•

•

•
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Check Antidote - PJ.mailbundle.•
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Click Apply and Restart Mail.

Access to Accessiblity's SDK
Click here to open Security & Privacy > Privacy > Accessibility in System Preferences

Click on the lock in the bottom left-hand corner and enter your administrator password.

Check AgentAntidoteConnect.

•

•

•

•
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Microsoft Outlook
!Warning Outlook is not compatible with Antidote under macOS 10.15.

Click here to open Security & Privacy > Privacy > Accessibility in System Preferences.

Click on the lock in the bottom left-hand corner and enter your administrator password

À partir de la barre de menus du Finder, choisissez le menu Aller > Applications.

Dans le dossier qui apparait, localisez l’application Microsoft Outlook et glissez-déposez-la dans le panneau
d’Accessibilité.

•

•

•

•
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Safari

Warning The type of connector used (Safari App Extensions) requires at least Safari version 12.1. Make sure your download the latest version.

Launch Safari.

Open Safari’s preferences (Safari > Preferences...).

Click Extensions.

Check Antidote - Safari. This extension is bundled with Connectix 10.

•

•

•

•
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LINUX
Antidote includes an advanced corrector, dictionaries and language guides, all of which integrate with your software to
help you write. This guide will help you learn how to optimize your use of Antidote with your other software.

Connectors adapted to the main Linux software applications can be installed. This is the case for Chrome, LibreOffice,
Firefox and Thunderbird. These connectors add toolbars and context menus to your software applications to optimize
access to Antidote.

For other software, you can use the standard operations of copy and paste and drag and drop to transmit the text to be
corrected or word to be looked up to Antidote.

DRAG AND DROP TEXT TO ANTIDOTE
You can drag and drop text between most software applications and Antidote.

In Antidote, create an internal document. ( ctrl  + n )

Drag the text to be corrected into this document.

Call the corrector.

Drag the corrected text back into your original document. (Warning: some formatting may be lost.)

For Antidote’s other resources, drag the word to be looked up onto the desired dictionary or into the headword
box.

•

•

•

•

•
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COPY AND PASTE TEXT TO ANTIDOTE
New to Antidote 10 v2

You can correct copied text using the Connectix Agent menu, not available on all Linux distributions.

In your document, select the text to be corrected and copy it (CTRL  + C  or right click).

In the Connectix Agent menu, select “Correct copied text”.

Antidote’s corrector window, along with an internal document window, will open automatically and analyze
the copied text directly.

Once the correction is finished, click “Copy and close” in the corrector. Your corrected text can now be copied
into any document. (Careful! Certain formatting features may be lost.)

FIREFOX AND THUNDERBIRD

•

•

•

•
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Antidote integrates with Firefox and Thunderbird by means of add-on modules. Once installed, these add icons to the
toolbar as well as elements to the context menu.

ACCESSING ANTIDOTE’S RESOURCES

Select the text to correct or the word to be looked up, then call Antidote’s resources by means of:

UPDATING THE EXTENSION
Within the application, open the menu Tools> Add-ons.

Click the "Extensions" tab.

Click the tools icon.

Select the menu item "Search for updates".

the buttons in the toolbar;

the context menu (right click);

the tools menu (Thunderbird).

•

•

•

•

USING WITH YOUR OTHER SOFTWARE  207

https://www.antidote.info/en/antidote-9/using-with-your-other-software/linux/installation


GOOGLE CHROME
Antidote integrates with Google Chrome by means of an extension. Once installed, the extension adds an icon to the
toolbar as well as elements to the context menu.

CHROME’S CONTEXT MENU

Antidote can be accessed from Chrome’s context menu. You can change the options offered in this menu as follows:

Right-click the Antidote icon in the toolbar.

Click Options.

Choose an option.

Click Apply.

Close the options tab.

•

•

•

•

•
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UPDATING THE EXTENSION

Make sure you update the extension regularly.

Click Chrome’s personalize icon in the upper right corner.

Select the menu item "More tools" and then the sub-item "Extensions".

Check the "Developer mode" box .

Click the "Update extensions now" button.

•

•

•

•
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KEYBOARD SHORTCUTS

Action Shortcut

Corrector ctrl  + alt  + K

Dictionaries ctrl  + alt  + D

Guides ctrl  + alt  + G

GOOGLE DOCS

SETUP

For help on setting it up, please view this article.

USE

Antidote integrates with Google Docs with an add-on compatible only with Google Chrome's Antidote connector.
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This add-on requires your authorisation to interact with your documents. At the start of each session, you must start the
script to allow execution.

The corrector, dictionnaries and guides are available in the side bar.

You can correct the whole document or a simple selection.

LATEX
Antidote can process a document containing standard LaTeX commands.

In the editor you use for your LaTeX documents, copy the text to be corrected (formatting instructions
included), and then paste it into a new document in Antidote’s internal editor.

Correct the document. The corrections will be made on the copy of the text in Antidote’s internal editor.

Transfer the corrections by pasting Antidote’s corrected text back into your original document.

Note — Antidote recognizes the 7-bit ASCII accent sequences used by TeX (eg \’e), but these can be difficult to correct. If so, you may have to

make these corrections manually.

LIBREOFFICE
Antidote integrates with the Writer, Calc, Impress and Draw modules of LibreOffice.

Integration of Antidote in LibreOffice requires manual installation.

•

•

•
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To access Antidote, place the cursor at the desired location in the document, then call the Antidote resources using the
buttons in the toolbar or the menu bar.

CUSTOMIZING THE CONTEXT MENU

The context menu panel in Antidote’s settings allows you to personalize the context menu, e.g. by adding direct access
to synonyms or conjugation.
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INSTALLING ANTIDOTE’S CONNECTORS
The connectors adapted to the main Linux software applications must be installed manually.

From Antidote, open the menu item Help > Connectix (install with your software)

Follow the instructions in the folder specific to each application.

THE CONNECTIX AGENT

•

•
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The Connectix Agent is installed in the menu bar of systems that allow for it such as Ubuntu 18.04. The Agent gives quick
access to Antidote’s various tools.

USE

You can also personalize the commands that appear in the Agent’s menu by going to Connectix options.

Click on the Agent’s icon (the Antidote flask) and a menu will open, giving you access to Antidote’s tools.

The Connectix Agent’s menu also allows you to choose whether your requests will be processed by Antidote
Web or by the copy of Antidote 10 installed on your local computer.
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Note — Unlike on other platforms such as Windows or Mac, the Connectix Agent cannot connect directly with any third-party applications

when running a tool. We therefore recommend that you run the tools via the specific integrations for these

applications.https://antidote.info/en/admin/pages/antidote-10/documentation/guide-utilisation/integration-dans-vos-

logiciels/linux/agent-connectix#delete

SYNCHRONIZATION  215



Antidote 10 allows you to create a wide variety of information: lists of words, searches and guide articles, favourites and
personal dictionaries. If your license authorizes the use of Antidote 10 on more than one device, you can share this
information across all of them using Cumulix, our cloud-based synchronization service.

The Cumulix service recognizes you using your customer account. When you use Antidote on a new device and log in
with your customer account (using your ID and password), Cumulix automatically syncs your information to this device.
This means that any words you have added to a personal dictionary on another device using the same customer
account will appear on this new device.

There are settings that allow you to customize how synchronization works. For example, you can choose to only sync
your favourites or your personal dictionaries. You can even select individual personal dictionaries to sync. You can also
choose not to enable synchronization. See the Settings chapter for details.

Synchronization is an optional service. It may involve additional costs. See your customer account for more details.
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